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8. Power Sources — This Mackie product should be connected to a power
supply only of the type described in these operating instructions or as marked
on this Mackie product.
9. Power Cord Protection — Power supply cords should be routed so that
they are not likely to be walked upon or pinched by items placed upon or
against them, paying particular attention to cords at plugs, convenience
receptacles, and the point where they exit this Mackie product.
10. Object and Liquid Entry — Care should be taken so that objects do not
fall into and liquids are not spilled into this Mackie product.
11. Damage Requiring Service — This Mackie product should be serviced
only by qualified service personnel when:
A. The power-supply cord or the plug has been damaged; or
B. Objects have fallen, or liquid has spilled into this Mackie
product; or
C. This Mackie product has been exposed to rain; or
D. This Mackie product does not appear to operate normally or
exhibits a marked change in performance; or
E. This Mackie product has been dropped, or its chassis
damaged.

SAFETY INSTRUCTIONS
1. Read Instructions — All the safety and operation instructions should be
read before this Mackie product is operated.
2. Retain Instructions — The safety and operating instructions should be
kept for future reference.
3. Heed Warnings — All warnings on this Mackie product and in these
operating instructions should be followed.
4. Follow Instructions — All operating and other instructions should be
followed.
5. Water and Moisture — This Mackie product should not be used near
water – for example, near a bathtub, washbowl, kitchen sink, laundry tub, in
a wet basement, near a swimming pool, swamp, or salivating St. Bernard
dog, etc.
6. Ventilation — This Mackie product should be situated so that its
location or position does not interfere with its proper ventilation. For
example, the Component should not be situated on a bed, sofa, rug, or
similar surface that may block any ventilation openings, or placed in a
built-in installation such as a bookcase or cabinet that may impede the
flow of air through ventilation openings.
7. Heat — This Mackie product should be situated away from heat sources
such as radiators or other devices which produce heat.

PORTABLE CART WARNING
Carts and stands - The
Component should be used
only with a cart or stand
that is recommended by
the manufacturer.
A Component and cart
combination should be
moved with care. Quick
stops, excessive force, and
uneven surfaces may cause
the Component and cart
combination to overturn.

12. Servicing — The user should not attempt to service this Mackie product
beyond those means described in this operating manual. All other servicing
should be referred to the Mackie Service Department.
13. Do not remove the cover on the console. It is permissible to remove the
outer cover on the Remote CPU to install accessory cards. Do not remove the
inner power supply cover.
14. To prevent electric shock, do not use this polarized plug with an
extension cord, receptacle, or other outlet unless the blades can be fully
inserted to prevent blade exposure.

Pour prévenir les chocs électriques ne pas utiliser cette fiche polariseé avec un
prolongateur, un prise de courant ou une autre sortie de courant, sauf si les
lames peuvent être insérées à fond sans laisser aucune pariie à découvert.
15. Grounding or Polarization — Precautions should be taken so that the
grounding or polarization means of this Mackie product is not defeated.
16. This apparatus does not exceed the Class A/Class B (whichever is
applicable) limits for radio noise emissions from digital apparatus as set out
in the radio interference regulations of the Canadian Department of
Communications.

ATTENTION —Le présent appareil numérique n’émet pas de bruits
radioélectriques dépassant las limites applicables aux appareils numériques de
class A/de class B (selon le cas) prescrites dans le règlement sur le brouillage
radioélectrique édicté par les ministere des communications du Canada.

FCC Information
NOTE: This equipment has been tested and found to comply
with the limits for a Class A digital device, pursuant to Part 15
of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference when the
equipment is operated in a commercial installation. This
equipment generates, uses, and can radiate radio frequency
energy and, if not installed and used in accordance with the
instruction manual, may cause harmful interference to radio
communications. Operation of this equipment in a residential
area is likely to cause harmful interference in which case the
user will be required to correct the interference at his own
expense.

WARNING — To reduce the risk of fire or electric shock, do
not expose this appliance to rain or moisture.

Note: The following notice concerns the lithium battery located on the motherboard inside the Remote CPU.
CAUTION: DANGER OF EXPLOSION IF BATTERY IS INCORRECTLY REPLACED. REPLACE ONLY WITH THE SAME OR
EQUIVALENT TYPE RECOMMENDED BY THE MANUFACTURER. DISPOSE OF USED BATTERIES ACCORDING TO THE
MANUFACTURER’S INSTRUCTIONS.
ATTENTION: IL Y A DANGER D’EXPLOSION S’IL Y A REMPLACEMENT INCORRECT DE LA BATTERIE, REMPLACER
UNIQUEMENT AVEC UNE BATTERIE DU MEME TYPE OU D’UN TYPE ÉQUIVALENT RECOMMANDÉ PAR LE CONSTRUCTEUR.
METTRE AU REBUT LES BATTERIES USAGÉES CONFORMÉMENT AUX INSTRUCTIONS DU FABRICANT.
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Preface

T

he Mackie Digital 8•Bus is an amazing digital audio tool. Its flexibility, depth, and creative pizazz
provides the engineer/artist with nearly limitless freedom to produce top quality work.

The D8B Version 3.0 upgrade offers a host of new features that can make your mixes sound better and
speed your workflow. Here’s a list of the newest features of the Mackie OS Version 3.0.

WHAT'S NEW WITH 3.0
• Third-party plug-ins via the Mackie UFX card
• Enhanced dynamics
• Input keying and EQ filter
• Soft knee compression toggle
• 48-channel overview screen
• 999 levels of Undo
• Automation Cut, Copy, and Paste
• 24-bit Alt I/O
• Advanced Mix Editor features including:
° New view-sizing arrows
° Auto-loop SMPTE time code boxes
° Loop-in/loop-out and Locate markers in the
time bar
° Contextual right mouse click for track
parameters and time bars
Event
Automation Track
°
• Enhanced Surround Sound mixing environment
with:
° Depth of Center Control
° Surround LFE Gain Control for each channel
° Surround-corrected bus/track assignment
° Surround Front-to-Rear Pan Control via
control surface or MIDI
° Surround GUI update—new 72-channel
overview

• Triumphant Return of the Desktop—drag and
drop file management between File windows
• Enhanced, flexible MIDI I/O mapping for all
channel strip and master section parameters
• Assignable MIDI commands on transport (REW,
FF, STOP, PLAY, REC) and on the D8B master
control section
• Insert and patch point feature on channels—
source either plug-ins, 8 aux sends, 8 buses, or 72
channels (pre-DSP only)
• 24-bit plug-in inserts across Main L/R buses
• Time offset (delay) on each channel 1-48 with 255
samples
• Channel Layout assigns channel strips in various
orders
• Non-destructive Ungrouping
• Optional fader control of level to tape—direct out
signal follows the source fader channel
• Multiple direct outs per channel
• Snapshot Library
• Pre/Post assignment of each aux send on each
channel
• Improved BBT resolution and clocking accuracy

D8B Manual • Preface • page 1

D8B Manual • Preface • page 2

Getting Ready

Chapter 1
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Introduction

Let’s Get It Working

T

This is a step-by-step guide to get the Digital 8•Bus
working. We assume you’ve pulled everything out
of the box and are ready to start working.
First, you’ll need:
• 1 Stereo Power Amplifier
• 1 pair of Monitor Speakers (you can substitute a
pair of powered monitors for the power amplifier/
monitor speaker combo, or some stereo
headphones)
• Miscellaneous cables
• 1 cup of coffee (we think any native Seattle-based
beverage heightens the Mackie experience)

his Guide reflects the newest and most
progressive features and options available
on the Mackie Digital 8•Bus. The D8B is
designed to grow with the audio industry. Each
software revision provides new features and
capabilities, updating your console and ensuring
that your investment remains current for many
years to come.
An increasing number of other manufacturers
have jumped on the D8B band wagon. Through
affiliations with companies like Apogee, TC
Electronics, Massenburg, dbx, and Antares,
Mackie Designs has provided an environment
where third-party plug-ins let you design the
perfect system for your needs—all within the
Digital 8•Bus architecture!

Hooking Stuff Up
First, connect the Remote CPU to the console.

About This Manual

1. Connect the DC power cable between the Remote
CPU and the console. Rotate the outer sleeve of
the connector clockwise until the sleeve is snug
and finger-tight.

This manual is the “let’s just do it” guide. Each
chapter covers an important consideration:
• Chapter 1 describes basic setup procedures with
an emphasis on achieving successful routing of an
audio source to your monitors.
• Chapter 2 briefly describes all surface controls.
• Chapter 3 describes the on-screen interface.
• Chapter 4 highlights some typical applications.
If you’d like to move ahead at light-speed, try
jumping directly to Chapter 4, using Chapters 2 and 3
as a reference. If you crave details, or if you’re new
to recording—especially digital recording—don’t
forget to check out our website for more info at
www.mackie.com.
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2. Connect the data cable between the Remote CPU
and the console. Rotate the thumbscrews on each
connector clockwise until they are finger tight.
3. Make sure the POWER switch on the Remote
CPU is off.
4. Connect the detachable linecord to the Remote
CPU. Shortly, we’ll connect to AC power.

Next, connect the keyboard, mouse,
and video monitor.
These connections are optional, but we strongly
recommend using them to get the most from your
new Digital 8•Bus console.

CONSOLE DATA

PARALLEL

MOUSE

KEYBOARD
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1. Plug a PC-compatible keyboard into the KEYBOARD port on the back of the Remote CPU.
2. Plug a PS/2 compatible mouse into the MOUSE
port on the back of the Remote CPU.
3. Plug an SVGA video monitor into the VIDEO port
on the back of the Remote CPU.
Note: We highly recommend the use of a multisync
monitor; however, if one is unavailable you must use a
monitor capable of at least a 72Hz scan rate. We
recommend using a 17-inch or larger monitor for best
results.

MASTER OUT
L R

CR
MAIN
L R

Line Cable

CR
NEAR FIELD
L R

Line Cable

Now connect the audio inputs and outputs
to the console.
1. Connect the CR NEAR FIELD or CR MAIN
outputs on the back of the Digital 8•Bus to the
line inputs of the power amplifier. These outputs
are wired balanced when using a tip-ring-sleeve
connector or unbalanced when using a tip-sleeve
connector. Use instrument/line-level cable for this
connection.

Powered
Monitors
Connect directly from CR NEARFIELD or CR MAIN
to powered reference monitors using line-level cable.

2. Connect monitor speakers to the output of the
power amplifier using speaker cable. Always use
high quality wire. The sound you hear will be
more reliable and accurate.

MASTER OUT
L R

Note: If you’re using powered monitors, connect the
Left and Right CR NEAR FIELD outputs directly to
the line inputs on the powered monitors.
Optional Refreshments

Have a sip of java and a biscotti.

CR
MAIN
L R

Line Cable

CR
NEAR FIELD
L R

Line Cable

Details
Make sure the POWER switch on the Remote CPU
is off. Now plug the linecord into an AC outlet
properly configured for your model. Leave the
POWER switch off while connecting the
peripheral equipment to the console.

Speaker Cable

Speaker Cable

Note: The Remote CPU should be treated as you would
any computer. We recommend that you use a UPS
(Uninterruptible Power Supply) and a surge protector
on the AC line.

Caution: Never connect or disconnect anything
except microphone or line-level inputs while
the console is powered up.
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Non-powered
Monitors
Connect from D8B outputs to power amp using line
cable, then from amp to non-powered speakers using
speaker cable.

Turn on the power switch on the front panel of the
Remote CPU, then turn on the power to all your
peripheral equipment. The Digital 8•Bus takes a few
moments to load the Mackie Real Time OS
(Operating System) and initialize the DSPs. When
the Vacuum Fluorescent Display (VFD) in the
onboard Fat Channel Section indicates EQ settings
for channel 1, the console is ready to use.

These buttons let you access four completely
different sets of controls, referred to as Fader Banks.
Even though only one Fader Bank is accessible at a
time, all four are fully functional at all times. Use of
a computer monitor provides on-screen control of
two fader banks at a time.

Fast Track Power-Up
1. Switch D8B power on.
2. Verify that SPEAKER LEVEL
V-Pot is turned all the way down.
FAST
3. Switch on all peripherals
T
RACK
(processors, recorders,
interfaces, etc.).
4. Switch on monitor amplifier or powered
monitors.

MASTERS

SHIFT

1-24

25-48

MIC/LINE

TAPE IN

(TRACK)

(MONITOR)

49-72

EFFECTS
BANK SELECT

A New Way of Thinking:
Four Consoles in One!

Now that you’ve got the Digital 8•Bus
powered up, try the different fader banks.

With the Digital 8•Bus, what you get is way more
than what you see at first glance. Directly above
the Master L/R fader, locate four buttons labeled
MIC/LINE, TAPE IN, EFFECTS, and MASTERS.

• Press the MIC/LINE button and set up a
random set of fader levels.
• Press the TAPE IN button and set up a
completely different set of fader levels.
• Do the same for EFFECTS and MASTER.

SHIFT

MASTERS

Channels

Fader Bank
1
Channels 1-24
Mic/Line
Tracking

1-24

Channels

1-24

25-48

MIC/LINE

TAPE IN

(TRACK)

(MONITOR)

25-48

MIC/LINE

TAPE IN

(TRACK)

(MONITOR)

49-72

EFFECTS
BANK SELECT

Fader Bank
2
Channels 25-4
8
Monitor/Tape
In
Mixdown

SHIFT

MASTERS

1-24

25-48

SHIFT

MASTERS
49-72

EFFECTS
BANK SELECT

FX Return

MASTERS

SHIFT

1-24

25-48

MIC/LINE

TAPE IN

(TRACK)

(MONITOR)

49-72

1-16; AL

Groups 1

T Return

-8; MIDI

1-8

1-8; Bus

1-8

Fader Bank
3
Channels 49-7
2
FX Return 116
ALT Return 18

1-24

25-48

MIC/LINE

TAPE IN

(TRACK)

(MONITOR)

49-72

EFFECTS
BANK SELECT

Fader Bank
Virtual Group 4
s
MIDI Controlle 1-8
rs 1Bus 1-8 Maste 8
rs

EFFECTS
BANK SELECT

D8B Manual • Chapter 1 • page 7

As you switch back and forth between all four
fader banks, the faders will move to their respective settings for each bank. You’ll find that this
becomes your most popular demonstration. Your
friends will love it; your spouse will love it; your
pet will be mildly amused.
This exercise demonstrates a process that
will become second nature as you increase your
skills on the Digital 8•Bus. The layered approach
to digital mixing is actually very convenient, while
at the same time providing tons of features in a
compact package. This mixer contains more
flexibility and features than most consoles taking
up 12 or more feet of desk space and costing up to
50 times more!

Fader Bank Selection
• MIC/LINE button = Fader Bank 1
(Channels 1–24)
• TAPE IN button = Fader Bank 2 (Channels 25–48)
• EFFECTS button = Fader Bank 3 (Channels 49–
72: Internal Effects Returns, FX 1–16, and ALT
RETurns 1–8)
• MASTERS button = Fader Bank 4 (Virtual Groups
1–8, MIDI Controllers 1–8, Bus Masters 1–8)
This architecture provides a total of 56 inputs,
with Fader Banks 1 and 2 providing 48 inputs, and
the 8 ALT Returns in Fader Bank 3 providing
another 8 inputs.
One of the primary applications the Digital 8•Bus
was designed for is multitrack recording (generally
up to 24 tracks). This involves tracking and
monitoring, bouncing, overdubbing, and mixdown.
You can think of Fader Bank 1 and Fader Bank 2 as
two separate mixing consoles, where Fader Bank 1
is used for tracking and Fader Bank 2 is used for
monitoring and mixdown.
Two 24-track machines can easily be connected
to the D8B for mixdown: one into the Fader Bank 1
line inputs, and the other into the Fader Bank 2
(Tape) I/O cards. This setup provides an amazing
amount of control through automation, routing, and
DSP!
Note: Although the D8B is perfectly set up for 24-track
recording, it’s possible to route channels to 46 outputs,
all at the same time: 24 direct outputs (3 cards),
8 buses (Alt I/O), 2 main stereo outputs, and 12 auxes.
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Let’s Get Some Sound Happening
• Mixer Power On.
• Monitors connected and on.
• Microphone or Instrument
plugged into Channel One.

FAST

• Phantom Power button
TRACK
pushed in if required.
• Fader Bank 1 (MIC/LINE selected).
• Press the MIC button down when using a
microphone; leave it up for an instrument.
• While sound source is active, adjust TRIM for
a reading around –15 on the channel 1 meter.
• Select L–R in the ASSIGNMENT section, then
verify that the ASSIGN button on Channel One
lights up green.
• In the CONTROL ROOM section, select
MASTER L–R.
• Select the desired SPEAKERS in the
CONTROL ROOM section.
• Set the SPEAKER LEVEL V-pot to about
11:00.
• Turn the MASTER L/R fader up to unity.
• Slowly raise the level of the Channel One fader
until you hear sound.
• The Master L/R meters should display levels.
• Rejoice in the sense of accomplishment while
listening to crystal-clear audio.

Refer to Figure 1-1 for the Fast Track Graphic
description of this procedure.

Details
1. Especially for digital connections, it’s important
that the Digital 8•Bus is powered up first. This
procedure helps establish the mixer as a primary
source in the digital sync scheme.
2. Be sure you’ve noted which output is connected to
the monitor system(s) and be sure they’re
powered up.
3. Be sure the microphone or instrument is plugged
into Channel 1 and that Fader Bank 1 (MIC/LINE) is
selected. It doesn’t take long to get used to
selecting the fader bank you really need to access;
however, at first make a conscious effort to
include this step in your routine.
4. Be sure the button below the gain trim labeled
MIC is pressed down for a microphone or is in the
up position for an instrument When working fast
this button is sometimes overlooked. If it’s in the
wrong position there won’t be any signal to play
with. That’s bad. Get in the habit of following the
signal from the source to the destination—step by
step. If you don’t leave any steps out you’ll be
successful every time.

Figure 1-1 Completing the Microphone Signal Path
Follow this graphic map to quickly complete a signal path using a microphone to capture the
FAST
sound source..
TRACK
Mic into
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30
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TAPE

50

40
50

60

60

SPEAKER LEVEL

Select Monitors/Set
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5. Start with gain TRIM down. While talking into the
mic or playing the instrument, turn it up until the
level stays around –15 to –10 on the channel one
meter.

Raise Channel
Level to Hear

6. In the CONTROL ROOM section, press the
MASTER L–R button so the yellow light comes
on. Assigning this button sends whatever is
coming from the MASTER L/R fader to the
selected speakers.

TRIM
LINE
MIC

CONTROL ROOM

0
60
-20dB +40dB

1

2 TRACK A

DIGITAL IN 1

2 TRACK B

DIGITAL IN 2

2 TRACK C

MASTER
L-R

MIC

MONO

OR

Note: The TRIM and MIC button status are two of the
only controls that are not written into automation or
snapshot data. That’s a disadvantage of analog circuitry,
but these controls are necessary. Running a strip of
white safe-release tape across the top label strip allows
for careful recording of each channel’s TRIM level and
MIC button status. This kind of tape can be removed
and folded for storage with session documentation,
guaranteeing accurate settings whenever you need to
restore the mix.

NEAR FIELD

MAIN

SPEAKERS

SPEAKER LEVEL

DIM

TALKBACK

D8B Manual • Chapter 1 • page 9

7. In the ASSIGNMENT section, verify that when
L–R is selected (green light on) the ASSIGN
button in Channel One lights up green. This is
basic bus assignment procedure. Anything you
want to come out the MASTER L–R bus must
light up on the assign button of each desired
channel. In similar fashion, any channel that
needs to be assigned to Bus 1 must have the
channel assign button lit when Bus 1 is selected
in the ASSIGNMENT section.

ASSIGNMENT
ASSIGN

ASSIGN

BUS 1

BUS 2

ASSIGN

ASSIGN

BUS 3

BUS 4

ASSIGN

ASSIGN

BUS 5

BUS 6

ASSIGN

ASSIGN

BUS 7

BUS 8

ASSIGN

ASSIGN

L-R

ROUTE TO
TAPE

8. Be sure the SPEAKER button is lit that
corresponds to your monitor system
connection—that the yellow light shows on
NEAR FIELD or MAIN.
9. Turn the SPEAKER LEVEL V-pot up to about
11:00.
10. Turn the MASTER L/R fader up to unity.
11. Slowly raise the level of the Channel One fader
until you hear sound.

TRIM

TRIM

LINE

12
REC/RDY

REC/RDY

ASSIGN

ASSIGN

WRITE

WRITE

ASSIGNMENT
10
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20

20

30

30

40

40

50

50

60

60

ASSIGN

ASSIGN
BUS 2

ASSIGN
BUS 7

BUS 8

ASSIGN

ASSIGN

L-R

ROUTE TO
TAPE
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Signal Routing Concept
The Digital 8•Bus, with its multilayer technology,
literally performs the work of at least four consoles.
To help organize the various connections, visualize
each bank as a new console. The “V” or “Multi-V”
diagrams that follow provide a simple and accurate
mental image of the signal flow and/or processing
while you put the Digital 8•Bus through its paces.
Figure 1-2 demonstrates a simple connection
scheme utilizing a microphone that’s routed though
the D8B to the monitor system.
Figure 1-3 demonstrates a tracking setup. Notice
how the graphic representation of two separate fader
banks supports the mental image of the D8B concept:
sound source into the MIC/LINE bank, then routed
to the multitrack, then back into the TAPE IN bank.
Figure 1-4 adds a mixdown recorder. The beauty
of this concept lies in its flexibility. Start at the
beginning, middle, or end of the signal path—it
doesn’t matter. When the routing concept is
understood, the process is simple.

Figure 1-2 Simple Microphone Connection/Basic Live Setup
This setup illustrates the most fundamental use of the D8B. A very basic live setting might
require only this limited level of complexity.

Channel 1–24
Mic/Line In

FAST
TRACK

Monitor Outs
to Speakers

Channels 1–24
Tracking Mixer
Fader Bank 1

Figure 1-3 Setting Up to Track
The graphic below highlights the simplicity of the D8B tracking procedure. Once levels to
tape are set, using the Channel Trim controls, it’s typically best to monitor the mix from
the TAPE IN Fader Bank throughout tracking.

FAST
TRACK

Multitrack

Channel 1–24
Mic/Line In

Channels 1–24
Tracking Mixer
Fader Bank 1

Tape or Bus Outs to
Multitrack Inputs

From Tape to Channel
25–48 Inputs

Channels 25–48
Tape Returns
Fader Bank 2

Monitor Outs
to Speakers

Channel Assignments Routed to
L/R Mix
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Figure 1-4 Basic Mixdown Setup
This is a basic mixdown setup. Live Mic/Line input source might be used for any audio
source: live vocals, instruments, or effects returns.

FAST
TRACK

Multitrack

Outboard Effects,
MIDI Gear, Live
Room Mics, etc.

From Tape to Channel
25–48 Inputs
From Master Out to
Mixdown Recorder

Tape or Bus Outs

From Mix Playback to
2-Track Input (Analog
or Digital)

Monitor Outs
to Speakers

Phones

Channels 1–24
Tracking Mixer
Fader Bank 1

Channels 25–48
Monitor Tape
Fader Bank 2

Monitor Mixdown Machine
at CONTROL ROOM in the
Master Section

Use this diagram for troubleshooting!

Signal Flow
The previous diagrams help create an accurate
mental image of how the D8B functions. The signal
flow diagram in Figure 1-5 (on the next page) looks
more closely at the actual path the signal takes from
a point of origin to a chosen destination. This is a
simplified flow-diagram designed to provide a “bird’seye” view. Follow the signal from left to right. Notice
the first thing the signal encounters, after the analog
inputs (including the analog trim), is the analog-todigital converter. The audio remains in the digital
domain from that point until it finally converts back
to analog at the main outputs, bus outputs, and
external aux sends. Simply follow the arrows to
discover the path—you never know where you might
end up. For a more detailed block diagram of the
D8B signal path refer to Figure 1-6.

Keep Close Track of These Concepts
1. The Channel Select Display, next to the Master
L/R meters, always displays the currently
selected channel number no matter which Fader
Bank is selected. If an adjustment is required in
the Fat Channel, verify that the channel you
intend to adjust is displayed here.
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CHANNEL

OL
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30
35
40
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LEFT

33

RIGHT

2. Be sure you verify the Bank Selection whenever
you need to make a change. At first it’s easy to
forget to check the Fader Bank status. However,
once you’ve adjusted to the layered consoles,
maneuvering throughout the entire console will
become second nature.

MASTERS

SHIFT

1-24

25-48

MIC/LINE

TAPE IN

(TRACK)

(MONITOR)

49-72

EFFECTS
BANK SELECT

Figure 1-5 Signal-Flow Diagram
Simply begin at the far left star and follow the route the signal must take to reach the master output.
DSP includes all dynamics, equalization, and phase controls.
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Level
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Level
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3. When using the V-Pot to adjust a parameter,
make sure it’s assigned to make the change you
need. Since the V-Pot is a multifunction
control, it’s easy to assume it’s doing the job you
want when it might be changing a completely
different setting. Intentionally check the status
of the V-Pot before making a change.
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ANALOG STEREO
INSERT/RETURN

KEY INPUT
Default: Itself (the channel)
OR:
CHANNEL TAP
BUS TAP
AUX TAP
2-TRACK DIGITAL INPUT

PRE-DSP
INSERT
(CHANNEL TAP
AND PLUG-INS)
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INSERT
(PLUG-INS
ONLY)
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LINE IN

LINE 13 (through 24)
TRIM
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Analog 8 channel TAPE CARD
(optional)

DELAY

DIG. TRIM

PHASE

COMP

GATE

HI PASS

PFL SOLO

EQ

FROM TAPE 33 (through 40)

A to D

MUTE

PAN

Analog 8 channel TAPE CARD
(optional)
FADER
FROM TAPE 41 (through 48)

A to D

Analog 8 channel TAPE CARD
(optional)

FX card A. inputs 49–52

Inputs 53–64
(optional — B, C, D cards)

ALT I/O CARD 65-72 (optional)

A to D

TDIF/ADAT 8 channel format
(optional)

AES/EBU & S/PDIF STEREO INPUT

PRE/
POST

TO CONTROL ROOM
SELECT

AUX 1–8

AUX
LEVEL

“Mackie
Digital 8•Bus
Block Diagram
4 / 12 / 2001”

AUX
PAN
AUX
LEVEL

AUX
LEVEL

AUX
PAN
AUX
LEVEL

Figure 1-6 D8B Block Diagram
This diagram provides a detailed view of the D8B signal path.
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Figure 1-7 D8B Gain Structure Diagram

D8B Manual • Chapter 1 • page 16

60 dB gain

40 dB gain

0

20 dB loss

20 dB gain

0

20 dB loss

+22 dBu max input

line in 13 - 24

mic in
1-12

+2 dBu max input

+22 dBu max input

line in
1-12

digital trim

0

0

level up +10

0

TRS +22 dBu max out

XLR +28 dBu max out

mix

st. aux pan cntr -3 dB

0

+22 dBu max input

0

gain dn –15 dB

gain up +15 dB

4 band EQ

+22 dBu max out

compressor

level up +20 dB

Inputs 25-48, Returns 1-8, 2 Trk A-C

0
0

ch aux level

Main L-R

0

level up +10 dB

Aux send

0

level up +10 dB

fat DSP

pan

0

0

Control Room

0

0

+22 dBu max out

EQ

gain dn –12 dB

gain up +12 dB

Mackie Designs
Digital 8•Bus
Gain Structure Diagram
5/15/01

Max Level @ Unity gain

0

level up +10 dB

Bus 1-8
Studio Out +22 dBu max out
Phones 1&2

channel fader

pan cntr –3 dB

level up +10 dB

Mackie Effects

Specifications

Analog Input/Output Section

Meters:
• LED ladders displaying 24 channels, 24 LEDs per
channel from –50 to 0 dBFS (0 dBFS = +20 dBu)

• Output Level (0 dBu = 0.775V RMS)
• Left and Right Outputs:
+22 dBu balanced 1/4" TRS
+28 dBu balanced XLR
• Bus (Tape) out:
+22 dBu balanced 1/4" TRS
• Aux sends:
+22 dBu balanced 1/4" TRS

Frequency Response:
• 20Hz-20kHz +/-0.5 dB

Crosstalk (@ 1kHz)
• Adjacent channels:

–90 dBu

• Aux sends feed through:
• Main outputs:

–90 dBu
–90 dBu

Equalizer

• Inserts:
+22 dBu unbalanced 1/4" TRS

Channel Section (mic/line)
• Line input: balanced 1/4" TRS input
• Mic Input: balanced XLR input

• Gain Range:

±15 dB

• Frequency range:

20Hz-20kHz
split into 4 bands
1/12 to 3 octave

• Preamp dynamic range:
114 dB max.
• E.I.N.:
–129.5 dBu, 150 ohm source
–131.2 dBV, 150 ohm source

• Threshold:
• Attack:

–60 to –1 dB
0.3 ms to 2.6 sec

• CMRR:
–83 dBu @1kHz
• Distortion: 0.005% @ 1kHz
+14 dBu output level
(20Hz-20kHz filter)

• Release:
• Ratio:

80 ms to 2.6 sec
1:1 to 20:1

• Output:

0.0 dB to 20 dB

• Q:

Compressor

Gate

• Mic gain range:
Unity to +60 dB
• Line In gain range: –20 dB to +40 dB
(channels 1-12)
–20 dB to +20 dB
(channels 13-24)

• Threshold:
• Attack:

–60 to –1 dB
0.1 ms to 0.6 sec

• Input max. level:

+4 dBu nominal
+22 dBu clipping
• Aux send gain range: off to +10 dB

• Release:
• Range:

80 ms to 2.6 sec
0 dB to 100 dB

• Bus out gain range: off to +10 dB
• Threshold:
–60 to –1 dB
• Ch. fader gain range: –100 to +10 dB

Digital Specs

Physical Dimensions

• Converters:
24-bit, 115 dB Signal-to-Noise-Ratio (EIAJ),
106 dB Dynamic Range, 128X oversampling
• DSP:
32 bit (>190 dB dynamic range)

• Console:
8.7" x 37.6" x 27.1" (221mm x 955mm x 688mm)

• CPU:
300 MHz Celeron
(166 MHz Pentium in earlier versions)

Weight

File Storage:

• Remote CPU:
5.25" x 19.0” x 20.0" (133mm x 483mm x 508mm)

• Console:
73 lbs. (33.1kg)
• Remote CPU:
50 lbs. (22.7kg)

• Floppy drive, internal hard drive or 10-base-T
Ethernet network

Dither:

Note: All specifications subject to change without
notice.

• Apogee UV22 16-bit Super CD Encoding onboard

D8B Manual • Chapter 1 • page 17

8.7"
(221mm)

Physical Dimensions

27.1" (688mm)

37.6" (955mm)

D8B
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(33.1 kg)

D8B CPU
SHIPPING
WEIGHT
50 lbs.
(22.7 kg)

CPU
19.00" (48.3cm)
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5.25"
(13.3cm)
3U

20" (50.8cm)

17.25" (43.8cm)

Updating Software
Software upgrades can easily be downloaded
from the Mackie website at www.mackie.com.
Find the D8B section and select “Downloads.”
Always read the Release notes that accompany the
software downloads. They contain valuable information specific to the current software revisions
and install procedures.

Windows-based Computers
Follow these steps if you are downloading
onto a Windows®-based computer:
1. Download the .ZIP files d8b3xxxx_PC.zip for
the operating system installation, and the D8B
Plug-in Demo Kit (Demo_Plugins_3xxx_PC.zip)
for the plug-ins installation.
2. We recommend that you update the operating
system first. Double-click on the d8b3xxxx_PC.zip
file. This will launch the WinZip™ selfextraction utility.
3. The default "Unzip To" directory is set to C:\. If
you prefer to have the files extracted to a
different location, type the path into the provided
text box and then press the Unzip button. Quit
the WinZip™ self-extraction utility.
4. Locate the two extracted files, labeled
d8b3xxxx Install 1.exe and d8b3xxxx Install
2.exe, on your hard drive.
5. Double-click on the first file, d8b3xxxx Install
1.exe, and you'll see a "WinImage™ Self
Extractor" dialog box.
6. Ensure that the "Writing On Floppy" check box
is selected, then click the "OK" button in the
upper right corner of the dialog box.
7. When the "Batch Assistant" dialog box appears,
insert a double-sided, high-density 1.44MB
floppy disk into drive A:\ and then click the
"OK" button.
8. When the Winimage™ utility has completed
writing to the first disk, be sure to label your
disks so you know which is #1 and which is #2.
Additionally, be sure not to leave either disk in
your floppy drive. Rebooting your PC with the
disk in the drive can create problems with your
PC. Repeat steps 5 through 7 for the second
disk image file.
9. With the D8B console power supply turned off,
insert installation disk #1 into the floppy disk
drive.
10. Power on the console power supply.
11. Follow the instructions on the D8B control
surface. (Note: The installer no longer uses the
VGA screen; typical boot is about 30 seconds.)
12. Place the 2nd floppy disk in the drive when
prompted by the installation software.

13. Remove the 2nd floppy disk when prompted and
power down the console power supply, then
power back on.
14. You now have the updated D8B operating
system installed.
15. Make sure you read the release notes. They
have important info about this upgrade.
Note: Repeat the above procedure with the
Demo_Plugins_3xxx_PC.zip file to install the
plug-in update. After updating the plug-ins
software on the D8B, you must perform the “Erase
UFX Memory” and “Upgrade UFX Cards”
procedures (under Windows in the upper menu
bar) to upgrade the UFX cards that are installed in
the D8B (see page 86).

Macintosh Computers
Follow these steps if you are downloading
onto a Mac OS® computer:
1. Download the self-extracting file
d8b3xxxx_Mac.sea for the operating system
installation, and the D8B Plug-in Demo Kit
(Demo_Plugins_3xxx_Mac.sea) for the plug-ins
installation.
2. We recommend that you update the operating
system first. Double-click on the
Demo_Plugins_3xxxx_Mac.sea file to extract
the two disk images.
3. Launch Apple's DiskCopy utility (you may need
to download the DiskCopy utility from http://
www.apple.com or check the system
installations disks that came with your system).
4. Depending on your version of DiskCopy, either
click the "Load Image File..." button or choose
"Make a Floppy" from the Utilities menu.
5. Locate the image file labeled d8b3xxxx Install
1.img that was extracted onto your hard drive.
6. DiskCopy will prompt you (depending on your
version of DiskCopy) to insert a floppy disk into
the floppy disk drive. With older versions of Disk
Copy, you may need to click the "Make a copy"
button first.
7. Once the disk has been ejected from the
computer, be sure to label your disk so you know
which is #1 and which is #2. Then follow steps 4
through 6 to create the second installation disk
from the second disk image file (d8b3xxxx
Install 2.img).
8. With the D8B console power supply turned off,
insert installation disk #1 into the floppy disk
drive.
9. Power on the console power supply.
10. Follow the instructions on the D8B control
surface. (Note: The installer no longer uses the
VGA screen; typical boot is about 30 seconds.)
11. Place the 2nd floppy disk in the drive when
prompted by the installation software.
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12. Remove the 2nd floppy disk when prompted and
power down the console power supply, then
power back on.
13. You now have the updated D8B operating
system installed.
14. Make sure you read the release notes. They
have important info about this upgrade.
Note: Repeat the above procedure with the
Demo_Plugins_3xxx_Mac.sea file to install the
plug-in update. After updating the plug-ins
software on the D8B, you must perform the “Erase
UFX Memory” and “Upgrade UFX Cards”
procedures (under Windows in the upper menu
bar) to upgrade the UFX cards that are installed in
the D8B.

Note to Macintosh USB Floppy drive users:
Apple's Disk Copy program will not work
using the above method with a USB floppy drive
because the menu option "Make a Floppy..." will
not be available. You must use Aladdin Systems'
ShrinkWrap program available for purchase and
trial download from http://www.aladdinsys.com/
shrinkwrap/index.html. Once you have
ShrinkWrap installed, substitute these steps for
steps 3-6 in the above directions.
3. Launch ShrinkWrap.
4. Select "Write Image back to Disk..." from the
Image menu (command-B).
5. Locate the image file labeled d8b3xxxx Install
1.img that was extracted onto your hard drive.
6. ShrinkWrap will prompt you to insert a floppy
disk into the floppy disk drive.
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Summary
This chapter has been specifically designed to
help you understand the basic concept of the Digital
8•Bus architecture. The following two chapters
describe the physical surface controls and the
software features and capabilities. The last chapter
describes specific applications as they pertain to
unique recording tasks and needs.
Chapters 2 and 3 support what you’ll encounter
in Chapter 4. Feel free to jump ahead, but keep in
mind that you’ll probably need to use these second
two chapters as a reference for the terms and
controls that are new to you.

Where Is It?

Chapter 2
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DIGITAL I/O
S/PDIF

8

Channels 1–12 Inputs
5
+48V
PH

4
+48V
PH

3
+48V
PH

2
+48V
PH

2

1
+48V
PH

MIC

MIC

MIC

MIC

MIC

MIC

LINE IN

LINE IN

LINE IN

LINE IN

LINE IN

LINE IN

INSERT

INSERT

INSERT

INSERT

INSERT

INSERT

Each channel contains:
• XLR mic input. Be sure the MIC button is pressed
down on the control surface channel strip.
• Phantom power On/Off button depending on
mic requirements.
• 1/4" TRS line input—balanced or unbalanced.
Be sure the MIC switch is in the up position
on the control surface channel strip.
• 1/4" TRS channel insert/direct output jack.

TDIF

OUT

5
DIGITAL EFFECTS CARDS

6

OUT

IN

This section describes rear panel connector types,
their functions, and associated signal buses.

ANALOG I/O

PDI•8

OUT

7

64 1 2 3
APOGEE
CLOCK I/O

IN

IN

Rear Panel Description

+48V
PH

1

SYNC

DIGITAL I/O
AES/EBU

ANALOG OUT

D

ADAT OPTICAL

C

ANALOG IN

B

AES/EBU I/O

A

WORD
CLOCK
OUT

No matter how fast you want—or need—to get
started, take advantage of this simple map of the
territory: it provides the Fast Track overview of
the D8B. It’s amazing how artistically supportive
this console is. It’s well worth your time to take a
look at all the controls so you can put them to
work efficiently.

Card Cage Section

WORD
CLOCK
IN

It’s Time to Locate Everything…

DIGITAL I/O

SYNC

ALT I/O

OPT•8

TAPE IN/OUTS

This is where you plug in the optional I/O cards of
your choosing, to customize the Digital 8•Bus for
your own application.
There are three slots assigned as TAPE IN/OUTS.
Each slot provides I/O for 8 channels, so you can
add up to 24 tape sends and returns, or additional
inputs and outputs.
• TO TAPE (OUTPUT) – The D8B can route any
channel in Fader Banks 1, 2 and 3 to the
multitrack through these connectors. In addition,
the bus outputs in Fader Bank 4 (MASTERS) can
be routed out the tape outputs.
• FROM TAPE (INPUT) – Multitrack outputs are
fed back into channels 25–48 (Fader Bank 2)
through these connectors. Depending on the
specific I/O card, these inputs will receive any
line-level analog or digital signal.
Each I/O card contains its own labeling protocol,
but the fundamental concepts described above
pertain to all.

1 Analog I/O (AIO•8)
• Each 25-pin D-sub connector handles 8 balanced
analog channels.

Channels 13–24 Inputs
LINE INPUTS
(BAL /UNBAL)

18

17

16

15

14

13

24

23

22

21

20

19

Channels 13 through 24 have 1/4" TRS (Tip/Ring/
Sleeve) line input connectors that accept balanced
and unbalanced signals.

• Top connectors send line-level outputs to the
multitrack (or other line-level equipment).
• Bottom connectors receive line-level analog
signal from the multitrack outputs (or other
line-level equipment).
• Each card offers I/O for 8 channels.
• Connectors are compatible with TASCAM
DA-88, 25-pin analog connectors.

2 Apogee Digital I/O (DIO•8)
• Two digital-format ins and outs: ADAT optical
(fiber optic connections) and TASCAM TDIF
(25-pin D-sub connections).
• Select one digital format at a time in the Setup
screen.
• One BNC sync connector for master clock connection from the D8B to TASCAM clock recipient.
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• Use the DIO•8 card as a format converter between either optical and/or TDIF.

• Using the configurable plug-in architecture,
insert plug-in capability is available for channels 1–48 (Pre- and Post-DSP), and Main Mix
L-R, in addition to internal effects sends
(Auxes 1–12).

3 ADAT Optical (OPT•8)
• Two digital ADAT optical (fiber optic) connections.
• Each card offers I/O for 8 channels.

• Effects return to the main L-R mix at Fader
Bank 3 (FX 1–16)

4 AES/EBU (PDI•8)
• One 25-pin D-sub connector in digital
AES/EBU format.

Reminder: Power down the system
before installing any cards!

• Each card offers I/O for 8 channels.

5 ALT I/O Card Slot
• Separate input/output card slot offering 8
more ins and outs.
• Holds any card: AIO•8, DIO•8, OPT•8, or
PDI•8.

Master Input/Output Section
BUS OUT 1-8
&
SURROUND OUT

• Inputs show up at RETURNS faders (channels
65–72).
• Outputs are assignable to either the 8 bus outputs (BUS 1–8), the 12 Aux Sends (AUX
1–12), or the MASTER L-R outputs.

bl

• Assignments are made in the Digital I/O menu.

6 The Clock I/O Card
• Provides word clock in and out to connect
with other digital equipment.
• For use as a master or slave clock source.
• Supports 48kHz and 44.1kHz internal sample
rates, with vari-speed capabilities.
• Supports external sample rates between
32kHz and 50kHz.
Note: The Apogee Clock I/O card replaces the
standard clock card that is shipped in the
SYNC slot with the D8B.

7 The Digital I/O Card (2-track)

L

9 bm

MASTER OUT
L R

2 TRACK IN A
L R

CR
MAIN
L R

2 TRACK IN B
L R

CR
NEAR FIELD
L R

2 TRACK IN C
L R

PHONES 1

PHONES 2

bn
br

STUDIO OUT
L R

bo

PUNCH I/O

TALKBACK

R

bp bq
MASTER OUT

9 MASTER OUTputs (1/4" TRS and XLR)
• Fed from the Master L/R fader on the console
surface.
• Both sets deliver balanced line-level signals.
However, the TRS Master Outputs also provide unbalanced line-level signals.

• AES/EBU digital I/O. Stereo interconnect for
master record machine. Input is connected to
DIGITAL 1 in the CONTROL ROOM monitor
section.
• S/PDIF digital I/O. Input is connected to DIGITAL 2 in the CONTROL ROOM monitor section.

• Post fader, DSP, and D/A converter.

• Same source output as MASTER L-R.

• Any channel (1–48), internal effects return,
or ALT IN can be assigned to one or more bus
outputs.
• Output level is controlled by the BUS 1–8
MASTERS (Fader Bank 4).

8 Digital Effects Card Slots
• Room for four separate effects cards.
• MFX – Mackie Effects card with two stereo
processors.

bl BUS OUT 1–8 (SURROUND OUT)
• 25-pin D-sub connector provides eight balanced line-level outputs.

• Carries Surround monitoring channel outputs.

• UFX – Universal DSP engine with functions
dependent on specific plug-in effects. Each
card is capable of four discrete mono, two stereo, or one stereo and two mono effects.
• Aux sends 1–12 internally route to the four
card locations.

D8B Manual • Chapter 2 • page 23

bm CR MAIN and CR NEAR FIELD

br 2 TRACK A, B, and C

• Pairs of 1/4" TRS stereo line-level outputs for
sending signals to control room speakers.

• Balanced 1/4" TRS inputs for receiving linelevel analog signals from a 2-track recorder.

• Both outputs carry the same signal (as selected
in the Control Room section).
• Levels can be adjusted independently or
linked together.

• The separate left/right pairs feed the 2 TRACK
A, B, and C buses in the control room monitoring section.
• Can accept balanced and unbalanced signals.

• 1/4" TRS outputs can drive a balanced or unbalanced input.
• Level controlled by the V-Pot in the
SOLO/STUDIO section of the control surface,
when STUDIO LEVEL is selected.

bp PUNCH I/O
• A remote switch connection for activating the
MMC master record function—to punch in or
out of record.
• Use with a normally-open switch.

bq TALKBACK
• A remote switch connection for engaging the
talkback function.
• Duplicates the Talkback switch in the CONTROL ROOM section.
• Use with a normally-open switch.

D8B Manual • Chapter 2 • page 24

• When stereo effects are selected, regardless of the Aux input selection,
returns appear at the FX faders numbered the same as their respective slots.
For stereo effects with mono inputs, the
effects return at the respective slot
numbered pair (input 9 returns at FX 9/
10; input 11 returns at FX 11/12, etc.)

AUX
1
AUX
2
AUX
3
AUX
4
AUX
5
AUX
6

AUX OUT

(BAL/UNBAL)

• Signal at these outputs is determined by the
CONTROL ROOM source selection.
• Balanced analog stereo-paired outputs for
sending signals to the studio.

AUX
7

bo STUDIO OUT L-R

AUX
8

• The Master L/R mix can be copied to either or
both Aux 9–10 or 11–12 Cue Mixes.

Note: Auxes 1–12 simultaneously feed the
analog Aux sends and the internal effects
cards.
Each MFX card handles two separate
mono inputs, so auxes are paired. MFX
effects returns are stereo, so each card,
while receiving two discrete mono inputs,
returns two sets of stereo outputs to the
EFFECTS Bank. Internally, Aux 1 returns
to FX 1/2; Aux 2 returns to FX 3/4; Aux 3
returns to FX 5/6; continuing through Aux 8,
which returns at FX 15/16.
UFX cards handle 4 mono, two stereo,
or one stereo and two mono inputs.
For each UFX card, no matter what the
Aux input selection, returns appear at the
FX faders numbered the same as their
respective slots.
If all UFX effects are mono, each return
correlates directly to the Slot number ( 9 to 9,
10 to 10, etc.)

AUX
9

• The signal at these outputs is determined by
the PHONES/CUE MIX 1 and PHONES/CUE
MIX 2 source selection on the control surface.
• Aux 9–10, Aux 11–12, or the CONTROL
ROOM selection can feed either or both
Phones/Cue outputs.

• Auxes 9 and 10 are linked together as a
stereo pair of 1/4" TRS analog line-level
outputs.
• Auxes 11 and 12 are linked together as
a stereo pair of 1/4" TRS analog linelevel outputs.

AUX
10

• Each jack carries an unbalanced stereo signal
through a 1/4" TRS jack.
• Designed to connect to virtually any stereo
headphones. Phones 1 and 2 V-Pots adjust to
compensate for headphones with exceptionally high or low impedances.

• There are 12 Aux sends available.
• Auxes 1–8 provide mono 1/4" TRS analog line-level outputs.

AUX
11

bn PHONES 1 and 2

AUX OUT Section

AUX
12

• Post-DSP, Master L/R fader, and D/A converter.
• The signal fed to these outputs is selected in
the CONTROL ROOM section of the control
surface.

Note: Patching from an Aux output does not interrupt
the internal sends to the FX Cards, so it’s possible to
run both internal and outboard effects at the same time.

PARALLEL

CONSOLE DATA

5
4

6

3
MOUSE

1

KEYBOARD

2
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Remote CPU Description
Data and Synchronization I/O
These connections are specifically pertinent to
non-audio functions (or, in plain English, these
aren’t audio connections!).

Connecting a Mouse, Keyboard and
SVGA Monitor
The Digital 8•Bus is designed to work as a standalone console. However, you’ll increase your
options and productivity by using a mouse, keyboard, and SVGA monitor. Simply connect them to
the corresponding ports on the back of the Remote
CPU for access to point-and-click commands with
the mouse, as well as key commands and text entry
from the keyboard.

3 The SVGA Monitor
• A hi-density 15-pin D-Sub connector is provided
to connect an SVGA monitor.
• Use at least a 17" multisync SVGA monitor capable of 1024 X 768 resolution and a 72Hz
refresh rate. Larger monitors provide greater
viewing pleasure.
• Use of monitor provides graphic display and
control of most console functions, including
equalization, compression, gating, internal effects, automation editing, and file
management.
• The SVGA monitor can be connected without
turning off the Digital 8•Bus (hot-plugable).

Other Connections
4 Console Data

1 The Mouse Port

• A 25-pin D-sub connector connects the console
to the Remote CPU using the cable supplied.

• Connect a PC-compatible mouse (PS/2 style).
• A two-button mouse is sufficient.

5 MIDI

2 The Keyboard
• Connect any PC-compatible keyboard
(QWERTY style).
• Must have a 5-pin DIN connector. An adapter
can be used for the 9-pin keyboard connector.

Note: Turn the Digital 8•Bus OFF
before connecting these devices. The
Digital 8•Bus must boot up with these
peripheral devices connected in order
for them to work properly.

• MIDI card in the remote CPU uses a 9-pin
D-sub connector.
• Install the supplied 9-pin to dual 5-pin adapter
to facilitate connection to your MIDI network
using standard MIDI cables. This could be a
plastic housing adapter or a rattail 9-pin split
to 5-pin I/O connection.
• MIDI IN receives MTC, program changes, and
controller, note, and poly aftertouch messages.
• MIDI OUT sends MMC commands, program
changes, and controller, note, and poly
aftertouch messages.
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6 Ethernet Port

2 Mic/Line Button

• Accepts an RJ45 telco connector.

• On channels 1–12 only.

• Connects to PC/Mac for FTP file transfer
through a network or peer-to-peer.
• Can be used to make peer-to-peer connections
with other Digital 8•Bus consoles.

• This button selects between the Mic Input (XLR) and the Line Input (1/4" TRS).
• Up position selects the line input (1/4"
TRS).

• Use CAT5 for standard network FTP connections;
use crossover CAT5 for peer-to-peer connections.

• Down position selects the microphone
input (XLR).

Control Surface Functions
For a road map to the various knobs, buttons,
and faders, refer to the D8B Overview section of
this manual.

3 REC/RDY
• The Record Ready button arms the corresponding tape track to record.
• Communicates via MMC (MIDI Machine
Control).

Channel Strip Section

4 Assign

The channel strip on the Digital 8•Bus is very
much like the channel strip on an analog mixer.
Each channel offers the same set of controls, with
a few exceptions. Even with a brief overview of
each control, you’ll find your understanding of the
digital mixing concept closely related to what you
already know about analog mixers—that’s the
beauty of this console design.
• There are 24 channel strips.
• There are four layers (Fader Banks) of feature
sets: MIC/LINE (1–24), TAPE IN (25–48),
EFFECTS (49–72), and MASTERS.
• Channels 1–12 have both mic and line input
capabilities.
• Channels 13–24 have line input capabilities only.
• Channels 25–48 receive signal only from the
I/O card inputs.

• Routes audio to output buses 1–8.
• Routes audio to the Master L-R bus.

1 Trim Level

• Assigns the selected channel to the
channel strip’s corresponding tape track
for recording. For example, after selecting ROUTE TO TAPE in the
ASSIGNMENT section, press SELECT
on channel 2, then press the ASSIGN
button on channel 12 to route the signal
from channel 2 to tape track 12.

TRIM
LINE
MIC

1
0

-20dB

12

2

MIC

3

REC/RDY

4

ASSIGN

5

WRITE

6
12
36

8

SELECT

9

SOLO

bl

MUTE

5 Write
MIDI 4

• Manually enables a channel for recording to automation.

FX 12

12
36

• Blinks when on standby; solid when active.
• Automatically lights when Auto Touch
automation has been activated.

dB

10

• At the top of each channel strip
• The Trim Level controls only input levels for
channels 1–24.
• Regardless of bank selection, trims are active and
available for channel inputs 1–24. This is handy
for tweaking without having to switch banks.
• Used to adjust and optimize input levels.
• This control is one of the few not written in a
snapshot.

Note: The TRIM levels at the top of each of the 24
channel strips and the MIC buttons at the top of the
first 12 channel strips are not written into automation
or snapshots. Careful notes as to their status should
be manually archived—as in written down—for future
reference. However, if TRIMs are all left at unity gain—
or at least left untouched—throughout the entire
session, the console is capable of perfect, total recall!
We highly recommend this technique.
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60
+40dB

6 Channel V-Pot
• A multifunctional digital control and
level display.
• Controls channel pan when PAN is selected in the Master V-Pot section (just
to the right of channel 24).
• Controls Aux send levels when Aux
1–12 is selected in the AUX section (just
above the Master V-Pot).
• Controls panning between stereo Auxes
9/10 and 11/12 when PAN is selected
below either send.
• Controls channel Level to Tape and Digital Trim whenever they’re selected
(immediately above Aux 1 and 2 select
buttons).
• Displays return fader levels (Bank 2)
when level to tape follows faders.

5

bm
U

5

10

20

30

40
50
60

7

7 Fader Bank Select LEDs
• Just below the channel V-Pots.
• When the green LEDs are on, Fader Bank 1 is
selected (MIC/LINE).
• When the red LEDs are on, Fader Bank 2 is
selected (TAPE IN).
• When both LEDs are on, Fader Bank 3 is selected (EFFECTS).
• When neither LED is on, Fader Bank 4 is selected (MASTERS).

8 Select
• Chooses a channel to be edited.
• Enables onboard or on-screen Fat Channel
control over the selected channel.
• Operative for copying and pasting data between channel strips.
• Part of the grouping and linking procedures.
• Double-clicking the SELECT button opens and
closes the strip’s on-screen Fat Channel.
• Pressing and holding opens a channels preferences page in the VFD, which controls basic
channel parameters.
• Pressing and holding two SELECT buttons at
once opens a Link options page in the VFD.

9 Solo
• Pressing Solo on any channel lets you hear
only the soloed channel.
• Mackie’s exclusive Rude Solo Light flashes incessantly whenever any channel is soloed.
• There are three different types of soloing
available: PFL, AFL, and Mixdown.
• PFL (Pre-Fader Listen) solos the signal before
it gets to the fader. PFL is a monitor function
only and has no effect on the Master L-R mix
send. Any channel is soloed in mono, regardless of pan position. PFL solo level is
unaffected by fader changes.
• AFL (After-Fader Listen) solos the signal after the fader in the signal path. Therefore, solo
level is affected by fader movement. AFL solos
the accurate pan positioning and, like PFL, is
only a monitor function not affecting the Master L-R mix.
• Mixdown Solo is a post-fader, pan-accurate
solo that overrides the Master L-R mix.
• Clear Solo, in the Solo/Studio section, releases any solo selections. This is particularly
useful when working with solos across multiple fader banks.

• Aux Solo is accomplished by selecting an aux
bus, then pressing the SOLO button by the
Master V-Pot. When this solo light is on, the
Master V-Pot adjusts the solo level.
• Soloing multiple channels is accomplished
by holding the shift key (onboard or keyboard)
while pressing the solo buttons on all desired
channels or, by holding one solo down while
pressing others. Also, selecting “Solo Latch”
in Setup > Mix Options keeps solos selected
until they’re manually switched off.
• Solo Isolate mode is accomplished by holding
down the Alt key on the keyboard or control
surface while pressing a channel’s solo(s). A
solo isolated channel is always active to the
solo bus and therefore will not mute when
other channels are soloed. Only PFL solo
mode overrides Solo Isolate mode.

bl Mute
• Mutes the signal after the channel fader.
• Prior to the L-R output bus.
• Prior to Bus 1–8 outputs.
• Does not affect the Direct Out to Tape unless
console is configured for Faders to Tape mode.

bm Channel Fader
• Controls the signal level from the channel to
the bus or buses it is assigned to (typically the
L/R Master Fader and the Bus 1–8 output).
• Doesn’t affect the signal level to the Tape Outputs unless specifically routed to do so, or if
console is configured for Faders to Tape mode.

Channel Meters
• Indicate post-EQ, pre-fader levels.
• The audio level display is scaled in digital
dBFS (decibels full-scale).
• 0 dBFS = +20 dBu (Clipping occurs at +22
dBu.)
• –15 dBFS = +5 dBu
• The minimum displayed level is –50 dBFS.
• Markings next to the LED ladders are denoted
as –50 dBFS to OL; they are similar in function to those of digital recorders. Each
LED-segment is accurate within ±1 dB.

Note: Typically, in digital recording devices such as
MDMs, HDRs, or DATs, there is a built-in overhead of
3–4 dB above the 0 dBFS mark to match the typical
maximum unbalanced analog console bus output value
of +22 dBu. The OL LED lights at +22 dBu.
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Master Section Description
The Master Section—everything to the right of
channel strip 24—is divided into 13
subsections. They are:
• Master Fader/Bank Select Section
• Master V-Pot Section
• V-Pot Assign Section
• Fat Channel Section
• Studio/Solo Section
• Phones/Cue Mix Section
• Control Room Section
• Clipboard Section
• Master Fader/Shortcuts Section
• Bus Assignment Section
• Automation Section
• Session Setup Section
• Transport Section

Master Section

Master Fader/Bank Select
Section
This section consists of:
• The four buttons used to select the four Fader
Banks.
• The SHIFT button, which is primarily used to
select and deselect multiple channels.
• The Master L/R Fader, which controls the signal
level going to the L-R stereo bus.
All 96 channels are always active. However
only 24 are available at a time from the control
surface (up to 48 are available through the onscreen interface). The buttons used to select the
active fader set are:
• MIC/LINE (TRACK)
• TAPE IN (MONITOR)
• EFFECTS
V-Pot Select
• MASTERS

Fat Channel

MIC/LINE (TRACK)
• Fader Bank 1.
• Selects channels 1–24.
• Combination of Microphone
inputs 1–12 and line inputs
1–24.

TAPE IN (MONITOR)
• Fader Bank 2.
• Selects channels 25–48.
• Requires 1–3 Tape I/O
cards installed in the card
cage for input signals.
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Master V-Pot
Bus Assignment,
Control Room

Solo/Studio,
Phones 1 & 2

Automation,
Setup

Master Fader,
Bank Selection
Transport
Clipboard, Master L/R,
Shortcuts

SHIFT Button
MASTERS

SHIFT

1-24

25-48

MIC/LINE

TAPE IN

(TRACK)

(MONITOR)

49-72

EFFECTS
BANK SELECT

MASTER
L/R
dB

10

5

U

5

10

20

30

40
50
60

The SHIFT button serves multiple functions.
It provides a way to select multiple channels and
multiple solo buttons. It also serves as a fine-tune
selector for Aux levels and Pan adjustments. Try
adjusting an Aux level with and without the
SHIFT button depressed—notice the difference in
numerical scrolling speed.
• Allows more than one channel SELECT button
to be engaged simultaneously.
• Allows more then one SOLO button to be engaged simultaneously.
• When SHIFT is pressed, the Rude Solo Light
illuminates.
• Allows fine-tuning of Aux send levels and pan
adjustments.
• Allows independent control of channel parameters with linked channels.
• Double-clicking selects all channels on the active fader bank.

Master L/R Fader
• 100mm logarithmically-tapered fader for
smooth fades.
• Remotely controls level via DSP—doesn’t
pass audio like a traditional fader.
• dB level ranges from +10 dB (fully on) to – ∞
(fully off).
• Mixdown Solo level control.
• Provides level adjustment to tape outputs (if
desired).

EFFECTS

Master V-Pot Section

• Fader Bank 3.
• Selects channels 49–72.
• Effects bank controls sixteen internal effects
returns and eight ALT I/O returns.

MASTER

MASTERS
• Fader Bank 4.
• Selects channels 73–96.
• Faders 1–8 control the virtual group levels.
• Faders 9–16 are assignable MIDI controllers.
• Faders 17–24 control the eight bus or
surround outputs (BUS 1–8), which are output
via the 25-pin D-sub connector labeled BUS
OUT 1–8 & SURROUND OUT on the rear of
the console. The BUS 1–8 outputs can also be
assigned to the 24 tape outputs, or the
ALT I/O slot.

PAN

SOLO

MASTER V-Pot
• Acts as the Master level control for the currently selected Aux bus.
• In all surround mode settings, the MASTER
V-Pot acts as the front/rear pan control for the
selected channel (provided the PAN button is
lit). When used along with the channel pan
V-Pot, the D8B acts like an audio rendition of
the family favorite Etch-A-Sketch®!
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MASTER PAN

AUX 1–8 Buttons (Default Operation)

• Assigns all applicable channel V-Pots to act as
pan controls (channels 1–72 and 81–88).
• Stays lit continuously until an Aux Select,
Level to Tape, or Digital Trim button is engaged.

MASTER SOLO (Aux)
• Solos the currently selected Aux.
• Only one Aux can be soloed at a time.
• Master solo can be active at the same time a
channel is soloed.
• Aux bus remains soloed until it is manually
disengaged or until the CLEAR SOLO button
is pressed.
• Solo level is post the MASTER V-Pot.
• Master Solo is not affected by the PFL or AFL
Solo status selected in the Studio/Solo section.

V-Pot Assign Section
These buttons:
• Assign the channel V-Pots to control individual
aux send levels.
• Assign the channel V-Pots to control individual
channel trim or tracking output levels.

This description highlights the default
configuration for aux sends and effects returns.
Keep in mind that the new D8B plug-in architecture
provides maximum flexibility and awesome creative
capabilities with respect to plug-ins, aux sends,
and returns.
• Pressing any Aux 1–8 assigns channel V-Pots
to control individual send levels to AUX 1–8
output.
• Each Aux 1–8 is simultaneously routed to the
corresponding 1/4" jack on the rear of the
console and to an internal effects processor.
• Patching from the Aux 1–8 jacks does not
interrupt the signal flow to the internal processors.
• Each Aux 1–8 acts as a mono send to a stereo
internal effects processor (MFX card only).
UFX cards offer complete flexibility.
• Auxes patched to the IVL Vocal Studio effects
return to four channels, either in stereo pairs
(second pair is the reverb return) or as four
separate channels.

AUX 9–10 and 11–12
• Configured differently than Auxes 1–8.
• Each channel has a stereo pair of controls:
one level and one pan. This is ideal for
phones/cue mixes or for an additional recording feed in a live setting.
• Pressing Aux 9–10 assigns the channel V-Pot
to control the send level for the stereo pair.
• Pressing Pan under Aux 9–10 assigns the
channel V-Pot to adjust pan positioning between
the stereo pair.

1-24

1-48

LEVEL TO TAPE

DIGITAL TRIM

AUX 1

AUX 2

AUX 3

AUX 4

• Aux 9–10 are not routed to the internal effects
processor by default, but may be assigned as
such in the plug-in configuration window.
• Aux 11–12 operates identically to Aux 9–10.

AUX 5

AUX 6

LEVEL TO TAPE

AUX 7

AUX 8

AUX 9-10

AUX 11-12

PAN

PAN
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• Level to Tape assigns the channel V-Pots as
tape output level controls via the I/O cards.
• This control is post channel DSP and prefader. Fader adjustments don’t affect tape
output levels.
• Facilitates optimizing the gain structure from
the beginning to the end of the signal path,
when used correctly.
• When Faders to Tape is active, the level to
tape is derived from the source channel faders
instead of the channel V-Pots—the level is
post-fader.

Figure 2-1 Aux Sends 1-8 (Default – Mackie Stereo Effects [MFX])
Aux 1 – 4
TRS Out

Aux 5 – 8
TRS Out

1-24

1-48

LEVEL TO TAPE

DIGITAL TRIM

AUX 1

AUX 2

IN

OUT

IN

Internal Effects Processor 1
IN

OUT

Internal Effects Processor 3

Internal Effects Processor 6
AUX 3

AUX 4

AUX 5

AUX 6

AUX 7

AUX 8

IN

IN

Internal Effects Processor 7

IN

IN

Internal Effects Processor 4
OUT

FX 1 FX 2

L

R

FX 3 FX 4

L

R

OUT

IN

Internal Effects Processor 2
OUT

OUT

Internal Effects Processor 5

FX 5 FX 6

L

AUX 9-10

AUX 11-12

PAN

PAN

FX 7 FX 8

R

L

R

FX 9 FX 10

L

R

OUT

Internal Effects Processor 8
OUT

FX 11 FX 12

L

R

FX 13 FX 14

L

R

FX 15 FX 16

L

R

Eight mono aux sends, each returning a stereo effect

DIGITAL TRIM
• Pressing the DIGITAL TRIM button assigns
the channel V-Pots to become digital trim
(digital input level) controls.
• Functionally located immediately after the A/D
converter in the signal path for channels 1–48.
• When using digital I/O cards, for channels
25–48, there is no A/D converter, so the digital trim is simply the first control in the signal
path after the card.
• Digital Trim is a recallable function, unlike
the analog Trim control. It can be automated
or stored in a snapshot.
• Digital Trim is the only input trim control for
channel inputs 25–48.

Talkback Mic

ways: 1) by pressing Talkback in the Control
Room section, 2) by pressing a foot pedal connected to the Talkback jack in the rear of the
console.
• Talkback audio is sent to the Phones/Cue
Mixes when pressing Talkback or depressing
the foot pedal, or to the Studio monitor system
when pressing Talkback to Studio.

Left/Right LED Ladders (Master Meters)
• Located above the Talkback Mic.
• Indicates the signal level of whatever is selected in the Control Room section.
• When Solo is selected, the Master Meters indicate the level of the combined soloed channels.
• When Mono is selected in the Control Room
section, both Left and Right meters indicate
the mono level.

• Located just above the LEVEL TO TAPE and
DIGITAL TRIM buttons.
• The Talkback mic is activated two different
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CHANNEL Select Display

V-Pots and SELECT buttons

• Just to the right of the L-R Meters.
• Numeric readout indicates the selected channel
—the currently editable channel in the VFD.

• Four Select buttons and V-Pots used to select
and adjust options that show up in the Fat
Channel VFD.
• Pressing Select above a Fat Channel V-Pot
lets the user adjust or scroll through the
pertinent options.

CHANNEL

OL
2
4
7
10
15
20
25
30
35
40
50

LEFT

• V-Pots rotate 360˚ and display the relative
adjustment positions as provided by eleven
discrete LEDs.

RIGHT

PREVIOUS and NEXT arrows

Fat Channel Section

• Pages the VFD to more parameters whenever
more than four adjustments can be made.
• The PREVIOUS button scrolls the VFD to
the left.

The onboard Fat Channel provides access to all
those really cool dynamics and EQ functions. It
also provides for configuring Setup parameters,
loading, and saving patch information.
The on-screen Fat Channel is an amazing
interface that provides the look and feel of a
vintage tool as well as precision control and
recall.

• The NEXT button scrolls the VFD to the right.
• An arrow on the left-hand side of the VFD,
pointing left, indicates a previous page is
available.
• An arrow on the right-hand side of the VFD,
pointing right, indicates the next page is
available.

Fat Channel Display
• VFD Vacuum Fluorescent Display.
• Provides a text interface to console operation.
Nearly all static functions and controls are
accessible.

D8B
GAIN
-1.0 dB

56 INPUT / 72 CHANNEL DIGITAL MIXER

GAIN
+2.2 dB

GAIN
0.0 dB

GAIN
+3.1 dB

SUPER CD ENCODING

PREVIOUS

EQ

SELECT

SELECT

SELECT

SELECT

HELP

LOW

LOW MID

HI MID

HI

NEXT

ON

SETUP

MEMORY A

MEMORY B

GATE

The Fat Channel
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COMPRESSOR

PLUG-INS

LOAD PATCH

SAVE PATCH

ON button
Toggles the selected Fat Channel DSP control
parameters on and off in bypass fashion.

SETUP button
When EQ is selected in the Fat channel, the Setup
button lets you select the type of equalization and
activate the “EQ to Dynamics” mode.

MEMORY A and B buttons
• Each channel has two memory locations for
EQ, compressor, gate, plug-ins, and surround
parameter comparisons.
• Any changes to the above controls are temporarily stored in the selected Memory A or B
buffers.
• Simply press Memory A to instantly recall the
settings you developed while Memory A was
selected. Press Memory B to instantly switch
to alternate settings.
• Automation of the parameters will overwrite
the buffers unless bypassed.

EQ button

SAVE PATCH button
Press this button to store an individual EQ,
compressor, or gate into the current Fat Channel or
plug-in setting to the onboard library. You must
choose EQ, Gate, Compressor, or a plug-in before
trying to save a patch.

Studio/Solo Section
This section contains a V-Pot to control Studio,
Solo, and Talkback levels, along with buttons to
select various solo functions and talkback to the
studio monitor system.

MIXDOWN SOLO button
• This solo status interrupts the L-R Main outputs to front-of-house speakers or 2-track
recorders. It is the destructive solo.
• Use this mode whenever you want the soloed
track(s) to be the complete mix—a rhythm
breakdown is a good example of this.
• Mixdown Solo is post-fader and DSP. Level to
tape (e.g., 2-track mixdown recorders) is controlled by the Master L/R fader.

Press this button to see EQ parameters for the
selected channel in the onboard Fat Channel display.

GATE button
Press this button to see Gate parameters for the
selected channel in the onboard Fat Channel display.

COMPRESSOR button
Press this button to see Compressor parameters
for the selected channel in the onboard Fat Channel
display.
Note: Fat Channel SELECT and page (PREVIOUS
and NEXT) buttons are used as additional view tools.

PLUG-INS button
• Press this button and use the prompts from
the VFD to select and navigate through the
various plug-in specific parameters.
• Use the “Next” and “Previous” buttons to page
through all available parameters.

Onboard control of plug-ins is intuitive for
basic functionality. Refer to the individual Plug-ins
Manual for details regarding the use of each plugin via the control surface or on screen.

LOAD PATCH button
Press this button to load an individual EQ,
compressor, or gate into the currently selected
channel. Plug-in settings previously stored in the
onboard library can be loaded into an FX card. DSP
type must be selected first.

STUDIO/SOLO

MIXDOWN SOLO

RUDE SOLO
LIGHT

CLEAR SOLO

PFL SOLO

SOLO LEVEL

AFL SOLO

STUDIO LEVEL

TALKBACK LEVEL

TALKBACK TO
STUDIO

LEVEL

PFL SOLO button
• Activates Pre-Fader Listen on the solo bus.
• Accesses the signal before it gets to the fader,
so the fader has no effect on the soloed signal.
• This is a mono-centered solo feature. Pan has
no control over this solo feature.

AFL SOLO button
• Activates After-Fader Listen on the solo bus.
• Accesses the signal after the fader, so fader
moves do affect the soloed signal.
• This is a stereo—post-pan control—bus so
soloed channels are heard in their correct pan
position.

Note: PFL/AFL only affects channel soloing and has
no effect on aux send soloing.
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TALKBACK TO STUDIO button

AUX 11-12

Routes sound arriving at the in-panel Talkback
mic to the Studio outputs.
Note: Make sure the speakers that are connected to
the Studio Outs are located in another room to avoid
feedback when the TALKBACK TO STUDIO button is
depressed.

CLEAR SOLO button

Assigns the Aux 11-12 mix to the Phones output.

COPY MIX TO CUE button
Pressing this causes all channel settings to be
copied to the channel V-Pots for the selected CUE
MIX 1 (Aux 9-10) or CUE MIX 2 (Aux 11-12). This is
a very quick way to copy the MASTER L-R mix,
including effects, to the phones output, which can
then be easily fine-tuned.

CONTROL ROOM button

Disengages all engaged solo buttons throughout
the entire console. This is especially convenient
considering sections may be soloed across multiple
fader banks.

SOLO LEVEL button

Assigns whatever is selected in the Control Room
section to the Phones output. Solos are also routed
to the Phones output when Control Room is selected.

LEVEL V-Pot
Adjusts the Phones output level.

Assigns the V-Pot in the Studio/Solo section to
adjust the solo level being fed to the Control Room
outputs. Not applicable to mixdown solo (use L/R
fader to adjust mixdown solo level).

STUDIO LEVEL button
Assigns the V-Pot in the Studio/Solo section to
adjust the output level being fed to the Studio
monitor system.

Control Room Section
These buttons:
• Select the source for the control room outputs.
• Select Main or Nearfield control room outputs.
• Adjust the listening level.
CONTROL ROOM

TALKBACK LEVEL button
Assigns the V-Pot in the Studio/Solo section to
control the preamp level for the in-panel Talkback Mic.

RUDE SOLO LIGHT

2 TRACK A

DIGITAL IN 1

2 TRACK B

DIGITAL IN 2

2 TRACK C

MASTER
L-R

• Blinks whenever a Solo button is engaged.

MONO

NEAR FIELD

Phones/Cue Mix Section
PHONES/CUE MIX 1

MAIN

SPEAKERS

PHONES/CUE MIX 2

SPEAKER LEVEL
AUX 9-10

COPY MIX TO CUE

AUX 9-10

COPY MIX TO CUE

AUX 11-12

CONTROL ROOM

AUX 11-12

CONTROL ROOM

DIM

TALKBACK

2 TRACK A, B, and C buttons
LEVEL

LEVEL

• Selects the signal at the 2 Track A, B, or C input as the Control Room source.

Phones/Cue Mix 1 and 2 select the sources and
sets levels for the Phones outputs.

AUX 9-10
Assigns the Aux 9-10 mix to the Phones output.
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• These inputs can be selected independently or
together for simultaneous playback along with
the MASTER L-R button.

Note: When DIGITAL IN 1 or DIGITAL IN 2 are selected,
MASTER L-R and 2-TRACK inputs are unavailable.

DIGITAL IN 1 button
Selects the AES/EBU digital input as the Control
Room source.

DIGITAL IN 2 button
Selects the S/PDIF digital input as the Control
Room source.

MASTER L-R button
Selects the main L-R output bus as the Control
Room source.

TALKBACK button
Routes the signal arriving at the in-panel
Talkback Mic to Phones/Cue Mixes 1 and 2 (and to
Studio Out if Talkback to Studio is selected).

Clipboard Section
Provides cut, copy, paste, and undo functions for
specific fader operations, channel parameters, and
automation events.
CLIPBOARD

MONO button
Combines the left and right channels to a
monaural signal and sends it to the left and right
Control Room outputs (Near Field or Main). This
provides for a quick check on the sound of the mix in
mono.

NEAR FIELD button
Turns on the Control Room Near Field output.

MAIN button
Turns on the Control Room Main output.
Note: The Near Field and Main speaker selections
cannot both be on at the same time.

CUT/ZERO SET

COPY

PASTE

UNDO

CUT/ZERO SET button
• Deletes edited parameters from the currently
selected channel(s) and returns them to their
default settings.
• Static or automated options are selected in the
Fat Channel display.
• The parameter settings are placed on the clipboard for desired paste operations.

COPY button
• Copies parameters from the currently selected
channel(s).

SPEAKER LEVEL V-Pot
• Adjusts the individual level of the selected
Control Room output (Near Field or Main).
• This control does not affect the level sent to
the Phones/Cue, or Master L-R mix
outputs.
• Near Field and Main levels are completely
independent of one another unless linked together in the Mix Options of the on-screen
Setup window.
• When linked, the level control is identical for
Near Field and Main. The link can be temporarily broken by pressing the Shift key and
adjusting the Speaker Level V-Pot. This is an
excellent way to set a fixed level offset between
monitor sets.

• Static or automated options are selected in the
Fat Channel display.
• The parameter settings are placed on the clipboard for desired paste operations.

PASTE button
Pastes copied parameters to the currently
selected channels.

UNDO button
• Reverts the currently selected channels to their
previous status, before a cut, copy, or paste.
• Multiple Undo and Redo operations are available by pressing UNDO in the Clipboard
section then Undo and Redo in the control surface Fat Channel VFD.

DIM button
Quickly attenuates the control room monitors by
20 dB. This is very useful for phone calls or visits
from the neighborhood volume cop.
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Master L–R/Shortcuts Section
MASTER L/R

SHORTCUTS

SELECT

CONTROL

WRITE

ALT

L-R button
• When L-R is selected, the individual channels
can be assigned or removed from the Master
L-R bus.
• Mic, Line, FX, and Returns (Channels 1–72) can
all be assigned in this way to the L-R Master bus.

ROUTE TO TAPE button
SELECT button
Selects the Master Fader and Aux Master for
edit operations.

WRITE button
Displays automation status and engages the
Master Fader and Aux Master to record automation
events—dependent on the automation mode.

CONTROL button
Used in combination with other buttons as a modifier
key. See Shortcuts (Appendix D) for a list of applications.

ALT button
Used in combination with other buttons as a modifier
key. See Shortcuts (Appendix D) for a list of applications.

Bus Assignment Section

• Assigns a selected channel to any or all of the
24 tape outputs.
• Any of the 48 channels, as well as any internal
FX returns, Alt I/O return, or Bus 1–8 can be
assigned to one or more, or all (24) Tape Outputs.
• When ROUTE TO TAPE is selected, press the
SELECT button on the channel you want to
route to tape, then press ASSIGN on the channel
strip that corresponds to the desired Tape Output.
• No two channels can be assigned to the same
tape output (you can assign two or more channels to a bus, and route the bus to tape). As
soon as a channel is assigned to a previously
assigned output, it takes over the output, thus
removing the previous assignment.

Note: Great care should be taken whenever a channel
is assigned to its own tape track. Beware the dreaded
feedback loop. Ouch!

This is a quick and easy way to assign, or tell what’s
been assigned to, Bus 1–8 or the Master L-R bus.
ASSIGNMENT
ASSIGN

ASSIGN

BUS 1

BUS 2

ASSIGN

ASSIGN

BUS 3

BUS 4

ASSIGN

ASSIGN

BUS 5

BUS 6

ASSIGN

ASSIGN

BUS 7

BUS 8

ASSIGN

ASSIGN

L-R

ROUTE TO
TAPE

BUS 1–8 buttons

Automation Section
What Is Automation All About?
Even if you’ve never worked with an automation
system, you’ll find the controls in the Mackie Real
Time OS intuitive and powerful. Spend a little time
grasping the concepts, then start mixing.
If you’ve worked with other automation
systems you’ll find the Mackie OS incredibly quick
and easy to master. A complete digital system
that’s been designed well is amazingly powerful
and easy to use. Have fun!

• Only one bus may be selected in the assignment
section at a time.
• Bus assigns are used along with the individual
channel Assign buttons.
• Press any Bus 1–8 button. Any channel that’s
assigned to the selected bus will have its Assign
button lit on the individual channel strip (on
the currently selected bank).
• Pressing the channel Assign button so the
light stays on will assign that channel to the
selected bus. Pressing Assign so the light
goes off removes the assignment.
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AUTOMATION

BYPASS

FADERS

MUTES

AUTO TOUCH

FADER MOTORS
OFF

PAN

ALL

TRIM LEVELS

BYPASS button
• Bypasses the playback of all currently written
automation moves.

• This button must be turned off before any automation can be recorded or played back.

AUTO TOUCH Mode

• Toggling Bypass doesn’t affect the automation
filter LEDs (Faders, Mutes, Pan, All). However, when Bypass is on no automation data
will be recorded.

• Activates Auto Touch write mode for automation data.

FADER MOTORS OFF button
• Pressing this button (so the yellow light is on)
disengages fader motors, which prevents any
automated fader movement during automated
playback.
• When the button is engaged, all faders snap to off.
• Turning fader motors off does not affect
changes that have been recorded during automation record passes. All automated levels still
play back even though the faders don’t move.
• The on-screen faders still show movement
even when the physical faders are off. Fader
moves may still be written to automation using
the mouse.

FADERS button
Allows writing of Fader moves during an
automation pass. When FADERS is activated, all
fader moves on write-enabled channels are written
into automation. Can be used in conjunction with
MUTES, PAN, and ALL.

MUTES button
Allows writing of mutes during an automation
pass. When MUTES is activated, all mutes on writeenabled channels are written into automation. Can
be used in conjunction with FADERS, PAN, and ALL.

PAN button

• All activated automation control points become write-enabled and enter automation
record mode at the instant they’re modified
from their current state.
• It’s not necessary to engage individual channel WRITE buttons in this mode. Manually
engaging WRITE in this mode only affects
fader, mute, and pan writing (if they’re activated in the Automation section).
• The channel WRITE button illuminates as soon
as a channel function is manually adjusted
(and the corresponding filter is activated).
• One or more of the automation buttons (FADERS, MUTES, PAN, or ALL) must be activated
or nothing will be written to automation.
Note: Fader, mute, and pan data may be overwritten if these filters are activated and the
channel is write-engaged.

TRIM LEVELS button
• Activates Trim Level automation on all writeenabled channels. This refers to trimming
automated moves up or down, not to analog or
digital level trim controls.
• All faders move to unity (U) and fader motors
are turned off.
• Previously recorded automation remains intact. However, fader and V-Pot changes are
simply added to or subtracted from existing
data.
• This is a good way to edit parts of an automation track. See “Modify Levels” on page 55 for
level-adjusting an entire track.

Allows writing of Pan moves (stereo and
surround) during an automation pass. When PAN is
activated, all pan changes on write-enabled channels
are written into automation. Can be used in
conjunction with FADERS, MUTES, and ALL.

ALL button
• Allows writing of all automation parameters
other than faders, mutes, and pan.
• In order to record an automation pass, recording every automatable parameter, FADERS,
MUTES, PAN, and ALL must be activated.
• Parameters selected by the ALL button are
Aux 1–12 levels, Aux 9–12 pans, Master Aux
levels, Digital Trim, all channel DSP functions
(EQ and Dynamics), plus Plug-in/Effects parameters, bus assignments, surround panning, etc.
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Session Setup Section

GROUP button

SETUP

SAVE

SAVE AS...

NEW

LOAD

GROUP

GENERAL

PLUG INS

DIGITAL I/O

Buttons in this section are used for file maintenance and for setting up system functions such as
Virtual Groups, Digital I/O, meter assignment, and
MIDI parameters.

SAVE button
• Saves the currently active session to the internal
hard drive or floppy drive. We recommend using the floppy only for backup.
• Saves all snapshot and automation data as
well as the status of all digital parameters at
the time of saving.

SAVE AS… button
• Saves the currently active session under a
new name.
• Uses the V-Pots and SELECT buttons in the
Fat Channel display to rename and complete
the operation.
• To finish the SAVE AS… either press Select
beneath SAVE in the onboard Fat Channel display or simply press SAVE AS… a second
time.
• To quick-save the proposed file name, simply
double-click SAVE AS…

• Brings up the Group menu in the Fat Channel
display.
• This is a virtual group function where faders
and mutes are linked to one master fader, solo,
and mute button in the Master fader bank.
• After pressing GROUP, press the SELECT buttons on each channel strip to be included in
the group, then press Exit to complete the action.
• Control the group from the Master fader bank,
where faders strips 1–8 control groups 1–8.

GENERAL button
Brings up the General menu in the Fat Channel
display. Provides access to:
• Solo settings
• The surround sound matrix
• MIDI Machine Control settings
• Console layout (channel reassignment)
• Record Safe and Write Ready status settings
• VFD display brightness
• Network cascading and Alt I/O assignments
• One-button record status
• About current OS version

PLUG-INS button
Brings up the Plug-In menu in the Fat Channel
display for selecting the effects package to load into
the internal FX card. Refer to the individual Plug-ins
manuals for specific implementation.

NEW button
• Press this button to start a new session. This
is the same as New Session… in the on-screen
File menu.
• The New Session menu appears in the onboard
Fat Channel.
• All Template preferences are loaded at the beginning of a New session.

LOAD button
• Brings up the LOAD menu in the onboard Fat
Channel display. This is the same as Open
Session… in the on-screen File menu.
• Facilitates the loading of previously saved session files from the hard drive or floppy disk.
• Sessions can be scanned in the Fat Channel
display by pressing the first two SELECT buttons on the left or by turning the far left V-Pot.
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DIGITAL I/O button
• Brings up the Digital I/O configuration menu
in the Fat Channel display.
• For selecting Tape I/O, Alt I/O, and Stereo I/O
settings.
• For selecting and setting the internal sample
rate or assigning the console to sync to external
word clock.

Transport Section

SMPTE VIEW button

This section provides control for external recorder
transports, time display, snapshots, locates, and loops.

This button toggles between SMPTE/MTC time
and BBT (Bars/Beats/Ticks) in the Position display.

POSITION display

Number Buttons 0–9

• Shows the numeric representation of SMPTE
or MIDI Time Code (Hours: Minutes: Seconds: Frames) or a musically referenced
display (Bars: Beats: Ticks).

• Used to numerically enter Snapshot, Locate,
and Loop points in the Range display, and
time values in the Position display.

• When the console is receiving time code, this
display continually updates according to the
time code position.
• Displays entered values for Locate storage.

• When numeric buttons are used to enter data,
you must press ENTER to complete the action.
• Pressing the number keys while holding CONTROL scrolls through the on-screen interface
windows.

RANGE display

ENTER button

• Shows the snapshot number in Snapshot
mode.

• Initiates numeric changes that have been
typed into the snapshot, locate, position, or
range display from the console number buttons (or standard IBM-style keyboard
connected to the console).

• Shows the most recently entered MMC locate
point when in Locator mode.
• When looping it shows the beginning (FROM)
and ending (TO) locate points for the loop.

• Pressing CONTROL and ENTER increases the
SNAPSHOT or LOCATOR selection (control
surface only).
• Pressing ALT and ENTER decreases the
SNAPSHOT or LOCATOR selection (control
surface only).

SET TIME button
• Press this button to enter a new time in the
Position Display (in Hours: Minutes: Seconds:
Frames or Bars: Beats: Ticks)
• The number buttons are used to enter the time.

LOCATOR button

• Press ENTER to complete the action. This
sends an MMC locate command.
RANGE

POSITION
HOURS

MINUTES

• Allows the number buttons to be used for entering specific location numbers.
• Each location number (00 – 99)
may represent a specific time during
an MTC-referenced playback or recording, if previously stored.

SECONDS

FRAMES

BEATS

TICKS

FROM

TO

SET TIME

BARS

SMPTE VIEW

LOOP

1

2

3

4

5

6

7

8

9

0

ENTER

LOOP

STORE

LOCATOR

SNAPSHOT
MODE

REWIND

FAST FWD

STOP

PLAY

RECORD

SHUTTLE

JOG & SHUTTLE

JOG

• When in this mode, the left two
digits in the Range display indicate
the locate point number.
• Locate points can be captured
while tape is moving. Simply hit
STORE, the Locate number, and then
ENTER at the instant you wish to
store a location.

LOOP button
• Used to set the start and end Locate
points in a Loop.
• To loop a segment, first enter the
locate start point using the numeric
buttons (onboard or computer keyboard), then press ENTER.
• Next, press LOOP, enter the ending
locate point number, then press ENTER.
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STORE button
This button is used to save locate points and
console automation snapshots to the currently
displayed number or a user-entered number.

RANGE

POSITION
HOURS

MINUTES

SECONDS

FRAMES

BEATS

TICKS

FROM

TO

SET TIME

BARS

SMPTE VIEW

LOOP

SNAPSHOT button
• Allows the number buttons to be used for
entering snapshot numbers.
• When in this mode, the left two digits in the
Range display indicate snapshot numbers.
• Onboard snapshot range is from 00–99,
equivalent to MIDI program changes 00–99.
• More snapshots are available from the onscreen interface.

1

2

3

4

5

6

7

8

9

0

ENTER

LOOP

STORE

LOCATOR

REWIND

FAST FWD

STOP

Engages external machine to fast rewind with no
given locate point.

FAST FWD button
Engages external machine to fast forward with no
given locate point.

STOP button
Stops external machines at the current position.
Note: The STOP button lights when time code is not
being received by the D8B.

RECORD

JOG & SHUTTLE

• These buttons control external devices that
respond to MIDI Machine Control (MMC).
MMC is transmitted from the MIDI output
port on the rear panel of the remote CPU to
MMC-compatible devices.

REWIND button

PLAY

SHUTTLE

Transport Controls

• Transport controls can be programmed to export specific MIDI messages other than
standard MMC protocol. See MIDI Mapping
on page 85 for more details.
Note: MMC is not bidirectional. The D8B sends
out MMC commands to your tape recorder(s),
but if you arm tracks or operate transport controls from the tape recorders, the activity is
not transmitted back to the D8B via MMC.
You can, however, press Play on your recorder
and, as soon as time code is received by the
D8B, it reverts to PLAY mode.

SNAPSHOT
MODE

JOG

Note: The PLAY button lights when time code is being
received. It flashes when you press it and no MTC is
received.

RECORD button
• Engages Master record function on external
machines and Write Ready engaged automation channels.
• Must be pressed with PLAY to engage record
mode unless One Button Punch mode is active.
• One Button Punch allows punching into record
without hitting PLAY (see “Mix Options” on
page 66).
• Pressing any transport button takes the D8B
and peripherals out of record status.

JOG & SHUTTLE button
Engages the rotary dial (below the REWIND,
FAST FWD, STOP, and PLAY buttons) to advance
external machines forward or backward with singleframe accuracy when using MMC.
When Jog & Shuttle is enabled, the REWIND and
FAST FWD transport buttons send out MMC shuttle
commands, usually corresponding to fixed speed
increments (i.e., 1/4x, 1/2x, 2x, etc.).

Rotary Dial Encoder
PLAY button
Engages external machine to play at normal
speeds from the current location.
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This multifunction dial enables the scrub function.

What’s On TV?

Chapter 3
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Using the Graphic
User Interface (GUI)
The Beauty of It…
The Digital 8•Bus provides
exceptional power from the control
surface alone. However, when
combined with an on-screen Graphic
User Interface (GUI) the console offers
yet another facet of audio bliss.
Some features are only available onscreen and are much easier to perform
on-screen. Yet some control surface
features are more efficient, like multiple
fader moves or inverse fader moves.
The software functions included
herein are definitely in the “I always
wanted to be able to do that” category.
In this section, we touch each control
and parameter—section by section.

• To jump the fader to a specific point in the fader
throw, simply click the mouse on that point.
• This fader has no effect on the channel input level.
It controls channel level to bus 1-8, L/R mix, and
the aux outputs or, if Faders to Tape is selected,
level to tape.

Label Fader (Scribble Strip)
• Double-click in the channel name region.
• Type in track name.
• Tab to next channel or shift+tab to previous
channel.
• Press enter or click anywhere else on-screen to
exit “track” naming.

The Mouse
All references to mouse clicks imply
left-click on the PS/2 mouse unless
otherwise specified. Certain keyboard
commands combine with mouse clicks
to increase capabilities of the OS and to
help increase speed and accuracy.
• Control-click implies holding the
Control (Ctrl) key down while clicking
on an item.
• Alt-click implies holding the Alt key
down while clicking on an item.
• Drag implies holding the mouse
button down while moving it across the
screen or across channels.

FADER
• Directly mirrors the onboard fader.
• Click and hold on fader; drag up
and down to adjust fader level.
• When FADER MOTORS is turned
off in the automation section, fader level
can only be adjusted on-screen.
• Fader Bank 2 can be viewed onscreen along with any other selected
Fader Bank (Ctrl-8 or on-screen Faders
button.
• To set fader to unity gain, click
anywhere in the fader throw region
while holding down Control on the
keyboard.
• Right-click a channel fader and
drag across several adjacent faders to
copy its level position to each.
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MUTE
• Highlighting the MUTE button turns the channel
off in the main mix and bus 1–8 outputs.
• Use the mouse to click the MUTE button and
highlight it.
• Simply click on more MUTE buttons to mute more
channels.
• To select or deselect multiple adjacent MUTE
buttons, click and hold on any MUTE, then drag
across the desired channels.

SOLO
• The function of the SOLO button (PFL, AFL, or
MIXDOWN) is dependent on the solo mode
selection in the onboard SOLO/STUDIO section.
• Click the on-screen SOLO button to hear one
channel alone.

• Hold the Shift key to solo more channels or select
Solo Latch mode in the Options menu.
• With the Shift key held, click and drag across
multiple SOLO buttons to select them all.

Quick Select Fat Channel
Simply double click the onboard SELECT button
to instantly open or close the Fat Channel. On
screen, double-click the select button, click on the
Fat Channel tab at the bottom of the screen, or
press Ctrl-6 to open the Fat Channel. To close it,
press Ctrl-6 again or, select the Fat Channel or
Close All tabs at the bottom of the screen.

=

SHIFT

= Multiple Solos

Solo Isolate Mode
This feature is useful when you want a track,
or tracks, to remain on, even when a solo button is
pressed. For instance, if you want to individually
solo each track along with the drums, simply
isolate the drum channels, then press individual
solo buttons.

ALT

Drag (opt.) = Solo Isolate

• Hold the Alt key and click—or click and drag
across—any number of channel SOLO buttons to
isolate them from the solo action.
• Alt-click on a Solo that’s in Isolate mode to remove
it from Isolate status.
• Channels in Solo Isolate mode have blinking
SOLO buttons. In AFL and MIXDOWN solo modes
they’ll be heard even when other channels are
soloed.
• For example, if you always want to hear the FX
along with any soloed channels, put the FX
channel in Solo Isolate mode.
• Not active during PFL solo status.
• Can also be turned on and off in the Channel List
(Ctrl+B).

SELECT
• Activates a channel for modification of any FAT
Channel parameters.
• Double-click Select to view on-screen Fat
Channel.

V-Pots
The onscreen V-Pots, like the onboard V-Pots, are
multifunctional. Click-Drag up to increase, pan right,
etc.; Click-Drag down to decrease, pan left, etc.
Control-click to set default value.
Increase

Decrease
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• Selects channel for cut, copy, and paste actions.
• Press shift, then click or drag across multiple
SELECT buttons to choose more than one.
• Right-clicking the mouse highlights multiple
channel SELECT buttons in the same way as
Shift-click.

Point and Click Aux Sends
To increase the send level, click to the right of any
Aux and drag to the right; drag to the left to
decrease the send. Control-click any Aux to set it
to unity gain.

Increase

Decrease

V-Pot
• Controls pan, aux level, aux pan, digital trim, or
level to tape, depending on selection in the
MASTER section.
• Click and hold on knob, then drag to change
setting.
• Drag up to turn knob clockwise or down to turn
knob counterclockwise.
• Control-click any V-Pot to set it to default value
(center, unity gain, etc.).

WRITE
• Activates channel to record automation data.

RECord
• Arms record on up to 24 tracks of any properly
connected multitrack(s). The machines must
respond to MIDI Machine Control (MMC) and they
must have proper MIDI device ID settings.
• Blinking lights indicate tracks are in record-ready
mode—as in, they aren’t recording yet.
• Solid red lights indicate that the multitrack is
running and active—as in, you better hope you’re
not erasing something you didn’t want to lose.
• Click, hold, and drag to select or unselect multiple
record buttons.
Note: If the RECord process isn’t working as expected,
verify that Record Safe is not checked in the Options/
Transport menu. With Record Safe selected (checked),
neither the D8B or any connected devices will enter
record mode.

AUX Send Levels
• Click and drag on the level indicator bar from left
to right to increase the Aux send, and drag from
right to left to decrease the level.
• The red bar indicates post-fader Aux level.
• The yellow bar indicates pre-fader Aux level.
• Control-click next to any channel Aux to set level
to unity.
• To copy an Aux level across multiple channels,
right-click on a level indicator, then drag across
several channels.
• A numerical Aux level readout displays directly
below the Aux grid where channel numbers
normally display.
• Pre/post Aux status is selected per channel or
globally in the Setup/Mix Options window.

Individual Pre- and Post-Aux Selection
Each individual Aux send can be either pre-fader
or post-fader.
• Alt-click on any Aux send to change its pre/post
status.
• Post-Fader Aux sends are indicated by red bars.
• Pre-Fader Aux sends are indicated by yellow bars.
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Aux Pans 9-10 and 11-12

Cool Quick EQ Box

• The blue bars after Aux levels 9 and 11 are pan
controls for Auxes 9/10 and 11/12.
• Click and drag left to pan left; click and drag right
to pan right.
• Center pan position puts the blue indicator half
way across the Aux level grid (the default
setting).
• Control-clicking sets the pan to center position.
• To copy an Aux pan across contiguous multiple
channels, Alt-Click or Right-Click on a pan position
indicator, then drag across several channels.

EQ On/Off
• Highlight to turn EQ on.

Quick EQ
Bypass the Fat Channel by Click-dragging directly
in the main screen EQ box. This procedure doesn’t
provide immediate pinpoint accuracy but is very
quick in the heat of battle.

The blue box directly below the EQ
on/off icon offers lightning-fast access
to powerful equalization.
• When EQ is on, adjustments to the
overall EQ curve can be performed
quickly without entering the Fat
Channel.
• Click on the EQ line and drag up or
down to boost or cut frequency ranges.
All four bands can be adjusted here.
• Click on any boost or cut, then drag
right to raise the selected frequency or
left to lower it.
• Control-click on any boost or cut, then
drag left to increase bandwidth or
right to decrease it.

Note: Right-click in the box to open an edit
menu. This menu provides options to Undo,
Redo, Open, Save, Cut, Copy, Paste, and
Reset the channel EQ status.

Compressor On/Off
• Highlight the Compressor button (C) to
turn the compressor on.

Increase

Gate On/Off
• Highlight the Gate button (G) to turn
the gate on.

Control+Click

• Highlight Phase button (ø) to invert
the channel polarity 180˚.

Narrow Q

Wide Q

Bass

Treble

Phase
Decrease
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Digital Trim
• The blue bar above the Compressor, Gate, EQ, and
Phase buttons graphically indicates the digital
trim level.
• While adjusting Digital Trim, the track number
window below the Auxes displays the digital trim
level whenever Digital Trim is selected for the
V-Pot on the control surface or on-screen.

• Click and drag left or right to change the trim
level.
• Control-click to set trim level to unity.
• Right-click and drag to copy trim level across
multiple channels.

Level To Tape
• The red bar above the Digital Trim indicates Level
To Tape.
• Click and drag left or right to change the level.
• Control-click to set level to unity.
• Right-click and drag to copy trim level across
multiple channels.
• Faders to Tape mode (Options menu) ties the
source channel fader to the tape level output.
Notice, in this mode when the TAPE Bank is
selected a change in the fader displays a change
in the Tape Output level indicator.
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Multitrack Direct Outs
• A hyphen in the OUT box indicates no direct out
assignment.
• Click and hold in the OUT box to see the Tape Out
list.
• Drag down the list to the desired output, then
release the mouse button.

• Fader Banks 1, 2, 3, and the BUS OUTS 1–8 (in
Bank 4) can be routed to the direct outs 1–24.
• Click on “Reset Channel Only” to deselect all tape
output assignments for the selected channel.
• Click on “Reset All” to globally deselect all
channel and bank tape output assignments.
• Click on “Set Channel to All” to send the selected
channel to all 24 tape outputs. This is a
convenient way to track a single mic or
instrument while overdubbing (for the umpteenth
time) to multiple tracks. Simply select the desired
record track on the multitrack recorder. The
signal will always be there for you.
• Click on “Bank to Outputs” to send all 24 channels
on the current bank to consecutive tape tracks.

The Feedback Loop
Caution
Caution: When Bank to Outputs is selected from the TAPE IN bank—or anytime you assign
to a tape track from a tape return channel, then monitor the correlating fader—there is
potential for a nasty feedback loop. To create the feedback loop:
• Select the TAPE IN bank.
• Place the multitrack in record-ready.
• Assign a channel to its correlating multitrack input (Channel 25 to Tape Output 1, Channel
26 to Tape Output 2, etc.)
• Slowly raise the Level to Tape V-Pot—or if you’re in Faders to Tape mode, raise the
level of the TAPE bank channel fader—correlating to the tape track (Channel 25, 26,
etc.)
• Watch the nasty feedback loop on the meter bridge. You might not even be able to hear
the loop, but it’s there.
• Finally, try to never do that again!
Note
Note: This phenomenon is not specific to the D8B OS; it’s just the way interconnecting gear
works. To eliminate the possibility of a feedback loop is to rob creative flexibility from the
system. We all learn to avoid creating feedback loops in our working environment. But it
helps to be alerted to the possibility from time to time.

• Any channel can be sent to any number of tape
outputs by simply selecting multiple tape outputs:
however, only the last selected output is displayed
in the OUT window.
• No two channels can be assigned to the same tape
output. To sum channels to an output, assign
them to a bus, then route the bus to a tape out.

BUS and L/R Output Assignments
• Highlight any BUS out 1–8 to route the channel
through the selected bus out.
• Highlight the L/R button to route the channel to
the Main L/R mix output.

• To assign multiple channels to a
mono or stereo set of tape outs,
assign them to buses, or a pair of
buses, then send the bus output(s)
to tape.
• Stereo pairing is selected by
assigning a channel to any odd/
even bus pair (1/2, 3/4, 5/6, 7/8,
L/R, etc.) In this case, the PAN
control positions the channel
between the bus pairs.

The Master Strip
Master Fader
• Controls the Master Mix level.
• Ideally set at unity gain. Controlclick anywhere in the fader throw
to automatically set the fader to
unity.
• Click anywhere in the fader throw
to instantly snap to that level.

MASTERS, EFFECTS, TAPE, AND
LINE buttons

• Click and hold on any BUS or L/R button, then
sweep across adjacent channels to assign the
selected bus output to multiple channels.

These are the on-screen fader bank
selectors.
• LINE is Fader Bank 1
• TAPE is Fader Bank 2
• EFFECTS is Fader Bank 3
• MASTERS is Fader Bank 4
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MASTER V-Pot
• Functional as a master Aux level control when
any of the Auxes are selected in the Master Strip.
• When the PAN icon is highlighted, the Master
V-Pot functions as a front/rear pan position
control for any selected channel in all Surround
Modes (not stereo).
• The Master V-Pot SOLO button solos any selected
Aux bus.

CUE LEVEL and CUE PAN 1 and 2
• These buttons activate the channel V-Pots for L-R
and level adjustments for Auxes 9/10 and 11/12.
• Selecting CUE LEVEL 1 or 2 activates the
channel V-Pots for individual stereo send levels
and the Master V-Pot for the selected cue master
volume/level.
• Selecting CUE PAN 1 or 2 activates the channel
pan V-Pots for L/R placement.
• Click-drag the channel V-Pot up to move right;
click-drag down to move left.
• Control-click any channel V-Pot to set it to center
position (in PAN) or to unity (for LEVEL).
• Right-click a channel V-Pot and drag across
several channels to copy its level or pan to each.

AUX buttons 1–8
• Each button activates the channel V-Pots for Aux
send level adjustment.
• When any AUX button is highlighted in the
Master Strip, the Master V-Pot is activated to
control Master Aux output level.
• Click on the channel V-Pot and drag up to increase
level; drag down to decrease level.
• Control-click on the channel V-Pot to set it to
unity gain.
• Right-click a channel V-Pot and drag across
several channels to copy its level to each.

DIGITAL TRIM
• This button activates the channel V-Pot to control
the digital input level—pre DSP.
• Click on the channel V-Pot and drag up to increase
level; drag down to decrease level.
• Control-click on the channel V-Pot to set it to
unity gain.
• Right-click a channel V-Pot and drag across
several channels to copy its level to each.

TRACKING LEVEL
• This button activates the channel V-Pots to adjust
final post-DSP output level to the multitrack
outputs.
• Same control as the onboard LEVEL TO TAPE.
• This control fine tunes the channel output levels
to the multitrack.
• Click on the channel V-Pot and drag up to increase
level; drag down to decrease level.
• Control-click on the channel V-Pot to set it to
unity gain.
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• Right-click a channel V-Pot and drag
across several channels to copy its
level to each.
• When Faders to Tape is selected, the
tracking source channel’s fader and
Tracking Level V-Pot are equivalent
functions.

WRITE
• Activates the Master Strip to record
selected automation data by the Main
Fader or Aux Masters.
• Any moves in the Master Strip will be
recorded into automation if the
automation settings are set to receive
them.

SELECT
• Activates the Master Fader in the Fat
Channel display.
• Enables the Master Fader and Aux
Masters status to be included in the
“Set Default Levels…” prompt or in
the clipboard operations.

Master INSERT L/R
• Allows any plug-in to be patched into
the main mix outputs.
• Simply choose the desired plug-ins
from the list that pops up when
mouse-clicking the INSERT icon.
• This is a post-master-fader insert.

Signal Path Flexibility

Signal Path (INSERTS)

The D8B version 3.0 software provides many
new and exciting capabilities—check out these
new flexible routing options. Selecting an insert
on-screen is exactly the same as patching from the
signal path into an external effect, then back
through a patch bay or dedicated physical insert
point. Of course, digital patching induces no
extraneous noise, crackles, or degradation—so, in
that way it’s not like a patch bay at all.
A review of the signal path is helpful at this point:

Tape/Line/Mic Input
A/D Converter
Pre-Insert
Channel Delay
Digital Trim
Phase
Compressor, Gate
(Dynamics)
Dynamics Meter
Dynamics Output Meter
EQ
Post-Insert
Channel Metering

POST Insert
The POST Insert accesses the signal immediately past the EQ circuit and before the channel
meter and fader. This an excellent patch point for
individual channel effects, where it’s appropriate
to send the equalized and dynamically controlled
signal to effects like reverb or delay. The POST
insert is also a good choice when inserting an EQ
in place of—or in addition to—the existing
channel EQ.

PRE Insert

Using PRE-Insert for
Bus Mastering

• Patch nearly any channel in through this insert.
This is a great place to insert dynamic controls
since the level is constant and unaffected by EQ,
dynamics, or fader adjustments.
• Insert any plug-in.
• Source any channel, Aux Send or Return, FX Send,
Bus Out, or Digital Playback device at this point.
• This insert is a great choice for bus mastering,
with channel DSP and subsequent routing to the
Main L/R output.

 Assign Channels (Vox,
Drums, etc.) to Bus 1/2
 Select Bus 1 and 2 as
Pre-Inserts for Channels 47/48
 Use Channel Dynamics and
EQ for 47/48
 Select a Really Cool PostInsert Plug-in for 47/48
 Assign 47/48 to the Main L/R
Output
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The PRE and POST insert selections are
displayed in the readout windows immediately
above the INSERT icons. Clicking on the window
displays the assigned plug-in module.

•

To reset the channel to its original layout
configuration, simply select the original channel
number. Notice the Mackie OS places the
original number to the right of the main list for
your convenience.

Notice, the channels below have been moved
around to provide a better mixing configuration.

Channel Layout Reconfiguration
The Channel number indicator buttons provide
the capability to move channel strips around and
reconfigure the channel layout. This is a very
convenient feature, especially during mixdown.
For example, it helps to have all the vocals
together, so just reconfigure the channels so
they’re all on adjacent channels.
Anytime you need to have
immediate access to faders
from another bank, this
feature is a life saver. Simply
click on the channel number
and select the desired channel.
• Press the on-screen
channel number icon to
reveal the Channel List.
• Drag to select the desired
channel for this location
and release.
• When a different channel is
selected for a location, there
is no effect on any other
channels. For example, if
you select to move channel
30 to the channel 10
position, channel 30 still
remains in its original
position between 29 and 31.
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May I See A Menu Please
There’s amazing power and flexibility in the
Menus and Screens built into the Mackie OS. This
guide will serve as an excellent Quick Reference
for each menu and screen.

The File Menu
Contains:
• New Session (Ctrl+N)
• Open Session (Ctrl+O)
• Close Window (ESC)
• Save Session (Ctrl+S)
• Save Session As…
• Save As Template
• Reset Template
• Desktop (Ctrl+D)
• Shutdown (Ctrl+Q)

Open Session (Ctrl+O)
• Press Ctrl+O or click the File menu, drag down to
Open Session, and release.
• Use this to open a preexisting session file.
• As soon as the session is opened, the faders and
all other parameters move to their proper settings
for the opened mix or snapshot.

Close Window (ESC)
• Press Ctrl+W, ESC, or click the File menu, drag
down to Close Window, and release.
• Closes the front window (Setup, Snapshots,
Locator, Surround, Event List, Mix Editor Fat
Channel, or any menu screen with a CLOSE icon
in the upper right corner).

Save Session (Ctrl+S)
• Press Ctrl+S or click the File menu, drag down to
Save, and release.
• Saves the current session to its assigned hard
drive or floppy disk.
• If you don’t choose to activate the D8B automatic
save feature, press Ctrl+S often to ensure against
lost work—stuff happens.

Save Session As…
• Click the File menu, drag down to Save Session
As…, and release.
• Enter a new file name (or use the default name)
and select destination folder and/or drive.
• An extremely useful feature for saving variations
of a session.
• Lets the current session be saved under a new
name, leaving the original file untouched from
that point on.
• Good for backing up session data under a new file
name, or to a floppy or external drive.

Save As Template

Let’s take a quick look at each menu item.

New Session (Ctrl+N)
• Select this to—wait, let me guess—start a new
session.
• The OS will ask you to save changes to the
current session.
• Next, you get the chance to name the session,
select which folder it ends up in, create a new
folder to put it in, or cancel.
• The session can be saved to the internal hard
drive or to a 3.5" floppy disk.
• A session consists of all snapshots, automation
data, and—if you choose—custom EQ, effects,
and dynamics patches.
• A new session uses the Template as its initial
status.

The Startup session is no longer the “template” for new sessions, as it was in v2.0. The
startup file is like any other; it is only created and
named “Startup” if no other file exists.
The Template is stored separately, but it can
be updated at any point with the current static mix
levels, setup parameters, and track attributes of
any given mix. Simply pull down the File menu
and initiate the Save Template operation.
The following are stored in the Template:
• Channel Name
• Noise Filter setting (in Channel List)
• Channel Layout (rearrangement)
• MDS Network settings
• Stereo/Surround setting
• Current Tempo (default to 120 bpm)
• Time View (SMPTE/BBT/Milliseconds)
• Mix Editor – Grid Setting (resolution—called
Snap Grid in the pull-down), Enable Snapping,
Snap to Cues, Snap to Grid
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Many other functions carry over from session
to session when opening a new session (e.g.,
sample rate).
If you require a more finely tuned template,
try these approaches:
1) Import a snapshot of your favorite settings
(you must save one to the snapshot library first).
2) Do a “Save As...” of the current file. Keep a
primary snapshot on tap in this file to reset
everything. Then select all channels and apply the
Edit/Clear Automation. This doesn't clear any
dynamic automation in the plug-ins, so you have to
click on any MODE button in the Plugin Configuration window to clear plug-ins of assignment and
automation.
Note: Currently, it’s not possible to update or delete
the Template from the control surface VFD. If you are
working from the control surface without an on-screen
interface, you may want to save a session with all of
your favorite parameters in place, then after powering
up, recall this session as the starting point for the new
session. Remember to immediately save the new
session under a different name so your original settings
remain intact.

Gain access to the Desktop by:
• Clicking the File menu and dragging down to
Desktop.
• Pressing Control+D from the computer
keyboard.
• Clicking Desktop in the window selection bar
along the bottom of the on-screen interface.
To close open windows:
• Press Control+W to close the active window
(click once in a window to be sure it’s active).
• Click in the triangle-shaped icon in the upper
left-hand corner of the active window.
• Click Close All in the window selection bar
along the bottom of the on-screen interface.
To exit the Desktop:
• Click Mixer in the window selection bar along
the bottom of the on-screen interface.
• Press Control+D.

Reset Template
Restores a new session to the factory default
settings for all static parameters.
To reset the Template to the factory default
settings, select the File menu Reset Template
command.

The Desktop Window (Ctrl+D)
The Desktop offers file management features
unavailable from the onboard Fat Channel VFD,
such as deleting files, flushing the Toilet, mounting and refreshing drives, and copying multiple
files or folders.
Use the Desktop to:
• Copy files between floppy disks and the
internal hard drive.
• Flush files to the toilet (delete).
• Create new files.
• Rename files.
• Duplicate files.
• Mount/Refresh drives.
• Drag and drop files and folders between any
two open windows.
Note: The destination drive or folder must be
opened and displaying its contents for proper
placement to occur. In other words, don’t drop
files or folders onto closed folders.
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Hard Disk
• Click the Hard Disk icon to open the internal hard
drive.
• Common navigation procedures apply through
folders and sub-folders.

Floppy Disk

Mount/Refresh Drives

• Click the on-screen Floppy Disk icon to open the
floppy disk window.
• Common navigation procedures apply through
folders and sub-folders.

Any time a file doesn’t seem to have ended up
where you thought you put it, or you’ve swapped
floppy disks, selecting Mount/Refresh Drives will
update a file directory window to display its
current contents.

Desktop File Menu
Use the Desktop File Menu to:
• Close windows (ESC)
• Go Back to Mixer (Ctrl+D)
• Shutdown (Ctrl+Q)

Select All
Selects everything that’s selectable in the
open window.

Note: Anytime you save patches (EQ, compressor, gate,
plug-ins, etc.) the Mackie OS defaults to the User Presets
folder. Don’t fight this procedure! To guarantee that
your file will be around through various OS and plugin updates, keep your presets in the default locations.

Shutdown (Ctrl+Q)
Use the shutdown function to close the Mackie
Real Time OS prior to shutting off the D8B.

The Edit Menu
The primary edit window (faders overview screen)
contains some functions common to normal
computer use (Cut, Copy, Paste, Undo, Clear) along
with several very useful features unique to the D8B
operating system.

The Edit Menu Contains:

The Edit Menu within the hard disk and floppy
disk windows contain the same options.

New Folder (Ctrl+N)
• This action creates a new folder in the active
window.

Cut, Copy, Paste, Rename, Duplicate Files
You guessed it! All these items do all these things
to any selected file or folder.

Delete Files (DELETE)
• Highlight the file or folder and select Delete from
the Edit menu.
• Drag any file or folder to the toilet icon to remove
it from the disk.
• A Warning window stands between you and
complete erasure of the file to verify the action.

•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Undo (Ctrl+Z)
Redo (Ctrl+Shift+Z)
Cut Channels (Ctrl+X)
Copy Channel(s) (Ctrl+C)
Paste Channels (Ctrl+V)
Delete Events (DEL)
Set Default Levels…
Modify Levels (Alt+M)
Insert Time
Delete Time
Insert Global Time
Delete Global Time
Clear Automation...
Clear Edit History
Play From Selection (Ctrl+Space)
Select All (Ctrl+A)

Note: Once a file is put in the toilet (DELETED), there
is no way to recover it. It’s flushed!
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• Information in the clipboard can be pasted to
another channel, track, region, etc.
• Cutting data typically restores selected channels
or regions to their default settings or to off.
• The History List keeps a running list of the Edit
choices for later recall.

Copy Channel(s) (Ctrl+C)
• Places selected data on the clipboard, awaiting
reassignment.
• Copying data has no effect on the data being
copied.
• Copied data is reassigned using the Paste
command (Paste Channels, or the Paste button in
the onboard Clipboard section).

Paste Channels (Ctrl+V)
• Replaces the data in a selected channel, region, or
area with relevant data residing in the clipboard.
• When multiple channels are on the clipboard, data
from the lower channel numbers are pasted first
when there are fewer number of target tracks
selected.
• Paste can be undone.

Delete Events (DEL)
This action deletes any selected events or
range of events. This action is entered on the
History List and available for Undo, as long as it
remains on the list.

Set Default Levels…
Let’s take a quick look at each menu item.

Undo (Ctrl+Z)
• Reverses an action. If you’ve made a bad
automation pass, cut something you didn’t really
want cut, pasted somewhere you didn’t want to
paste, etc., simply select Undo and the D8B
reverts to its previous status.
• Selecting Undo multiple times steps back through
the history list (list of actions taken), all the way
back to the Top Level (starting point) if necessary.
Open the History List (Ctrl+H) to check it out.

Redo (Ctrl+Shift+Z)
• Reverses an Undo. If you’ve undone an action, or
set of actions, you might determine that your
original guess was best.
• Redo is a multilevel command, like Undo, so
multiple redo commands retrace your steps
through any undone actions in reverse order—the
last is first and the first is last.

Cut Channel (Ctrl+X)
• Removes selected data: channel, track,
automation, dynamics, etc.
• Information that’s been Cut is stored on the
clipboard, awaiting reassignment or purging.

D8B Manual • Chapter 3 • page 54

• This is a very useful automation tool and is the
primary starting point for the automation process.
• For use in automation, this feature sets the
current levels of the faders on the selected
channels as the default through the range of
SMPTE time code.
• Changes to automation data can be selected to
retain their adjusted status until another
automation move is written, or to snap back to the
default level upon exiting Write mode (see Write
Flyback on page 60).

Modify Levels (Alt+M)

Insert Global Time
• With the Mix Editor open, this feature globally
inserts a region of no data change at the selected
start point (on all channels for all data).
• Selecting Insert Global Time in the Edit menu
opens a window with settings for the insert start
point and length of time inserted.

Delete Global Time
• With the Mix Editor open, this feature globally
deletes a region of data change at the selected
start point (on all channels for all data).
• Selecting Delete Global Time in the Edit menu
opens a window with settings for the deletion
start point and length of time deleted.
• Use this control to modify all selected channels
for the user-selected parameter.
• Choose the type of parameter in the top pull-down
button.
Set the action to Trim, Set, Min, or Max.
• Trim adds or subtracts the selected value from all
selected channels for the selected parameter.
• Set moves the selected parameter to the specified
value for all selected channels.
• Min limits the minimum parameter setting to the
specified value for all selected channels.
• Max limits the maximum parameter setting to the
specified value for all selected channels.
Note: The Modify Levels command affects automation
data only if the Include Automation box is checked. If
the box is checked, levels are modified globally across
the complete SMPTE time line on selected channels,
for the selected parameter.

Insert Time
• Within the Mix Editor, this inserts a region of no
data change in the selected channel region.
• The amount of blank time inserted is equal to the
length of the selected region.
• Functional on any number of selected tracks.

Delete Time
• Deletes a selected time region in the Mix Editor
window, including all data and changes.
• The amount of deleted time is equal to the length
of the selected region.
• Functions on any number of selected channel
regions.

Clear Automation

• Removes all automation data globally for the
selected channels and the selected categories.
• This action can be undone.
• This action is listed in the History List and
remains available for an Undo at any point, as
long as it remains in the list.
• Plug-in automation is cleared by removing the
plug-in from its assigned slot.

Clear Edit History
• Removes all items from the History window.
• This cannot be undone!

Play From Selection (Ctrl+Space)
• This action starts playback of the onboard D8B
transport from the start time entered in the Mix
Editor start time window.

Select All (Ctrl+A)
• Operates on list type windows (Snapshot,
Locator, MIDI Map, etc.) for selecting all list
items for deletion.
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The Channel Menu
The Channel menu contains:
• Channel List (Ctrl+B)
• Open Channel…
• Save Channel As…
• Group (Ctrl+G)
• Ungroup
• Channel Link… (Ctrl+L)
• Unlink (Ctrl+U)
• Faders to Unity (Ctrl+])
• Faders to Off (Ctrl+[)
• Adjust Channel Delay…
• Reset Channel Delay…
• Reset Channel Layout...
• Select Fader Bank (Alt+A)
• Select All Faders (Alt+Shift+A)

Let’s take a quick look at each menu item.

Channel List (Ctrl+B)
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• Allows for quick and easy setting of global
channel parameters.
• Change the channel name.
• Easily set groups.
• Set playback status to Run, Punch-Run, or
Disabled.
• Solo isolate channels.
• Quickly set channel links.
• Set individual channel delays of up to 255
samples (see “Adjust Channel Delay” on page 59).
• Turn digital filter on or off (to eliminate analog
channel noise).
Playback—Allows automation playback enable
and bypass for the individual channels. This feature
is used in addition to the global automation bypass,
but works on a per-channel basis. There are three
modes within Playback: Run, Punch-Run and
Disabled.
Note: The three different Playback modes, Run,
Punch-Run, and Disabled, all operate in the same
manner for MIDI I/O as they do for automation.
Remember that MIDI I/O pertains only to Fader,
Mute, and Pan automation and control.
Run: This is the default mode, and if dynamic
automation is present on the channel, automation
moves play back when time code is received and the
global automation bypass is disabled.
Disabled: This mode simply disables automation
playback on the individual channel, regardless of the
global Bypass status. “Disabled” is a safe area that you
can use to prevent automation playback from chasing
and overwriting your latest edits before you get a
chance to commit the settings. The “Disabled” feature
is also handy for setting up parameters within the
context of a mix, relative to whether other individual
channels or sections are automation bypassed.
Punch-Run: Once you’ve automated a channel, you
might want to preset a punch-in level to drop or
boost the parameter of interest (especially a fader).
In Absolute mode (Auto Touch off), the parameter
cannot be altered if it is chasing automation, as you
can see when you grab a fader knob during
automation playback and it “fights” you. For this
purpose, we created the Punch-Run mode. Place the
channel in Punch-Run, which releases the playback
chase mechanism until the channel has been placed
in any automation Write mode. When Punch-Run is
engaged, you can roll back the tape, freely adjust the
parameter level and, when the punch-in point arrives
to set the new level, press the WRITE button on the
channel and the parameter level will be written to
the track. At punch-out, two things will occur: the
parameter level jumps to any preexisting level on the
track (similar to Write Flyback, but the level is not
necessarily the original level) and the channel
parameters now chase on subsequent playback.
You cycle through the modes by clicking on the
Playback column in the specific channel’s row. From
the console, hold down an individual channel strip’s
SELECT button for 2 seconds, and then press the

SELECT button under the Playback mode to toggle
between the Disabled, Punch-Run, and Run states.
Shortcuts: Note the “previous-click” shortcut (the
last click has a memory if it was on a “like” parameter,
and copies the previous-click setting to the next click).
Also you can click and swipe down the list to change
the column to the value that’s toggled by the click.
From the control surface (or the keyboard) press
the CONTROL button (or Ctrl key) and the channel
SELECT button simultaneously to enter or exit
(toggle) Punch-Run mode. The red bank LED (for Ch
25-48) above the SELECT button blinks to indicate
Punch-Run status.
Note: The Disabled state does not automatically
reengage itself. Remember to toggle it to Playback
status if you want automation moves to play once again.
Write—This in an individual channel write-safe
function that is independent of the global
Automation Bypass and Automation filters. There
are two modes, Enabled and Locked, where Enabled
allows automation to be written, and Locked
prohibits the overwriting of moves on the channels
dynamic automation track.
Note: The two modes, Enabled and Locked, operate in
the same manner for MIDI I/O as they do for automation.
Toggle the Write mode by clicking on the Write
column in the specific channel’s row. From the
console, hold down an individual channel strip’s
SELECT button for 2 seconds, and then press the
SELECT button under the Write mode in the Fat
Channel Display to toggle between the enabled and
locked states.
Shortcuts: Note the “previous-click” shortcut (the
last click has a memory if it was on a “like”
parameter). You can also click and swipe down the
list to change the column to the value that’s toggled
by the click.
Isolate—This turns Solo Isolate on and off. When
Solo Isolate is on, the channel or track remains on
when another channel is soloed.
Filter—This noise-shaping filter can improve the
signal-to-noise ratio for particularly noisy analog
input sources. If you have Digital I/O cards (DIO•8,
PDI•8, OPT•8) installed in channels 26 through 48,
leave the filter off for those channels. Save the
settings in your template so they carry over from
session to session.

Open Channel…

• Static channel parameter settings can now be
saved and recalled.
• The Open Channel window provides access to
previously saved channels on either a floppy disk
or the internal hard drive.
• Highlight the desired item and click Open to send
the saved channel data to the selected channel.
• Enable Auto Touch and All filters to write a
channel setting into automation. On subsequent
operations, use Punch-Run in the channel list to
avoid automation chase conflicts.

Save Channel As…

• Allows static channel parameter settings to be
named and saved for instant recall at a later time.
• Descriptive naming provides for stress-free recall
of a finely-honed channel status.
• Save channel status to either a floppy disk or the
internal hard drive.
• Select New Folder to organize channels into
logical groups: band name, instrument type,
singers, drums, guitars, etc.
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Group… (Ctrl+G)

• Provides a very convenient way to group faders
for control by a group master fader in the
MASTERS fader bank.
• Simply select all the desired channels for a
specific group by Shift+Selecting throughout the
Bank or Banks you choose, then use the pulldown menu to assign them all to a group.
• This does not override any previous group settings
outside the selected channels, however, a channel
can only be assigned to one group. The most
current group selection does override a previous
channel group assignment.
• This feature provides a way to add faders to an
already existing group.

Ungroup

• Provides an easy way to remove channels from a
previously established group.
• Select some or all of the grouped channels to
remove the selected channel from the group
status.
• Select “Retain All Levels” to keep the selected
channel fader levels at their group-adjusted levels.
This adds or subtracts the group master setting
from the originally set channel levels in order to
maintain the mix setting even when the faders are
removed from the group.

Channel Link… (Ctrl+L)
• Link is still initiated by either first selecting two
channels and then selecting “Channel Link…”
under Channels in the upper menu bar, or by
pressing and holding two adjacent channel
SELECT buttons for two seconds, and then
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following directions in the Fat Channel Display.
An additional link initiation may be made using
the Channel List feature.
Note: You can select each channel in a linked pair
individually. If you want to copy channel settings to a
linked pair, you must select both channels (ShiftSelect) and then paste the settings.
The features are outlined as follows:
Any two (Odd/even or Even/odd) contiguous channel
strips may be linked:
(For example, channels 5 and 6, or FX1 and FX2;
or channels 6 and 7, or Group Masters 2 and 3.) A
channel may be paired with only one other channel
strip in its bank. If channel 5 is linked with channel 4,
it may not be simultaneously linked with channel 6.
Channels may be paired across banks (e.g., Ch 24
and Ch 25) if necessary, but it’s not recommended for
typical applications.

• Link Setup provides a means to select the
parameters that are linked between channels.
• Choose only the parameters that need to be
linked. For instance, in many cases only the
faders need to link; all other parameters should
remain intact in the way that they’ve been finetuned for the individual track.
• Relative offset: Pressing [Shift] on the console or
keyboard while moving any controller function on
the D8B console surface or with the mouse allows
a relative distance (or relative offset) of ANY
linked parameter. For example, on two linked
faders, press and hold [Shift], move one fader, let
go of [Shift], and a new relative position is
maintained. To maintain a pan spread, press and
hold [Shift], move a linked pan V-Pot, release the
[Shift} and the pans will maintain the offset spread
to the extent of the maximum left or right value.
• Remember that pressing [Ctrl] and moving a
controller resets it to a normal, or default,
position, so you can always realign and match the
relative link to a zeroed offset.
• Inverse Pan linking: Pan can be set to link inversely.
This means that rotating the Pan control on one
channel causes the Pan control on the linked
channel to rotate in the opposite direction.
• Inverse Switch toggling: You can press [Shift] and
then press the MUTE button on a channel, and it
will toggle oppositely to the other linked mute.

This feature can be especially handy for
applications such as vocal comps and bus
switching. Inverse switching is set and recalled
individually on all parameters, so Bus 1 and the
linked Bus 1 can be inversely locked, while Bus 2
and mutes are locked to the same value.
• Holding down [Shift] and enabling a linked
channel mute, Bus 1-8 and L-R assigns, EQ on/off,
Gate on/off and Comp on/off assignment enables
the inverse function. To leave this mode, press
[Shift] and the linked button again. The mode may
also be initiated by using the keyboard [Shift] and
clicking on a linked channel’s button.

• Select the channels that will remain at the
original position; all unselected channels will be
offset by the selected number of samples (±255).
• This feature helps compensate for phase and
timing discrepancies in a synchronization scenario
or any multi-playback/record device setup.

Reset Channel Delay…

Unlink (Ctrl+U)

• This resets the time-altered channels to a status
of no offset.

Reset Channel Layout…
• This action resets all channels to the default
contiguous channel layout (1-97). It “undoes” all
channel rearrangements across the board.

Select Fader Bank (Alt+A)
• Removes a link between channels.
• Initiate by selecting the linked channels and then
selecting “Unlink” under Channels in the upper
menu bar, or by pressing and holding the linked
channels’ SELECT buttons for two seconds, and
then choosing Link Off in the Fat Channel Display.

Faders to Unity (Ctrl+])
• Sets the selected channel faders to unity.
• Affects faders only (including the MASTER L/R
fader). Does not affect other channel parameters.

Faders to Off (Ctrl+[)

• Selects all 24 channels in the currently selected
fader bank for clipboard, automation, and other
operations pertaining to multiple channel
modifications.

Select All Faders (Alt+Shift+A)
• Selects all 97 channels (96 plus the L/R mains) in
all four fader banks for clipboard, automation, and
other operations pertaining to multiple channel
modifications.

The Options Menu

• Instantly sets selected channel faders to off.
• Affects faders only (including the MASTER L/R
fader). Does not affect other channel parameters.

Adjust Channel Delay…

Solo Latch
• This feature provides a means to shift channels in
time, relative to each other.

To activate Solo Latch, simply select it in the
Options Menu, so a check mark appears beside
Solo Latch.
Solo may be set to latch (i.e., more than one solo
can be enabled as they are swiped across the screen
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or on the panel) or to radio button (only one
allowable at a time).
If solo latch is not set (no check mark), multiple
solos may be manually latched by either:
1) Pressing and holding another solo switch, while
initiating more solos, or pressing multiple solos
at one time.
2) Pressing and holding [Shift], while initiating
more solos.

Link Speakers
• Links the Near Field and Main speaker levels
• Changing the speaker level when either speaker
set is selected changes the level on the other set.
• Hold Shift on the control surface or keyboard
while adjusting the speaker level to create an
offset between the speaker levels. This is a
convenient way to match monitor levels between
speaker systems while still linking the overall
volume changes.
• Hold Ctrl while adjusting Speaker Level to delete
the offset.

Faders to Tape
• Direct out levels (Level to Tape) from the tape out
follow the sourced channels’ faders. For example,
if channel 12 is assigned to direct out 24,
adjusting channel 12’s fader directly affects the
tape output level.
• Switch this off for independent Level to Tape
settings.

Automation Sub-menu

Trim Levels
• This mode sets all faders to unity position and
assigns all parameter controls (except mutes) to
globally add or subtract from existing settings and
recorded moves.
• This is perfect for raising or lowering a complete
set of moves.
• For example, if the vocal track automation is
perfectly crafted and structured, yet the entire
track needs to come up a couple dB in the mix,
fear not. Select Trim Levels, start time code, enter
WRITE mode, and, with one move, increase vocal
track fader 2 dB, throughout the duration of the pass.
Note: Trim Levels automation writes linked
parameters independently on linked channels.

Auto Touch
• Called AUTO TOUCH on the control surface.
• Readies all selected automation parameters to enter
write mode the instant the parameter is adjusted.
• As soon as a selected channel parameter is altered,
the channel strip enters write mode for the
adjusted parameter. However, adjustments of
parameters that haven’t be selected for automation
in the onboard AUTOMATION or Automation Menu
do not cause the channel to enter write mode.

Faders
• This readies the automation computer to record
all fader movements for any write-selected channel.

Mutes
• This action readies the automation computer to
record all mute activity.

Pan
• This readies the automation computer to record
all Pan movements for the write-selected channels.
• All surround pans are recorded as well as L/R
positioning. However, surround output, depth of
center, and LFE assignments are not written with
this selection.

All
• Sets the automation computer to record all
parameter changes for the write selected
channels, other than the individually selectable
FADERS, MUTES, and PAN.

Write Flyback
Bypass
• With this command selected (Bypass button lit in
the Automation section), automation data is
neither recorded or played back
• With this command deselected (no light), all
write-selected parameter adjustments are written
into automation data and referenced to time code.
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• This controls what happens to the parameter
levels upon punch-out of automation record.
• With Write Flyback selected, each parameter
recorded into automation returns to its previously
adjusted status at the end of a record pass. A
track that was off for an entire arrangement snaps
back to off, after the level is increased, when
punched out of record.
• When Write Flyback mode is not selected,
parameter adjustments in automation remain at
their last user-adjusted setting, even after the end
of the automation pass.

Write Ready Mode

The Plugins Menu

• This option does not function when Auto Touch is
selected.
• When Write Ready is selected, channels are
manually engaged to write automation data.
• Write Ready mode assigns the transport RECORD
button to punch the Write Ready channels into
and out of automation record.
• When the channel WRITE button is pressed, the
yellow light blinks, signifying that the channel is
ready to record automation. No automation will be
recorded until the RECORD Master is enabled in
the transport section.

Transport Sub-menu

Plugins (Ctrl+P)
All three of these menu items are available in
the Mix Options section of the Setup window.

Use Pre-Roll
• Sets machine location a specified amount ahead of
the locate point.
• The amount of Pre-roll is set in the Locator-MMC
section of the Setup window.
• Pre-roll is used to provide a set time period for all
synchronized device transports to lock together.
• Ideally, pre-roll is equal to the sync-lock time for
the recording system’s transports, so that
synchronized playback is a reality by the time the
devices roll past the locate position.

Record Safe
• In Record Safe, the channel RECord/ReaDY
buttons will not engage. However, automation
data can still be written.

One Button Punch
• With this option selected, record mode is activated
by pressing the RECORD button in the control
surface’s transport section. When One Button
Punch is not selected, the PLAY button must be
held down while pressing RECORD to engage
record mode.
• To punch out of record status, simply press PLAY,
STOP, REWIND or FAST FWD.
• One Button Punch affects only the punch-in
procedure.
• The punch-out procedure is the same no matter
what the status of One Button Punch (hit any
other transport button to punch out).

• This command opens the Plugin Configuration
window. It is here that plug-ins are selected,
inputs are chosen to feed plug-ins, and stereo or
mono modes are selected.
• There are sixteen plug-in slots—four dedicated to
each FX card. Card one is allocated plug-in slots
1–4. Card 2 is allocated plugin slots 5–8. Card
three is allocated slots 9–12. Card four is
allocated slots 13–16.
• For each active plug-in, the SLOT number button
opens and closes the plug-in window.
• MODE toggles between STEREO and MONO
when using the UFX card. Each UFX card is
divisible into two halves. Either half can be
selected as stereo or two-channel mono. In other
words, each UFX card can be configured as two
stereo, four mono, or one stereo and two mono
plugins.
• The MODE selection is not applicable to the
MFX cards.
• MODE selection determines the plug-in options
from the UFX card.
• Select the desired plug-ins in the PLUGIN column.
The available options are dependent on the
installed plug-in card(s).
• Each of the four card slots is allocated four
possible inputs and four possible outputs. MFX
cards are automatically configured with two mono
inputs, each feeding a separate user-selected
effect. Each MFX effect has a stereo output,
automatically returning to two faders in the
control surface EFFECTS bank. UFX cards offer a
potential of four discrete inputs and outputs,
configurable into plugin-specific stereo and mono
configurations.
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• When using the MFX card, each mono input feeds
a stereo effect; each stereo effect returns to two
faders on the EFFECTS bank. For example, with
an MFX card installed in mixer card slot 1 and
selected in the Plugin Configuration window,
INPUTs are available at slots 1 and 2. If Aux 1 is
selected for SLOT 1, the Aux 1 send feeds the
input to Stereo Effect 1, whereas the returns enter
the mixer at EFFECTS bank faders 1 and 2.
• Once the plug-in is selected, the plug-in-specific
input options appear in the INPUT menu.
• A plug-in can also receive its input from a channel
pre- or post-DSP insert or the main stereo left and
right bus. When a plug-in is inserted “in-line” in
this manner, its output is routed directly back into
the channel or bus.
• To deactivate a plug-in, select “none” in the
associated PLUGIN column pull-down assignment
menu. Click “OK” in the Alert dialog box.
Warning: Deactivating a plug-in erases all
automation data for the plug-in.

Basic MFX Use Procedure
1. Open the Plugin Configuration window.
2. Select MFX 3.0 in the PLUGIN menu. When a
plug-in card slot contains an MFX card, a single
box covers the four plug-in slots allocated to
that card.
3. Once MFX is selected, two mono inputs become
available in the INPUT menu.
4. Click and hold on the input box to open a dropdown menu; drag to select the desired input.
5. Open the STEREO EFFECTS windows by
clicking on the SLOT buttons to the left of each
active input.
6. Verify audio send to the plug-in at the STEREO
EFFECTS input meter, and that the ON button
below the input meter is yellow.
7. Manually set up the desired effect or select from
effects presets.
8. To hear the effect, unmute the appropriate
channels and then raise the appropriate faders
in the control surface EFFECTS bank.
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Basic UFX Use Procedure
1. Open the Plugin Configuration window.
2. Select the desired Stereo or Mono MODE status.
Change status by simply clicking on the current
MODE status button.
3. Click and hold in the plug-in list to open the dropdown list of available plug-ins. Drag to select the
desired plug-in(s) from the PLUGIN menu.
4. Once a UFX plug-in is selected, the plugin-specific
inputs become available in the INPUT menu.
5. Click and hold on the input to open a drop-down
menu; drag to select the desired input.
6. Open the selected plug-in window by clicking the
SLOT buttons to the left of each active input.
7. Verify audio send to the plug-in at the input
meter, and that the plug-in is ON.
8. Manually set up the desired effect or select from
effects presets.
9. To hear the effect, unmute the appropriate
channels and then raise the appropriate faders
in the control surface EFFECTS bank.

Shortcut to Plug-in Windows
Plug-in windows can be opened and closed
from the keyboard by using a combination of the
shift, number, and Alt keys. Plug-in windows
correspond to the active input slots in the Plugin
Configuration window.
• To open and close plug-in windows for SLOTS
1–9 press:
Alt 1–9
• To open and close plug-in windows for SLOTS
10–16 press: Alt+Shift 0–6

Plug-ins Selector
Toggle between Windows menu selections and
Plug-ins Menu selections by clicking the 1/4" TRS
icon on the far left end of the window selector strip.
See Appendix C (Plug-in Configuration and
Routing) for more information about configuring
and routing plug-ins.

The Windows Menu
Contains:
• About
• Hot Keys
• Close All (Ctrl+\)
• Desktop (Ctrl+D)
• Setup (Ctrl+1)
• Snapshot (Ctrl+2)
• Surround (Ctrl+3)
• Locator (Ctrl+4)
• Mix Editor (Ctrl+5)
• FatChannel (Ctrl+6)
• Panning (Ctrl+7)

About
This window displays the OS version, software
authors, artist, etc.

Hot Keys
The more of these key commands you learn,
the faster and more efficient you’ll be at recording.
Some adjustments are necessary on the control
surface or with the mouse, but many control
settings flow very quickly from the keyboard.
Once you begin to incorporate these into your
routine you’ll quickly realize the power and
creative freedom they offer.

• Faders (Ctrl+8)
• Event Track (Ctrl+9)
• History List (Ctrl+H)
• MIDI Map (Ctrl+ –)
• Upgrade UFX Cards...
• Erase UFX Memory...

Let’s take a quick look at each menu item.
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Close All (Ctrl+\)
This command closes all open windows. The
main faders overview backdrop is always displayed
unless the Desktop is selected.

The Desktop Window (Ctrl+D)
The Desktop is where files are saved, named,
copied, and organized. See the description in this
chapter under the File menu (page 52).

The Setup Window (Ctrl+1)

MDS Network (Mackie Digital Systems
Network) allows any number of consoles that are
on the same MDS Network Channel to either
generate or receive common Link Option controller actions. There are 8 MDS Channels, that are
not unlike TV channels via ethernet, where the
console has a unique Device Name (like 'Jolene' or
'Spike') and after setting the Device Name and
assigning one of the 8 MDS Channels, the console
may then join the party.
Consoles are normally linked audio-wise via
the ALT I/O 1–8 card slot where audio buses are
configured to be transferred from a slave console
to a master console for further mix processing. If
using the buses for digital audio, all allowances
for word sync must be made (both consoles need
to be clocked from the same source).
Note: All of these Ethernet messages are
broadcast from any given control surface that is
on-line and transmitting or receiving. Updating
only occurs after the connection is established and
the link parameters are modified.

Network Channel

General
These personal preference settings are
straight ahead. What’s the date and time? Do you
like the mouse to be quick and nimble or a bit
more deliberate? Do you want the on-screen
interface to look more Mac-like (Gray Motif) or
PC-esque (PC/UNIX)?
Smart Save is a function that automatically
saves your session every five minutes. Check the
Create New Files box to save the session as a new
session without overwriting the previously saved
version.
Display Intensity refers to the control surface
VFD display, not the computer monitor display.

MDS Network

• Each Digital 8•Bus assigned to the same Network
Channel is linked according to the functions
selected under Link Options.
• Communication between devices is dependent on
common network channel numbers. All devices
assigned to Network Channel 1 communicate
together and act as one console across the
selected Link Options. All devices on Network
Channel 2 communicate; all devices on Network
Channel 3 communicate; etc.
• Communication between all devices sharing a
common Network Channel is bidirectional on
common Link Option selections.

Device Name
• This simply allows the D8B to be given a unique
name for identification purposes across the network.

Alt I/O 1–8
• This provides for the routing of the audio signals
from Aux 1–12, Bus 1–8, or L/R output through
any I/O card installed in the Alt I/O slot.

Link Options
• This provides the selection of control signals that
are sent or received on the ethernet connection.
• When multiple D8Bs are linked together via their
individual ethernet connections, they
communicate and respond according to the
selections in the Link Options list.
• Whichever parameters are selected are
transmitted and received across the network on
two or more D8Bs.
• Whichever parameters are not selected act
independently on each individual D8B.
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Link Options are enabled and disabled according to what control surface actions you want to
have linked on two or more consoles assigned to
the same Network Channel.
• Fader Banks: This option provides for bank
selection across the network from any Digital 8•Bus
sharing a common Network Channel number.

Digital I/O

• Aux Strip: This option links the selection of any
aux bus across the network. For example, if Aux 1
is selected on any networked Digital 8•Bus console,
it will be selected on all networked Digital 8•Bus
consoles with Aux Strip selected.
• Bus Assign: This links the BUS ASSIGN selection
across the network. For example, selecting Bus 1–
8, L–R, or Route to Tape in the ASSIGNMENT
section selects that assignment status in each
networked D8B with Bus Assign selected. This
allows the ASSIGN buttons to function identically
on each D8B.
• Cue Controls: This links the Phones/Cue selection
across the network. For example, selecting any
parameter in the PHONES/CUE MIX 1 section
selects that parameter in each networked D8B with
Cue Controls selected.
• Solo Logic: This links the SOLO/STUDIO
selection across the network. For example,
selecting any solo or studio status in the SOLO/
STUDIO section selects that status in each
networked D8B with Solo Logic selected.
• Speakers: This links the Speaker selection across
the network, including NEAR FIELD, MAIN,
MONO, and DIM.
• Sample Rate: This links the sample rate setting
across the network. Selection of a sample rate
status on any networked Digital•8 Bus sets the
sample rate on the others with Sample Rate
selected. This link syncs the sample rate setting
but not the source setting (Apogee Clock Internal
or Word Clock setting). Word clock connections
must still be made using real live cables.

The Digital I/O setup window allows you to
make input and output settings for the I/O cards
that are installed in the Tape In/Out card slots.
The D8B automatically senses the card configurations and provides selection and patching options
accordingly.

Tape Banks
Any of the following tape I/O cards can be
installed in the three Tape In/Out slots and the
Alt I/O slot in the back of the Digital 8•Bus.
• DIO•8: This digital card provides input and output
connections via ADAT and T/DIF protocol. Tape
bank I/O selections are completely selectable on
both inputs and outputs. The DIO•8's provide
direct dubbing capabilities from ADAT optical to
T/DIF format, and vice versa. Powerful patching
options interconnect the Alesis ADAT format and
the TASCAM DA series format.
• PDI•8: The PDI•8 AES/EBU card connects to any
digital device that supports the AES/EBU digital
audio format. The PDI•8 allows for real-time
sample rate conversion and status bit designation
on its four pairs of inputs (click the Setup button
in the Digital I/O Setup window).

• Automation: This links the automation control
across the network. For example, enabling
automation by selecting ALL in the AUTOMATION
section, enables ALL automation in each networked
D8B with Automation selected.
• Load/Save: This links the Load and Save
commands across the network. If the Load or Save
commands are initiated on one networked Digital
8•Bus, each networked D8B loads or saves a
session.

• OPT•8: The low-cost OPT•8 I/O card provides
8 channels of ADAT light pipe digital I/O.
• AIO•8: This analog card offers 8 balanced linelevel inputs and outputs per card through a 25-pin
D-Sub connector.
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Alt I/O
• The Alt I/O 1–8 operates according to the type of
I/O card installed (AIO•8, DIO•8, PDI•8, OPT•8).
• The Alt Inputs feed the 8 Alt Return channels on
Fader Bank 3.
• The Alt Outputs are configured via the Alt I/O 1–8
pull-downs in the MDS Network Setup window.

Stereo I/O
• These settings apply to the Stereo Digital I/O
AES/EBU and S/PDIF connections on the back of
the Digital 8•Bus.
• The Stereo I/O is configurable for three levels of
UV22 dither: Off, Low, and Normal.
• In addition, Status Bits can be designated as Pro
or Consumer, usually applicable to DAT mastering.
Check with the device manufacturer (i.e., DAT,
CD-R, MiniDisc) for the proper setting.
• The Digital In toggles between AES/EBU and
S/PDIF. This selection determines which Digital
source is displayed on the Pre Insert>Channel
Patch list.

3. To obtain the unlock code, have the ESN and plugin serial number ready. Then you have two options:
• Log on to the Mackie plug-in authorization
web page:
(http://www.mackie.com/d8bauthorize.htm), or
• Phone Mackie Tech Support at 800-258-6883.
4. When you have obtained an unlock code, click
Authorize in the Licensing window and enter
your unlock code in the UNLOCK CODE box.
Click Enter, and enjoy your newly expanded
console.

Mix Options

Licensing

• This window provides an interface to install and
authorize plug-ins.
• To install a new plug-in, click Install, then insert
the floppy disk provided by the plug-in
manufacturer and click OK.
• Authorized plug-ins are indicated by an opened
padlock icon.
• Locked plug-ins are indicated by a closed
padlock icon.
• To authorize a locked plug-in, highlight it in the
Licensing window and click Authorize.
• Enter a valid UNLOCK CODE to authorize each
locked plug-in. Unlock codes are furnished by
Mackie Designs.
Unlock Procedure
1. Locate your D8B’s Electronic Serial Number
(ESN). This is displayed at the bottom of the
Licensing window. The 12 digit ESN is made
from numbers 0–9 and letters A–F. It is unique
to the D8B processor, and is not the serial
number label on the rear of the control surface
or CPU chassis.
2. You will also need your plug-in’s serial number
which is printed on the floppy disk label.
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Note: Most of these option items are also found
under the Options menu at the top of the screen.

Surround Mode
• This pull-down list provides access to the various
Surround Sound modes available on the D8B.
• All standard mix modes are selectable through the
Surround Mode list, including Stereo, Quad,
LCRS, 5.1, and 7.1.

Auto Arm
• Once the Surround Mode is selected, Auto Arm
provides a quick and easy way to arm all the
channel buses to feed the appropriate outputs.
• Stereo automatically activates all L/R
assignments for all appropriate channels.
• Quad automatically activates bus assignments
1, 2, 5, and 6.
• LCRS automatically activates bus assignments
1, 2, 3, and 4.
• 5.1 automatically activates bus assignments 1–6.
• 7.1 automatically activates bus assignments 1–8.

Clear
• Automatically clears all bus assignments
(whether set manually or activated automatically
through the Auto Arm feature).

Aux Select - Pre/Post
• Select the desired Aux bus using the Aux Select
pull-down list.
• Set global pre/post status for the selected aux bus
by clicking PRE or POST under “Aux 1–8
Pre/Post Assign Macros:”.
• Individual channel aux pre/post assignments are
performed by Alt+clicking on the Aux Send’s level
bar in the overview screen.

One Button Punch
• With this option checked, connected record devices
are placed into record mode by simply pressing
the RECORD button in the Transport section.
Note: The record devices must be in play mode.
• When this option is cleared, both PLAY and
RECORD must be pressed at the same time to
enter record mode on connected record devices.

Record Safe
• When this option is checked, the D8B is prohibited
from engaging connected record devices into
record active status.
• Use this mode when you want to guard against
inadvertently erasing previously recorded material.

Use PreRoll
• Checking this option instructs the playback
transports to begin before the specified locate
point based on the Pre-Roll time specified in the
LOCATOR-MMC Setup window.

Use Write Ready
• When this function is enabled, the transport
Master Record button becomes a Master Write
button and functions as a global Master write
enable for the absolute and (absolute) trim
dynamic automation modes.
• When “Use Write Ready” is toggled (in the Mix
Options Setup window, or under the GENERAL
MIDI Setup menu in the Fat Channel Display), the
Write LEDs begin flashing (when enabled) to
indicate Write Standby mode. Individual channels
remain in Write Standby (if write armed) up until
the point that the Write Master is engaged (time
code must be rolling), and returns to standby mode
when the Write Master is toggled off. “Standby” is
indicated by flashing LEDs, and “Armed” is
indicated by solidly lit LEDs (actively writing).
• Conversely, when “Use Write Ready” is disabled,
and absolute and (absolute) trim dynamic
automation is enabled, any channel Write may be
immediately punched in and out of armed status.
There is no standby mode. The transport Record
Master only applies to MMC control (Record enable).
Please Note: The Record Safe and Master Write
functions provide protection against the accidental
overwriting of audio and automation data.

Write Flyback
• This feature provides a choice for the punch-out
ending level of an automation pass. You can choose
to either leave levels at the current state or to snap
levels back to the original punch-in state.

• The purpose of the Write Flyback feature is to
establish a rough mix on any given channel at the
point when the channel is first punched in, so that
a default level may be maintained right up to
23:59:59:29. Whether Write Flyback is enabled or
not, any subsequent punches that occur after the
last dynamic event on a track will always “rubber
band” snap back to the original level state upon
punch out.
There are also applications when you may not
necessarily want to have the automation track
return to the original level, such as an ending
track fade, where the levels started high but end
low, or for an effects parameter that goes from one
state to another and remains that way for the rest
of a song. Disable Write Flyback when you don’t
want the OS to create final levels for you.
As a default, this box is checked (enabled), and
acts similarly to the Set Default Levels function,
although Write Flyback is a real-time process,
whereas Set Default Levels is an off-line operation.

MIDI Snapshots
• When enabled, incoming MIDI program changes
(received on any MIDI channel) can recall
Snapshots numbered 0-99 on the console.
• The D8B sends MIDI Program changes on MIDI
channel 1 (by default, selectable in the Snapshot
Window) when snapshots are recalled on the
console, either via the dynamic automation snapshot
track or by manually recalling a snapshot from either
the snapshot window or via the front panel.
• Incoming program changes may be used to write
snapshot events into the dynamic automation track.
Please note that incoming program changes
do not currently update the snapshot number
displayed on the panel transport 7-segment
displays.
To avoid a snapshot thru MIDI feedback loop,
we recommend (as is normal practice with any
MIDI instrument) that you avoid looping the MIDI
Out to the MIDI In, unless it is meant to be done
intentionally (e.g., a normal exception is master
keyboard control over a workstation type instrument, through a sequencer). Bottom line—avoid
mapping the D8B to control itself through a
sequencer.

Solo Latch
• When Solo Latch is checked, SOLO buttons
remain engaged even when a new SOLO button is
pressed.
• When Solo Latch is not checked, new SOLO
selections disengage previous SOLO selections.
• If Solo Latch is not set (checkbox not selected),
multiple solos may be manually latched by either:
° pressing and holding another solo switch while
initiating more solos, or pressing multiple solos
at one time.
° pressing and holding [Shift] while initiating
more solo’s.
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To allow this operation, set the “Solo Latch”
checkbox in the Mix Options Setup window, or
press GENERAL in the Setup Section and, under
Solo, select “SOLO LATCH” ON or OFF in the Fat
Channel Display.

MIDI File Tempo Map

Link Speakers

Default Tempo

• When the Link Speakers checkbox is enabled, the
Mains and Near Field SPEAKER LEVEL control
is linked. Increasing or decreasing the SPEAKER
LEVEL control simultaneously adjusts both the
Near Field and the Main Control Room Output.
This provides a consistent level when A/B’ing
between speaker sets. The default option is an
unlinked state (same as OSv1.0).
• Holding down the [Shift] key and spinning the
SPEAKER LEVEL V-Pot temporarily breaks the
link. This can be used to establish a level offset
between the two stereo output pairs. The level
difference is maintained in the same operational
manner as linked channel parameter offsets. The
link offset may be updated at any time, using the
[Shift] key.

• Sets the automatically-set MIDI tempo reference
for position alignments during an automation pass
or locator activities.

Faders to Tape
• When this option is checked, source channel
faders control the level to the tape outputs 1–24.
• When this option is not checked, level to tape
outputs 1–24 are adjusted by selecting LEVEL TO
TAPE in the V-Pot Assign section and adjusting
the channel V-pots.

Calibrate
• This operation resets the minimum and maximum
fader values for the OS.
• For optimum performance and positioning
response, the fader calibration may be used
periodically. The calibration takes a few minutes
to perform its routine, so take a break, will ya?
Caution: Do not touch the faders during the
calibration procedure. Doing so could damage the
servo motors.
Note: This procedure is only available from
the Mix Options Setup window on the screen.

• Import a MIDI Tempo Map from a standard MIDI
File to synchronize the D8B Bars/Beats/Ticks
display with your MIDI sequencer MTC reference.
Note: Tempo Map only recognizes 4/4 meter.

Device ID selection
• Sets the Device ID reference for connected record
devices such as the HDR24/96, ADATs, or DA
Series multitracks.

Song Offset
• Sets the consistent time difference between the
record device time code and the D8B reference
time code.
• Generally used to ‘zero reference’ a song’s
starting point in BBT. It’s easier to jump to
measure 1 than 2:01:23 (usually).
• Offset can be as little as one frame or as much as
23 hours, 59 minutes, 59 seconds, and 29 frames.

Pre-Roll
• Sets the time difference between a Locate point
and the actual start point.
Many record devices require a few seconds to
synchronize, so the Pre-Roll time allows a brief time
period in advance of the locate point to ensure
transport sync and accuracy.

FTP Server

Locator-MMC

Allow FTP Clients
Check this option to enable the D8B for internetwork communication and file transfer.

IP Address:
• Note the D8B IP address displayed. The factory
default is 10.10.28.20
• If your computer is set up for dynamic IP
addressing, you can leave the default address as
is or enter an address of your choice. You will
need to know the D8B IP address to set up your
FTP client software.
• If your computer is set for a fixed IP address, set
the first three fields of the D8B IP address to
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match your computer’s address, and set the last
field to something different. Be sure you don’t set
it to the address of another device that you have
on your network.

Subnet:
• In the Subnet window type 255.255.0.0 (default
value) unless your network requires a subnet mask.

Gateway:
• If no Gateway is being used you can usually leave
this setting blank, though some FTP clients
require an entry even for a simple network.
10.10.10.10 is the default value.

Apply
When all parameters are set properly, click
APPLY to instantly activate the changes.

The Snapshot Window (Ctrl+2)

Description
• Double click in the description column of the
desired snapshot to enter a text description,
which is then saved with the snapshot data.
• Don’t write your agent’s telephone number here,
or say bad things about the guitar player...

Snapshot Edit Window
This provides access to the snapshot edit
parameters. Simply click on the word “Edit” to reveal
the snapshot edit parameter pull-down list.

Selecting
• Click once on the snapshot name to highlight it.
• A highlighted snapshot can be saved as a
selection for recall from within a different session,
or it can be deleted from the list.
• To make a snapshot active from the on-screen list,
double click the snapshot number.
• To make the snapshot active from the control
surface, press SNAPSHOT in the transport
section, use the numeric keys to type the
snapshot number, then press ENTER.

Naming
• Each new snapshot is automatically given a
number and the name “snapshot.”
• To change its name, double click on “snapshot,”
then type the new name. Press ENTER on the
keyboard to complete the naming procedure.

Filtered
It’s often convenient to eliminate a parameter
or set of parameters from a snapshot change. If,
for example, you’ve set all the basic EQs in the
first snapshot, it might be efficient to filter EQ
changes out of any new, or subsequently recalled,
snapshots. In this way the original equalization
settings remain active throughout.
• Filters are selectable on each snapshot.
• Parameters which can be filtered from changes
are: Fader, EQ, Phase, Mute, Compression,
Plugins, Pan, Gate, Direct Routing, Auxes and
Buses.

New Snapshot (Alt+N)
• Creates a new snapshot of the current mixer
status throughout all parameters (channel and
plug-in settings) except analog TRIM and the
selection of MIC or LINE on channels 1–12.
• Parameters not affected by snapshot recall are:
Surround mode, Channel Key Input, ALT I/O
Output assignment, Plug-in routing, Plug-in module
type and parameter values (loading/unloading of
configuration), and Channel List settings.

Open Snapshot…
• This opens a previously saved snapshot file from
the disk. This is a very convenient feature that
enables immediate recall over the mixer status for
tracking, overdubs, mixdown, etc., such as a
default mix setting.
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Save Selection As
• Saves current mixer snapshot selection
(highlighted in the snapshot list) to a file for recall
at a later date.
• This is different from a stored snapshot in that it
saves data in a file for retrieval, even from a
different session. Snapshots, on the other hand,
are stored specifically as a portion of a session file.

as the selected channel’s front/rear position
control. The control surface can perform surround
pan positioning using the Etch-A-Sketch® (Etch-AMix) approach.

MIDI Channel
• Determines the send channel for MIDI data
contained in the snapshot.

Store Snapshot
• Stores all snapshot data in the snapshot list for
immediate selection at any time during a session.
Stored snapshot data is only available from within
the session in which it’s stored.

Edit Playback Filter (Alt+I)
• Opens the Snapshot Filter window.
• Allows for elimination of specific parameter
change information from snapshot data.
• This window can also be opened by doubleclicking the “Filtered:” field in the Snapshot
window.

Unlock Snapshot
• Sets the snapshot status to receive updates.
• An unlocked snapshot can be overwritten by
storing data in the same snapshot number.
• An unlocked snapshot is indicated by the open
padlock to the left of the snapshot number in the
snapshot list.

Lock Snapshot
• Sets the snapshot to ignore updates.
• A locked snapshot cannot be altered or overwritten.
• Once you’ve stored a snapshot you’d rather not
lose, lock it. If you want to further adjust this
snapshot, store it to a different snapshot number
and alter it.
• A locked snapshot is indicated by a closed
padlock to the left of the snapshot number in the
snapshot list.

Delete (Alt+Delete)
• This removes the highlighted snapshot(s) from the
snapshot list, even if they’re locked.
• This cannot be undone.

Renumber
• Renumbers the snapshot list in ascending
numerical order.

Select All (Ctrl+A)
• Highlights all snapshots in the list.

The Surround Window (Ctrl+3)
The surround window offers precise control
over image positioning in any mixing panorama
along with individual subwoofer level and depth of
center control.
Surround position control is available from the
control surface by using the individual Channel
pan for L/R positioning and the Master Pan V-Pot
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Panning
• Simply drag the colored ball to position a channel
anywhere in the surround panorama.
• The top of the pan grid represents the front
speakers.
• The bottom of the pan grid represents the rear
speakers and the subwoofer.
• The subwoofer (Bus 4) is not affected by pan, but
in the case of LCRS, Bus 4 is the rear (surround)
panned bus output.

Flyback
• Adjust surround position as usual, by dragging the
red or green ball. However, when FLYBACK is
selected, the ball (surround position) immediately
snaps (flies) back to its original position once the
mouse button is released.

Output Assignment/Speaker Icons
• Toggles channel sends to individual speakers
within the surround system, between on and off.
• Click the desired speaker position to include it in
the channel’s surround pan position.

Pan Position (Green Ball)
• Selected by clicking the icon containing the
green ball.
• Acts as a retrievable surround pan, depth-ofcenter level, and sub-effect level preset that is
instantly selected when the icon containing the
green ball is clicked.

Pan Position (Red Ball)
• Selected by clicking the icon containing the
red ball.
• Acts as a retrievable surround pan, depth-ofcenter level, and sub-effect level preset that is
instantly selected when the icon containing the
red ball is clicked.

Morph

Speaker Icons

• Activated by clicking the MORPH icon.
• Automatically pans between the red and green
surround positions, depth-of-center level, and subeffect level.

Speaker icons are numbered consistently
throughout the surround modes. Speakers 1 and 2
are always Front L/R; speaker 3 is always Front
Center; speaker 4 is always the Subwoofer (except
in the case of LCRS, when it’s the Mono Surround);
speakers 5 and 6 are always Rear L/R; and
speakers 7 and 8 are always Front Left Center
and Front Right Center.
To set speaker status across a 12 channel row
(or a portion of a row), open the Panning Overview
window (Ctrl+7), click on a speaker icon, and drag
parallel left or right—all channels in the row will
adopt the speaker status of the originally selected
icon.

Morph Time
• Controls the amount of time it takes for the
MORPH process to move between the two preset
positions (red and green balls).
• Can be adjusted between 1 and 121 seconds.

Depth of Center
• This control spreads (from the Center to the Left
and Right) the channel surround pan position in
the front half of the surround panorama.
• The resultant moves can be recorded into
automation.

Depth of Center Level Meter
• This display indicates the width of the center
image from 0 (Center) to 100 (Left and Right
only—phantom center channel).
• 50 is an even level distribution among L, C, and R.

Low Freq Effect
• Acts as an individual channel level control to the
subwoofer output.
• The number four speaker icon controls the
subwoofer on and off status (except LCRS).
• Since low frequencies are omnidirectional,
individual channel sends to the subwoofer are not
controlled in the surround pan positioning grid.
Their sends to the subwoofers are adjusted by the
Low Freq Effect fader.
• The fader control attenuates from 0.0 (full level)
to –100 (off).
• The level may be further boosted or attenuated at
the Bus 4 fader for the entire subwoofer output.

Stereo

Channel Number Display
• This numeric readout indicates the channel being
affected.

Surround Modes
There are five surround modes available:
Stereo
Quad
LCRS
5.1
7.1
Surround mode selection is accomplished in
the Mix Options Setup window. The Surround
Mode setting determines the look and functionality of the SURROUND SOUND pan window. Each
Surround Mode shares similarities in functionality, yet there are also differences in functionality.
Surround modes other than stereo use 4 to 8
speakers. While mixing in surround, the main
stereo L/R bus may still be available and active.
Pan positions between various front and rear
speakers are sent to the L/R mix as simple L/R
positioning. For example, a channel panned fully
right-rear (speaker 6) displays equal level in the
L/R mix as a channel panned fully right-front.
•
•
•
•
•

• Since stereo is a two dimensional mix mode,
there’s not much use in using the surround
window to pan.
• MORPH and FLYBACK are available only in the
surround pan window. These features offer
creative possibilities in any multichannel mix mode.
• Low Freq Effect and Depth of Center are not
functional in this mode.
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Quad

• Notice the speakers are numbered 1, 2, 5, and 6.
This provides consistency throughout the
available surround configurations. Speakers 1 and
2 are always Front L/R, and speakers 5 and 6 are
always Rear L/R.
• Low Freq Effect and Depth of Center are not
functional in this mode.

LCRS

5.1

• Notice the speakers are numbered 1, 3, 2, 5, 4,
and 6. Speakers 1 and 2 are Front L/R, speaker 3
is Front Center, speaker 4 is the Subwoofer, and
speakers 5 and 6 are Rear L/R.

Depth of Center
• This control continuously varies the center image
from dead-center (speaker 3) to a phantom-center
(equally split between speakers 1 and 2).
• With a Depth of Center setting of “0” the centerpanned channel is routed to the center speaker
only (speaker 3).
• With a Depth of Center setting of “100” the centerpanned channel is routed equally to the front left
and right speakers (speakers 1 and 2).

Low Freq Effect

• Notice the speakers are numbered 1, 3, 2, and 4.
Speakers 1 and 2 are Front L/R, speaker 3 is
Front Center, and speaker 4 is Mono Surround.

Depth of Center

• This control varies the channel send level to the
subwoofer (speaker 4).
• This is the only control over channel levels to the
subwoofer (speaker 4).
• The pan grid has no effect on this adjustment.
• With this control set to OFF there is no send level to
the subwoofer.
• Unity gain is achieved when this control is set to “0.0”.

7.1

• This control continuously varies the center image
from dead-center (speaker 3) to a phantom-center
(equally split between speakers 1 and 2).
• With a Depth of Center setting of “0,” the centerpanned channel is routed to the center speaker
only (speaker 3).
• With a Depth of Center setting of “100” the centerpanned channel is routed equally to the left and
right speakers (speakers 1 and 2).

Low Freq Effect
• This control has no effect in LCRS mode.
• Notice the speakers are numbered 1, 7, 3, 8, 2, 5,
4, and 6. Speakers 1 and 2 are Front L/R, speaker
3 is Front Center, speaker 4 is the Subwoofer,
speakers 5 and 6 are Rear L/R, and speakers 7
and 8 are Front L/R Center.

Depth of Center
• This control continuously varies the center image
from dead-center (speaker 3) to a phantom-center
(equally split between speakers 1 and 2).
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• With a Depth of Center setting of “0” the centerpanned channel is routed to the center speaker
only (speaker 3).
• With a Depth of Center setting of “100” the centerpanned channel is routed equally to the front left
and right speakers (speakers 1 and 2).
• Note: Speakers 7 and 8 are unaffected by the
Depth of Center control.

Low Freq Effect
• This control varies the channel send level to the
subwoofer (speaker 4).
• This is the only control over channel levels to the
subwoofer (speaker 4).
• The pan grid has no effect on this adjustment.
• With this control set to OFF there is no send level
to the subwoofer.
• Unity gain is achieved when this control is set to
“0.0”.

• Deactivates all speaker selections.
• Sets Depth of Center status to “0” (center pan
routes to speaker 3 only in surround or equally to
L/R in stereo).
• Sets Low Freq Effect to 0.0 (unity gain).
• Reset affects only the selected morph setting (red
ball/green ball).
• Channel settings that are reset are not stored on
the Clipboard, and therefore they are not available
for Paste functions. However, a reset can be
reversed by selecting “Undo” in the Surround
Sound window Menu or by pressing Ctrl+Z.

Open Surround…
• This action opens the Surround Files folder where
previously saved surround settings are stored.
• Highlight the desired setting and click Open or
simply double click on the item to activate it for
the selected channel.

Right Click

Save Surround As…

Right click in the desired window to reveal the
Surround Menu. This menu provides opportunity to:
• Reset the channel surround parameters
• Undo previous action
• Open previously saved surround channel status
• Save existing surround channel parameters
• Cut, Copy, or Paste all channel settings

• Enables archival of specific surround positions.
• Opens the Surround folder and automatically
names the file “Surround#X”.
• To rename the file, simply type the desired text
into the auto-highlighted File Name field or, if
necessary, highlight the existing text and type the
new file name.
• Click Save to complete the action.

MENU

Cut
• This action cuts all settings from the selected
channel and resets it to the default settings. Pan
is centered, speakers are deactivated, Depth of
Center is set to “0”, and Low Freq Effect is set
to “0.0”.
• Though the result of a cut is like the result of
“Reset,” settings that are cut are stored on the
Clipboard and can be pasted into a selected
channel. (Channel settings that are Reset are not
stored on the Clipboard.)
• Morph selection and time adjustments are not
part of the Cut action. They are unaffected by cut,
copy, or paste.

Copy
Surround Menu commands are only active on
pannable channels. If a menu command is unavailable, it will display in gray upon Menu activation.
Menu selections are not available in the Master
Fader bank.

Undo
• This feature is available to Undo cut, copy, paste,
arm, and reset commands.
• As an added aid, the Undo command specifies the
target of its action.
• This feature does not undo changes in surround
pan positioning.

Reset
• Resets the selected channel to front-center pan
position.

• This action copies all current surround channel
settings to the Clipboard. Copied settings can be
pasted to other selected channels.
• All Surround Sound parameters are copied and
are part of the Paste function. However, only data
for selected Morph (green ball/red ball) is copied.
• Morph selection and time adjustments are not
part of the Copy action. They are unaffected by
cut, copy, or paste.

Paste Surround
• This action replaces any current settings on a
selected channel with previously copied or cut
surround data.
• Morph selection and time adjustments are not
part of the Paste action. They are unaffected by
cut, copy, or paste.
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The Locator Window (Ctrl+4)

enter the desired time in hours, minutes, and
seconds, then press Enter to complete. Store
locate time by selecting LOCATOR mode, entering
the locate number, then pressing Store followed
by Enter.
• Locate points can be entered on the fly by simply
clicking the New button at the desired time during
playback.
• Selected Locate points can be updated by clicking
the Store button to overwrite with the current
time.

Automation Parameters
These settings activate and deactivate the
write status of all automation parameters. In
addition, Bypass controls the read/playback status
for all automation data.

BYPASS

Transport Controls
Play, Stop, REWind, FFWD, Record
These controls operate any connected record
or playback devices. Devices are controlled
through MIDI Machine Control (MMC) and must
be set properly to receive transport control
commands.

Numeric Transport Position Indicator
• This window defaults to SMPTE time code
position, but can also indicate transport position
in Bars/Beats/Ticks or Milliseconds.
• To change the transport position readout, rightclick anywhere in its numeric window, then scroll
and select from the pop-up menu.
• From the control surface, toggle between SMPTE
and Bars/Beats/Ticks by pressing the SMPTE
VIEW button next to the POSITION readout.

• When this is highlighted, automation data is
completely ignored.
• When this icon is not highlighted, all previously
recorded automation data plays back and any
selected automation data can be written, as long
as channels are in automation write mode and
time code is received at the MTC input.
• See the Playback column in the Channel List
(under Channel in the upper menu bar) for
individual channel automation playback status.

FADER
• Highlight this button to enable the recording of
fader movements into automation.

MUTE
• Highlight this button to enable the recording of
mute on/off selections into automation.

PAN
• Highlight this button to enable the recording of
pan and surround positions into automation.

ALL
• Highlight this button to enable the recording of
all other automation parameters besides fader,
mute, and pan, into automation.

TOUCH
Ways to Enter Locator SMPTE Position
• Click in desired field (Hours, Minutes, Seconds,
Frames) and drag up to increase and down to
decrease. Press Enter or click out of the field to
complete.
• Click in the desired field and enter the number
from the keyboard number row or numeric
keypad. Press Enter or click out of the field to
complete.
• Press Tab to enter the SMPTE window, starting at
the Hours field and enter the desired setting.
Press Tab to move from field to field; press Return
to complete action and to exit data entry mode.
• Press the SET TIME button (in the Transport
section on the console) to enter a locate time.
Using the numeric keypad on the control surface,
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• Highlight this button to enable automation data
recording by simply moving an automation
parameter control.
• While automation is playing back, moving any
selected parameter control begins instant
recording of that automation parameter.

TRIM
• Highlight this button to move all faders to unity
position for TRIM automation.
• This status adds or subtracts the TRIM fader
movement to or from all previous channel
automation data.
• Use this feature anytime you want to keep all
previously recorded fader moves intact while
offsetting the relative track level.

LOCATOR Parameters

New
• Click this button to create a new cue point.
• The new cue point is created at the existing
SMPTE, millisecond, or measure position.
• Cue point readout changes form depending on the
readout format selected in the main Locator
window (SMPTE, Bars, Milliseconds.)

Delete
• Click this button to Delete the highlighted cue
point(s) from the Cue list.

Renum
• Cue points are ordered on the Cue list according
to their Locator position (SMPTE, Bars,
Milliseconds). If cue points are not created
progressively from the beginning of the recording
to the end, the Locator numbers (left of the Cue
name) might become random. Click Renum to
restructure the cue numbers into ascending order
from the beginning of the recording to the end.

hours). A vertical scroll bar allows for paging or
incremental viewing of the channels or parameters, and the horizontal scroll bar allows for
paging or scrolling time chunks, according to the
current time resolution.
The Mix Editor can view a single channel with
all of its parameters or, by selecting the “Channel
View” checkbox, you can view multiple channels
of one parameter type (plus a background event of
a different type). This allows you to view, for
example, 12 EQ parameter tracks stacked on top
of one another, or 6 stacked pan automation
curves.
Automation Event curves are displayed as
dots (actually, small squares) that represent
nodes, and lines that represent value ramping.
The nodes represent editable points that are either
created during the automation process in real
time, or by the hand tool in the Mix Editor.
Note that on/off or radio button-type parameters (e.g., Mutes, EQ On/Off, or Snapshots, etc.)
that aren’t of a ramping type, are displayed as
stepped values.
Automation tracks may be cut, copied and
pasted, in typical graphic editor fashion, using
click and drag highlighting with the mouse cursor
and ` (“I” icon). Single segment copy and multiple
pasting may be performed easily with repeatable
segments for a “groove” repetition approach. An
entire time region across all parameters or
channels (according to the current filter views)
may be selected by clicking and dragging across
the top time bar. Highlighted regions may be
“nudged” up, down, left or right, for trim or offset
needs, using the 4 nudge arrows (top center of the
Mix Editor window).
Note: Refer to the History List as well. It’s of
great value when using the Mix Editor.

Store
• Click Store to enter the current Locator position
into the highlighted Cue point.
• If multiple cue points are highlighted, the Locator
position is stored in the earliest occurring Cue
point only.

The Mix Editor Window (Ctrl+5)
The Mix Editor window contains a graphic
representation of automation data. Though
automation data is primarily entered through the
control surface knobs, buttons, and faders, it can
also be altered graphically in the Mix Editor.
Precise level and timing information is easily
entered and adjusted here. The resizable window
supports various selectable views from 1 to 24
channels, or parameters, of data on the Y axis and
any length of time region on the X axis (up to 24

Auto Follow
• This feature causes the Mix Editor to change
views on the fly. When enabled, Auto Follow
updates the Mix Editor to focus on any parameter
you touch (by channel and function). When
enabled, “Auto Scroll” updates the Mix Editor to
scroll the screen past the timeline cursor, located
at the screen’s halfway point.

Edit Tools
Left-click on the Mix Editor tools to select
them. At any time, right-click in the channel/
parameter list to open a pop-up list for quick and
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easy selection of the desired Edit Tool (I Beam,
Hand, Magnify, or Eraser).

Time Code Displays

• Press the Alt key along with the up/down
arrows on the keyboard to scroll up and down
the channel/parameter list.

• Three time code displays indicate the highlighted
region start and end points, and the current cursor
position (displayed in either SMPTE or BBT).
• Values may be manually entered in the Start/End
point fields for specific edits.

• Press the Control key along with the up/down
arrows on the keyboard to vertically zoom in
on the channel/parameter list. The view varies
between 2, 4, 8, 16, and 24 channels or
parameters.

Pointer Tool (Hand Tool)
• Use this tool to enter new data nodes and to alter
existing ones.
• While the Pointer tool is selected, press the
Control key to momentarily select the Erase tool.
• The Pointer tool can create and move new or
current automation nodes (curve turning points)
while time code is being received (on the fly
editing—before or to the left of the current time)
or while time code isn’t being received (at any
point on the timeline).

Eraser Tool
• Use this tool to click on and remove the data
inflection nodes.

Highlighter Tool (the I-Beam)
• Use this tool to select data by time and channel.
• Select the “I” tool and click and drag across a
track to highlight a specific time region.
• Click on another track name field to move the
current highlighted region (time segment) to the
selected track.
• Click and drag across the top timeline bar to
select specific sections of time across all tracks.
• Double-click on one track to select the entire 24
hours of data.
Note: You can select multiple adjacent
channel parameters (in Channel View) or multiple
adjacent parameters by pressing the Shift key on
the keyboard while clicking on tracks.

Magnify Tool
• Use this tool to select specific data lengths and to
expand the data time to fill the overview screen.
• Click and drag with the Magnify tool to zoom into
a specific area. Double-click to double the
magnification.
• Hold the Control key while in magnify mode to
toggle between zoom in and zoom out.

Zoom Arrows
• The four blue zoom arrows at the top of the channel/
parameter list expand and contract the time axis
(left and right arrows) and change the displayed
number of automation tracks or parameters (up
and down arrows—choices are 1, 2, 3, 4, 6, 12,
and 24 tracks) when clicked with the mouse.
• The keyboard arrows are mapped to control the
same view display changes when the Mix Editor
is open, using modifier keys as follows:
• Press the Alt key on the keyboard along with
the left/right arrows to scroll across the Mix
Editor timeline.
• Press the Control key along with the left
arrow on the keyboard to zoom out.
• Press the Control key along with the right
arrow on the keyboard to zoom in.
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Page and Back Pull-downs
• Allows two automation types to be viewed as
foreground and background data (great for seeing
relational data like fader and pan, or surround
front/rear pan vs. L-R pan). The foreground data
curve is subject to all clipboard operations, while
the back page curve remains untouched. To
update either the foreground or background view,
click on the drop-downs, drag across the type field
or channel and release the mouse on the
highlighted desired item.

Auto-scroll Checkbox
• When enabled, scrolls the data window along with
the time code while the current time cursor
remains centered in the window.

Auto-follow Checkbox
• When enabled, causes the screen to update and
place the last selected, or ‘touched,’ channel strip
or channel parameter to the topmost position in
the window.

Channel View
• When disabled, provides a view of a single
parameter across multiple channels. The
parameter is selected in the Page pull-down box.
• When turned on, you can view multiple
parameters of a single channel. The channels are
selected in the Page pull-down box, which
includes the Master Fader, groups, buses, plugins, FX, returns, and MIDI channels.

When Channel View is highlighted, the Mix
Editor Channel List changes to a parameter list. This
mode views one channel, effect, bus, aux, group,
MIDI channel, or plug-in at a time. The list then
contains all parameters available for automation.
The six buttons to the left of the Page and
Back pull-down lists act as filters for parameter
selection:
• When none of these six buttons is pressed, all
data is displayed for the selected channel.
• Highlight the EQ button to display EQ data
only.
• Highlight the Comp button to display
compression data only.
• Highlight the Gate button to display gate data
only.
• Highlight the FMP button to display fader,
mute, and pan data only.
• Highlight the Busses button to display bus
data only.
• Highlight the Auxes button to display aux
data only.
These buttons can be selected in combination
with each other. For example, to view EQ and
compression data, simply highlight both EQ and
Comp.

Four Nudge Arrows
These arrows are located in the Mix Editor
control palette immediately to the left of the
Cursor, Start, and End time windows.
• When these arrows are clicked with the mouse,
highlighted data regions can be moved back and
forth in time (left-right arrows), or values within
the highlighted regions may be incrementally
increased or decreased by using the up-down arrows.
• The resolution of these moves is relative to the
current screen resolution, so the greater the zoomin value, the finer the resolution of any modifications.
• Using the nudge arrows is a good way to toggle
mute events on and off by highlighting regions on
a mute track and simply nudging up or down to
change mute states.

Flip View Icon
This tool swaps the Page parameter views in
the Mix editor. For example, if “Fader” is foreground and “Mute” is background, clicking on the
flip icon will toggle the view to show “Mute” as
foreground and “Fader” as background. Toggling
the flip once more will flip the view back to the
original view of “Fader” as foreground and “Mute”
as background.

Cue Points
Tabs along the top of the time line indicate
cue points. Simply click and drag the cue point
tabs to reposition them in the Mix Editor window.
Performance Note: For optimum graphic update
performance during automation and playback, it is
best to close all windows other than the Mix Editor.

Automation Moves
• The box under the Auto-Follow button displays
Node usage and availability.
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The Fat Channel Window (Ctrl+6)

The Fat Channel overview is opened and
closed by clicking on the “Fat Channel” button in
the lower menu bar, or by pressing Ctrl+6 on the
keyboard. The shortest way to open and close the
Fat Channel is to double-click on a channel
SELECT button.

EQ

There are four EQ types to choose from:
• 4 Band Parametric
• 20/20 EQ
• British EQ
• British H/P
The default EQ type is the “4 Band Parametric
EQ.” A quick summary of the EQ choices follows:

4-band Parametric
• 4 parametric bands with analog style overlaps

20/20 EQ
• 4 parametric bands with full 20Hz to 20kHz
frequency sweep on each

British EQ
• Low-band hi-pass filter, 2 mid-parametric bands,
and a high-band low-pass filter

British H/P
• Low-band hi-pass filter, 3 upper-parametric bands
EQ types are saved and recalled with patches,
snapshots, and sessions, and transferred via
clipboard operations.
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• Click the ON button near the bottom of the EQ
window to turn on the EQ for the selected channel.
• There are three methods to modify parameters in
the EQ.
• Click and drag on the graphic curve in the
display window. Drag up and down to change
the gain, left and right to change the
frequency, and click and drag left and right
while holding down the Alt key to change the Q.
• Click and drag up or down on a control knob
below the display window.
• Click and drag up or down in the numeric
display boxes (Gain, Freq, Q).

Compressor
The meter in the Compressor section indicates
the amount of gain reduction applied by the Compressor. Thus, when there is no signal applied, the
Reduction meter indicates 0 dB of reduction, with
the needle all the way to the right. As the signal
level increases above the Threshold setting of the
Compressor, the needle moves down, indicating the
amount of compression being applied at any given
moment in time, to a maximum of 20 dB of reduction.

MENU
• Click the MENU button to Open, Save, Reset,
Undo, Cut, Copy, and Paste an EQ patch.

Note that the Reduction meter is triggered by
the Compressor function only, and does not
indicate the closing or opening of the gate.

Threshold
• Determines the level at which the compressor
begins to act on the incoming signal. It is calibrated
in decibels, ranging from –60.00 dB to –1.00 dB.

Attack
• Determines how fast the compressor reacts once
the threshold has been exceeded. It is calibrated
in milliseconds, ranging from 0.31 ms to 2560.00
ms (2.6 seconds).

Release
MEM A/B
• Each MEMory stores the most recent MEM A or
MEM B EQ settings made for the selected channel.
• Click either of these memory positions to instantly
select the stored settings.
• Ideal for making quick A/B comparisons between
EQ settings.

MORPH
• Click the MORPH button to smoothly fade from
one MEMory setting to the other.
• The amount of time it takes for this transition is
set in the time window directly below the MORPH
button.
• MORPH time can be set as low as 1 second or as
high as 121 seconds.

• Determines how fast the compressor turns off
once the signal falls below the threshold. It is
calibrated in milliseconds, ranging from10.00 ms
to 2500 ms (2.5 seconds).

Ratio
• Determines the change in output level as a
function of the change in input level, once the
threshold has been exceeded. It is calibrated in
decibels, ranging from 1.00:1 to 19.99:1. Thus, if
the ratio is 10:1, an increase in input level of 10
dB (assuming the input is above the threshold
level), results in a 1 dB in output level.

Output
• Determines the overall gain of the compressor from
input to output (as measured with the signal below
the threshold level). Use this control to compensate
for the loss of gain caused by the action of the
compressor. It is calibrated in decibels, ranging
from unity (00.00 dB) to +20.00 dB.
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SOFT
• This button turns on the soft-knee function, which
determines the severity of the compression action.
When highlighted, compression is smoother and
more gentle.
• When SOFT is not highlighted, the compression or
limiting action is more immediate and extreme.

ON
• Click the ON button to turn on the compressor for
the selected channel.

MENU
• Click the MENU button to Open, Save, Reset,
Undo, Cut, Copy, and Paste an Compressor patch.

The red LED, on the bottom right of the meter,
is a “gate threshold” indicator and lights up to
indicate when the Gate is on.
Remember that additional channel metering is
found on the console’s channel strips (post-EQ,
pre-Fader) and also at the dual-solo meters
(sharing duties with the L/R meters), indicating
either PFL (post-EQ) or AFL levels, as determined
by the solo section assignment.

Threshold
• Determines the level at which the gate acts on the
incoming signal. It is calibrated in decibels,
ranging from –60.00 dB to –1.00 dB.

MEM A/B

Attack

• Each MEMory stores the most recent MEM A or
MEM B EQ settings made for the selected channel.
• Click either of these memory positions to instantly
select the stored settings.
• Ideal for making quick A/B comparisons between
compressor settings.

Release

Gate
The meter in the Gate section indicates either
the input signal level or the output signal level,
depending on the setting of the Meter switch next
to the meter. This setting is global and is not
recalled with any individual channel. The default
meter setting is “In” (Input level).

• Determines how fast the gate opens once the
threshold has been exceeded. It is calibrated in
milliseconds, ranging from 0.10 ms to 599.99 ms.
• Determines how fast the gate closes once the
signal falls below the threshold. It is calibrated in
milliseconds, ranging from10.00 ms to 2500 ms
(2.5 seconds).

Range
• Determines the change in output level as a
function of the change in input level, once the
signal level drops below the threshold. This is
sometimes called downward expansion. It is
calibrated in decibels, ranging from 0.00 dB to
100.00 dB.

ON
• Click the ON button to turn on the gate for the
selected channel.

MENU
• Click the MENU button to Open, Save, Reset,
Undo, Cut, Copy, and Paste an Gate patch.

MEM A/B
• Each MEMory stores the most recent MEM A or
MEM B EQ settings made for the selected channel.
• Click either of these memory positions to instantly
select the stored settings.
• Ideal for making quick A/B comparisons between
gate settings.
The I/O Signal meter displays the channel
input signal, as measured at the post-Digital Trim/
pre-Compressor point. The channel output is
measured at the post-Gate/pre-EQ point, with a
range of –20 dBFS to 0 dBFS (the best signal-tonoise range). Even though this meter occupies a
chunk of screen real estate in the Gate region, the
needle movement is not directly displaying the Gate
operation, but instead reflects the total gain
contribution from the Digital Trim, Compressor,
and Gate functions (when “Out” is selected).
Additionally, on the I/O signal meter there is a
“signal present” indicator (the green LED), which
lights if the signal is above “minus infinity” dB
(the same minimum range as the channel meter
bars). At –20 dBFS, the needle movement kicks in.
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Additional Fat Channel Controls

Aux Sends
• Use the on-screen knobs to adjust any of the aux
send levels.
• Press Control while clicking the Aux knob to set
Aux send level to unity gain.
• Click in the window directly below the Aux send
knob to toggle the individual Aux Pre/Post status.
• A yellow block beneath the Aux send level control
indicates a Pre-Fader status for the Aux send.

Digital Trim
• Use the on-screen knob to adjust the channel
digital trim.
• Press Control while clicking the knob to set the
Digital Trim to unity gain.

Write
• Highlight this button to put the selected channel
into automation Write Ready mode.
• This cannot be activated when the console is in
automation BYPASS mode.

Pan
• Pan channel in the L/R spectrum.
• Hold Control and click on the PAN button to snap
to center position.

Solo
• Highlight SOLO to solo the channel.
• Press “S” on the keyboard to solo the selected
channel(s).
• Press “D” on the keyboard to release the SOLO
status on the selected channels.

Mute
• Highlight MUTE to mute the channel.
• Press “M” on the keyboard to mute the selected
channels.
• Press the comma key on the keyboard to release
the mutes on the selected channels.

Channel Select
• Use the arrows on either side of the channel number
(or the arrow keys on the keyboard) to scroll up or
down through the D8B channels.
• Click in the “Chan. Select” window for a pull-down
of all the channels.

Channel Name
• This displays the channel name.
• Double-click on the name to highlight it, then type
in the new channel name (up to 16 characters).
Press Enter or click elsewhere to complete the
operation.

Assignment

Fader
• Use the on-screen fader to adjust the selected
channel level.
• Press Control while clicking anywhere in the fader
throw area to snap the fader to unity gain.

Pre-DSP Insert
• Click and hold in this window to insert a channel,
aux, bus, return or plug-in into the signal path
before the DSP.
• This insert is at the beginning of the signal path,
just after the A/D converter and before Digital
Trim, EQ, Dynamics or other processing.

Post-DSP Insert

• Assign the channel to the main L/R bus or any of
the 8 bus outputs.

• Click and hold in this window to insert a plug-in
into the signal path post EQ, Dynamics, and other
processing.

Route to Tape

Key Input

• Highlight the desired numbers to send the channel
to one or many tape outputs.
• This is the most visual way to tell if a channel is
routed to several tape outputs.

• Use another channel’s audio to trigger the
dynamic processor of the selected channel.
• Click and hold in the Key Input window to select
the key input source.

Phase
• Highlight PHASE to invert the channel polarity by
180 degrees.
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Dynamics EQ

L.F.E. (Low Freq Effect)

• Use this window to filter the key input. This is
often necessary to properly trigger the dynamics
processor. Accentuate the high frequencies of a
key instrument with lots of attack to solidify the
keying process.
• This EQ is edited as described for other EQ edit
operations.
• Dynamics EQ borrows the highest band of the
regular channel equalizer. As a trade off, you get to
equalize the key audio. However, you’re left with
only three bands of EQ for the specified channel.

• This control varies the channel send level to the
subwoofer (speaker 4).
• This is the only control over individual channel
levels to the subwoofer (speaker 4).
• The pan grid has no effect on this adjustment.
• With this control set to OFF there is no send level
to the subwoofer.
• Unity gain is achieved when this control is set to
“0.0”.

The Panning Window (Ctrl+7)

Pan Ball
• Click and drag the pan ball to change surround
pan positioning.
• Top of the pan grid is front; bottom of the pan grid
is rear.
• Hold the Control key to restrict the pan ball to
vertical movement.
• Hold the Alt key down to restrict the pan ball to
horizontal movement.

Right Click
Right click in the desired window to reveal the
Surround Menu. This menu provides opportunity to:
• Reset the channel surround parameters
• Undo previous action
• Open previously saved surround channel status
• Save existing surround channel parameters
• Cut, Copy, or Paste all channel settings

This window is extremely useful in an active
surround mixing environment. All the basic
surround pan function are available for each
channel (mics, tape, FX, and returns).

Speaker Select
• Highlight the desired speaker number icon to send
a specific channel to any or all speakers.
• Speakers are always numbered according to
function: Front L/R are speakers 1 and 2; Front
Center is speaker 3; Rear L/R are speakers 5 and 6;
Front L/R Center are speakers 7 and 8; Speaker 4
is the Subwoofer (or Mono Surround for LCRS).
• To set speaker status across a 12 channel row (or
a portion of a row), click on a speaker icon and
drag parallel left or right—all channels in the row
will adopt the speaker status of the originally
selected icon.

D.O.C. (Depth of Center)
• This control continuously varies the center image
from dead-center (speaker 3) to a phantom-center
(equally split between speakers 1 and 2).
• With a Depth of Center setting of “0” the centerpanned channel is routed to the center speaker
only (speaker 3).
• With a Depth of Center setting of “100” the centerpanned channel is routed equally to the left and
right speakers (speakers 1 and 2).
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The Faders Window (Ctrl+8)

TAPE Bank on top
This mode places the tape return fader bank in
the upper half of the screen display. Now all input
faders are available at all times. This offers incredible value in many practical applications, even
though the tape fader bank masks the Aux Sends,
Bus Assignments, Tape Outs, Digital Trims, as well
as EQ, phase, Compressor and Gate on/off buttons.
• Record buttons are available on the tape fader
bank.
• Automation Write buttons are available on all 48
channels.

Channel Numbers
• Maintains previous channel layout. However,
it’s not possible to reconfigure channels, once
the Faders option is selected.

Event Automation Track (Ctrl+9)

• Use this feature to duplicate an action at a
different time stamp. Simply duplicate the event,
then edit the time stamp field by double-clicking
on the time reference. Place the cursor on the
desired time unit, then drag up to increase or
down to decrease.

Capture Event Time (Alt+T)
• Highlight and release this Edit Menu item to copy
the current Locator time position to the time
reference window of the highlighted Event
Automation Track item.

Run Event (Alt+R)
• Click any where in the event row to highlight it.
• Choose Run Event from the Edit menu to activate
(send) all event data to the designated destination.
For example, when Run Event is selected while a
snapshot event is highlighted, the snapshot data
is instantly loaded into the D8B.
• Avoids having to run time code to preview the event.

Synchronize Events

The Event List has been replaced by the Event
Automation Track, which allows for a new approach
to time stamping snapshot recall and modular DSP
recall. A list of events can be easily placed, moved,
and edited from this handy window. Snapshots,
Plug-ins, Channels, as well as EQ, Compressor,
and Gate Patches can all be accessed from the
disk and placed with frame-accurate precision.
Use this list to trigger files to load at a given
timestamp. This is a handy way to automate an
EQ, by the way, because you can edit the Patch
and all references change. One way of looking at
the patch event is as a mini snapshot.

Synchronize Events is used to match file data
from the current opened session with the DSP
patch files (EQ, Comp, Gate, Channel, Plug-in) on
disks that are referenced by the Session’s Event
Automation Track. In short, it is a ‘Disk to RAM’
correlation. DSP files that the Event track references may need to be resynchronized due to the
files having been renamed, deleted, updated, or
moved. An important thing to keep in mind is that
a session saves all of the Event Automation Track
parameters, whether or not the original referenced
DSP files exist at all. This ‘safety net of reproducibility’ was an important design issue; a session
should completely reproduce snapshots and
dynamic automation playback, regardless of file
dependencies outside of a session.
Synchronize Events does not act upon snapshots, because it does not directly reference
snapshots from disk. Any changes to snapshots
within a session operation will not be displayed as
modified Event lines in the same manner as DSP
patch file references.
Visually, when a session using Events is
loaded, the OS performs a match against the
dependent files, and displays any detected changes
by adding an asterisk to the ‘Action:’ column to any
or all Event lines. Event lines must be highlighted
first before performing a sync operation.

Delete Events (Alt+Delete)
New Event (Alt+N)

Guess what! Select this item to delete any
selected automation events.

• Select this item to add a new event to the list.

Select All (Ctrl+A)

Duplicate Event
• Highlight any list item, then select Duplicate
Event.
• This creates an identical copy of the selected
event.

Choose this item to select (highlight) all
automation events on the list.

Mute Icon
Highlight any of the “M” icons to mute the
triggering of automation event playback.
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Current List Item Arrow

The History List Window (Ctrl+H)

• The arrow in the far left column represents the
current or last triggered automation event.
• The arrow moves to the next event as soon as the
time code reaches the automation event time; it
remains there until another event time is passed.

New Event Type
This pop-up window lets the user select the
specific type of automation event: Snapshot, EQ,
Compressor, Gate, Channel, or Plug-in.

Load Target
• This pop-up window lets the user select a channel
destination for the selected data type.
• A snapshot event does not permit target selection;
it only requires the entry of the specific snapshot
number.

Browse/Path
• Click the Browse button to search your D8B patch
files for the desired automation event.
• Highlight the proper patch in the list then press
“Open” to load the event into the automation
event list.
Note: The folder that opens automatically for
each event type contains user patches, so if you
haven’t saved any patches, you won’t see any
items on the list.

Time Window
• Enter the exact frame-accurate time for the
automation event data to be activated.
• Click each time segment and drag up or down to
increase the time setting.
• Time settings are also selectable by pressing the
Tab key until the appropriate time field is
highlighted, then entering the number from the
numeric keypad or number keys on the keyboard.
Tab from field to field.
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• The History List Window lists actions taken in the
Mix Editor. In addition, Automation Passes, Clear
Automation…, Delete Global Time, Insert Global
Time, Delete Events, and Modify Levels…
commands are logged as single list items. Each of
these actions is available for Undo, as long as they
remain on the History List.
• Using this list, it is possible to regress to any
point in the mix. If at some point things went in
the wrong direction, it’s easy to go back to where
the mix was on the right track.
• Highlight any item in the list to deactivate all
forthcoming listed actions. When the mix is
played, no actions listed below the selected event
will occur.

• If an event is selected in the list, then a change is
made in the Mix Editor, all events following the
selection will be replaced by the new event.
• Use the Undo command from the Edit Menu
(Ctrl+Z) or the control surface to regress through
the mix event steps one at a time.
• Use the Cut or Delete commands from the Edit
Menu (Ctrl+X) to remove all events below the
selected History List event. These actions are not
replaced by Undo or Paste actions.
• Use the Clear Edit History command from the Edit
Menu to remove all events from the History List.
This action cannot be undone.

The MIDI Map Window (Ctrl + –)

The MIDI Map window offers setup options
for bidirectional MIDI control of practically the
entire console’s parameter set. The MIDI Map is a
complete feature revamp from the V2 Channel
List, which consisted only of channel fader, mute,
and pan MIDI routing. The V3 MIDI Map provides
complete parameter access to channel functions,
master fader, channel strip, and Aux master
controls, and all plug-in parameters. In addition,
the Master section and Transport controls are
assignable to MIDI messages. Additionally, a
‘roving ’ Fat channel map routing may be added,
so that MIDI control may follow the selected Fat
Channel, which is great for external devices such
as a joy stick or X-Y pad controlling (for example)
a channel’s Surround Pan without hard mapping
(and subsequent remapping). MIDI Maps may be
created and saved to disk for subsequent recall.
MIDI continuous controller, polyphonic
aftertouch, and note on messages are assigned to
the various parameters via the MIDI Map, in a
linear approach of one controller type per parameter. In V2, mapping was limited to fader control
as continuous controller messages, mutes as note
on and off messages, and pan as polyphonic
aftertouch control messages. In V3, any variable
controller may be a continuous control message or
a poly aftertouch message, and any switch message (on/off or assignment switches) can be

assigned to a note on (or note off as note on of
velocity 0) message.
In V2, messaging was selectable as In (receive) or Out (send) but not both, whereas in V3
messaging may be bidirectional. This means you
can control the console from a sequencer or
control a sequencer from the console. Note that
MIDI program changes may also be used to
trigger D8B snapshots. Snapshot program change
messages may occur simultaneously with MIDI
Map control messaging. The shorter length MIDI
program change messages allow for much greater
MIDI bandwidth utilization, and in some cases can
accomplish the required control without totally
mapping the console via the MIDI Map. Snapshot
triggering via MIDI is not enabled in the MIDI
Map, but is set via the GUI Setup>Mix Options
window, by checking the MIDI Snapshot box.
A listing of D8B console parameters is found
in the MIDI Implementation Chart at the end of
this document. The off, minimum, and maximum
values are listed with the associated MIDI controller values to aid in setting up a remote control
map. Note that many of the console’s values are
8-bit resolution (255 values). Since MIDI conventionally sends only 128 values (two byte MSB/LSB
precision is not supported by the D8B), intermediate steps will be interpolated by the D8B.
Applications for the MIDI Map include remote
transport control from MIDI applications that
don’t support MMC (but do allow their own
internal parameter mapping), surround joystick
control, or any continuous controller or two-state
switch application (lighting, remote mixing, show
controls, etc.). Any mapped control information
may be transmitted via manual adjustment on the
console, snapshot recall, and/or automation
playback (which may include snapshot or other
Event track playback).

Creating a Route
A Route is created by opening the MIDI Map
from the Windows menu, then selecting “New
MIDI Route” from the MIDI Map File menu or
simply clicking the NEW button at the bottom of
the MIDI Map screen. A Route is made up of the
following attributes:
• (Selection): The first column (with no column
header) denotes the Route number and selected
Route within the map list. The number is a simple
identifier, as there is no sorting mechanism for the
MIDI Routes. The selection paradigm is the same
for any D8B listing function; Shift-click allows for
multiple selections and Ctrl-click allows for
discontinuous selections.
• MIDI Status: This choice offers the type of MIDI
message (as XNh, where X is the status type, N is
the MIDI channel, and h denotes that it’s listed in
hexadecimal values). If the Route is mapping a
switch parameter with two value states, it will be
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•
•

•

•
•

•
•

assigned as a Note On (9Nh) message. If the
parameter is continuously variable, the
Continuous Controller (BNh) or Polyphonic
Aftertouch (ANh) may be used.
#(number): This assignment is in the range of 0127 decimal values (00h-7Fh) for the associated
Status type.
Channel: A static value is selectable for a switch
message type, in the range of 0-127 decimal
values (00h-7Fh). It is not selectable and is the
implied variable (dynamic, changing, whatever)
output when using the continuous type status
messaging. Note that for D8B controls that use
less than 256-step resolution, (e.g., EQ type uses
4 values, whereas a fader uses 256 values), the
full range of 128 MIDI values may not be used.
Route To: This assigns the MIDI route to a
console channel strip, master fader or aux send
master, master section, or transport parameter.
The actual Parameter within any chosen function
is assigned in the Parameter column.
Parameter: Available choices follow either the
switch or variable control types of categories, as
set by the MIDI status column selection.
Mode: A value is displayed when the Route is a
switch type. The displayed value is typically either
On or Off, but may show some other type of
descriptor, such as ‘Pre’ or ‘Post’ as an aid to
determining the Status function.
Direction: The MIDI Route is set to Receive,
Send, or Both. Take care to avoid MIDI feedback.
The File menu inside of the map contains the
following additional commands:
• Open MIDI Map: Recalls a saved MIDI Map
from disk. If a map is currently in place, it will
be entirely overwritten by the map from disk
upon loading.
• Save MIDI Map As...: Saves the current MIDI
map to disk as a Map file, which is available
for recall at a later date.
• MIDI Channel: Sets the global MIDI channel
for the entire map.
• Delete MIDI Route: Deletes the currently
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selected Route(s) within the list. The DELETE
button at the bottom of the MIDI Map window
does the same. Multiple Routes may be
selected using the Shift-Select or ControlSelect keyboard combinations.

Erase UFX Memory...
When you update the plug-ins software on the
D8B, it is necessary to clear the flash memory in
the UFX cards that are installed in the D8B, and
upgrade their memory to the latest version of the
software.
Note: This procedure requires you to reboot
the D8B after it is completed.
1. Select “Erase UFX Memory...”.
2. Follow the on-screen instructions for erasing the
flash UFX OS.
3. When the procedure is completed, click
“Continue.”
4. Reboot the console by turning the power switch
off on the Remote CPU, wait 5 seconds, and turn
the power switch back on.

Upgrade UFX Cards...
After completing the procedure for erasing the
UFX memory, it is necessary to upgrade the UFX
cards to the newest software.
Note: This procedure requires you to reboot
the D8B after it is completed.
1. Select “Upgrade UFX Cards...”.
2. Follow the on-screen instructions for
downloading the UDOS package to the UFX
cards.
3. When the upgrade is completed, click
“Continue.”
4. Reboot the console by turning the power switch
off on the Remote CPU, wait 5 seconds, and turn
the power switch back on.

Applications

Chapter 4
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Setting Up for a Session

Channel Configuration/Planning

This section of the Digital 8•Bus Owner’s
Manual provides very application-specific descriptions of some common usages. Follow the checklist format to help ensure everything is set just
right for your configuration.
As your skills and knowledge increase, try
new techniques. Build a system that’s optimized
for your specific application.

This actually has a lot to do with how well any
audio experience unfolds. If you know where
you’re headed with track expectations and instrumentation, you’ll be able to make better choices
along the way. Plan; plan again; think about it;
then, plan some more.
Devise a mock up of the final track sheet
before you begin recording. You’ll know more
about how to get where you want to be.

Listening Environment
In any serious recording or live audio situation, the listening environment is one of the most
important considerations. In a recording application, be sure the Digital 8•Bus is connected to
excellent reference monitors, like the Mackie
HR824’s. In addition, set up the system in an
acoustically controlled and balanced environment.
Avoid a control room with identical dimensions in
any direction and set it up with a good mixture of
absorption and reflection.
In a live-sound setting, place the console out
in the house at a good visual and auditory vantage
point. If you’re mixing in mono, it’s okay to sit in
line with one of the speaker clusters. When
mixing in stereo or surround, select the best
location—typically called the “sweet spot”—to
critically assess the entire mix. Eliminate guess
work. Maximize efficiency.

Power-up Procedure
A well-thought-out power-up procedure saves
wear and tear on all your gear. This procedure
helps minimize the opportunity for equipment
damage while maximizing the chance of success.
Refer to Figure 4-1 for a Fast Track Graphic
representation of this procedure.

❏ Amplification system off: power amps or
powered monitors
❏ Master Fader down
❏ Switch Console Power on
•

The D8B will create a Startup file with default
settings if the User-Set Template has not yet
been specified.

❏ Open and load a snapshot or a session (optional)

Figure 4-1 Power-up Procedure
Follow this procedure for a safe and sure startup routine. Deliberate, well-thought-out procedures help eliminate
uncomfortable pauses in a session. They make recording a more enjoyable experience.
Amp or Powered
Monitors Off

Master L/R
Fader Down
MASTER
L/R

dB

Console
Power On

Select A starting Snapshot or
Open Your Master Template

10

5

U

5

10

20

OR

30

40
50
60

Amp or Powered
Monitors On
Connect Instruments
and Microphones

Set Sample
Clock

Synth
OR
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•

It’s a good idea to keep a snapshot of each
working configuration as a starting point:
tracking, overdubs, symphony, grunge band, etc.

❏ Connect all mics and instruments
•
•
•

Be sure all channel faders are down.
Turn Master Fader down.
Turn Speaker level down.

Setup Window
The Setup Window is very important to the
functionality of the Digital 8•Bus. Its settings
determine how the console functions within its
own architecture as well as how it interfaces with
other digital equipment.

❏ Set up sample clock
•

•

•

Verify consistent sample rate settings
throughout all digital multitrack recording
devices.
Word clock and digital data transfer
connections are very important to the
efficiency and functionality of any digital
system. Verify them.
Most systems work best when the D8B is the
Master word clock source. Use the Apogee
Clock I/O card to send word clock to slave
devices.

❏ Turn amplification system on
•

Wait until all other gear is powered up before
turning on the monitor system.

❏ Enjoy the creative process

Follow the checklist on the next page to verify
that each Setup Window parameter is intentionally
set. For specific recommendations for various
parameter settings, refer to “The Setup Window” on
page 64.

Figure 4-2 Basic Connection for Multitrack Recording
This diagram represents the fundamental connections in a D8B-based multitrack system. Sound sources
feed Fader Bank 1 (MIC/LINE); Fader Bank 1 feeds the multitrack inputs via the AIO•8, DIO•8, or ADAT card
outputs; the multitrack outputs feed Fader Bank 2 (TAPE) via the AIO•8, DIO•8, or ADAT card inputs; the mix
output feeds the control room monitor system, master 2-track recorder, headphones, etc.

Multitracks

Audio Source

Fader Bank 1

To Monitors

Fader Bank 2
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Setup Window settings are automatically stored
and are recalled in subsequent boot ups.

❏

General
• Mouse Speed
• Display Intensity
• Date and Time
• Smart Save selection
• Appearance style

❏

Mackie Digital Systems (MDS) Network
• Network Channel
• Mixer Name
• Alt I/O 1–8 assignments
• Link Options across the digital network
(connected Digital 8•Bus consoles)
Digital I/O (Tape 1–24)

❏

• Sample rate
• Apogee Clock status: Internal/Word Clock
• Alt 1–8 Type, Inputs, and Outputs
• Stereo I/O settings
Licensing
• Displays authorization status (locked or
unlocked) of D8B plug-ins
• Enables installation and authorization of
plug-ins

❏

• Displays mixer serial number
Mix Options
• Surround Mode selection and Bus arming

❏

• Aux 1–8 global Pre/Post selection
• Selection of One Button Punch, Record
Safe, Use PreRoll, Use Write Ready, Write
Flyback, MIDI Snapshots, Solo Latch, Link
Speakers, and Faders to Tape
• Fader Calibration
Locator-MMC
• MIDI File Tempo Map loading and resetting
• Default Tempo setting

❏

• Device ID selection
• Song Offset
• Pre-Roll time
FTP Server

❏

• Choose to allow FTP client
• Set IP Address, Subnet, and Gateway
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Installation and Connection of
Optional I/O and Effects Cards
The Input/Output cards are an essential part
of the D8B multitrack system. These cards
provided up to 24 tape outputs and inputs for use
with any common analog and digital formats.
Since the I/O cards are optional and interchangeable, you probably need to install them before you
begin creating hit recordings. If you install multiple
types of I/O cards, note which slots they’re installed
in. Making a note of each I/O card type and its exact
slot will help avoid subsequent problems.
There are several optional cards available for
the Digital 8•Bus which you can install into the
card cage in the rear panel of the console. These
cards provide additional inputs and outputs for
specific applications, or additional digital signal
processing power for effects.

AIO•8 (Analog Hookup)
This card provides 8 analog line-level inputs
and outputs. Connections are made through two
25-pin D-Sub connectors. You can install this card
in any of the Tape In/Out slots, or in the ALT I/O
slot.

DIO•8 (Digital Hookup)
This card provides 8 digital inputs and 8 digital
outputs. Connections are provided in both ADAT
Multichannel Optical Interface and Tascam T/DIF-1
formats. You can install this card in any of the Tape
In/Out slots, or in the ALT I/O slot. You can mix any
combination of the AIO•8 and DIO•8 cards in the
Tape I/O slots to suit your particular application. You
can configure the card in the GUI (Setup>Digital I/O)
and select the I/O connector you wish to use.

OPT•8 Card (ADAT Optical)
The inexpensive ADAT optical card functions
with any device incorporating the ADAT format
digital optical lightpipe. The OPT•8 card configures
itself automatically; it doesn’t need to be adjusted
in the Setup>Digital I/O window. Lightpipe connections between the D8B and the connected record/
playback device are clean and efficient.

PDI•8 Card (AES/EBU)
This card provides 8 digital inputs and 8 digital
outputs in the AES/EBU standard format.
Connection is made through a 25-pin D-Sub
connector. You can install this card in any of the Tape
In/Out slots, or in the ALT I/O slot.
AES/EBU is a standard two-channel digital
protocol used for long balanced cable applications.
Thus, each conductor actually transmits two
channels of digital audio data.

MFX Effects Card
This card provides two additional DSP engines for running internal effects. The Digital
8•Bus is shipped with one MFX card installed in
Slot A. You can install up to three more MFX
cards in Slots B, C, and D.

UFX Effects Card
This card provides up to four additional DSP
engines for running internal effects. The UFX
architecture provides access to the newest and
coolest third-party plug-ins, as well as an array of
groovy new Mackie plug-ins. The D8B effects card
slots accommodate any combination of UFX and
MFX cards.

Connections for ADAT
The connection for ADAT is made with a fiber
optic cable, sometimes referred to as “lightpipe.”
This connection provides 8 channels of digital audio.
You can purchase this cable from your Alesis dealer,
Monster Cable, Hosa, or other cable manufacturer.

Connections for DA-88
The connection for T/DIF-1 is made with a 25-pin
D-Sub connector. This connection provides 8 channels
of bidirectional digital audio. This connection requires
a 25-pin D-sub cable (Tascam Part Number PW-88D).

D8B Manual • Chapter 4 • page 91

Installation of FX Cards
IMPORTANT: Shut off power to the
Digital 8•Bus’ Remote CPU before
installing or removing cards. Also,
install your FX cards in order. For
example, put your first FX card in the
slot marked “A,” your second FX card
in slot “B,” etc.

1. Loosen the four spring-loaded screws on the blank
cover plate to the FX card slot you want to fill.

FX Card Cover Plate Removal

2. With your finger in the hole on the FX card (and
the components on the circuit board facing to the
left), push the card firmly into the white connector
slots so it fits snugly. Do not touch any of the
circuit board components or solder joints.

3. Replace the cover plate and tighten the screws
securely using a slotted screwdriver. DO NOT
OVERTIGHTEN THE SCREWS, or you run the
risk of stripping the threads in the D8B.
FX Card Installation
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Installation of I/O Cards
IMPORTANT: Shut off power to the
Digital 8•Bus’ Remote CPU before
installing or removing cards.

1. Using a #2 Philips screwdriver, unscrew the blank
cover plate corresponding to the I/O card slot you
want to fill.

Remove Cover Plate for Tape I/O Card

2. Holding the I/O card so that the components on
the green circuit board face to the left (see
diagram), line up the card so the top and bottom
edges fit into the white guide slots. Do not touch
any of the circuit board components or solder joints.
3. Be sure to push the card in all the way—until the
front of the I/O card is flush with the back panel of
the D8B. This may require a good, solid push, so
don’t be shy.

Installing a Tape I/O Card

4. Tighten the spring-loaded screws on the
I/O card securely using a slotted screwdriver. DO
NOT OVERTIGHTEN THE SCREWS, or you run
the risk of stripping the threads in the D8B.

Tighten Screws on Tape I/O Card
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Checklist for Basic
Operational Functionality

Connecting Analog Multitrack(s)

Basic system functionality depends greatly on
the accurate selection of a few key items. Work
through this checklist to verify console settings.
The previous chapters provide an explanation of
each item. This checklist simply provides a mental
road map to verify proper functionality.

❏
❏

Control Room selection correct
Monitor Speaker selection correct

Mic/DI
Line/Instrument

❏ Install DIO•8 or OPT•8 card into one or more of
the D8B TAPE CARD slots.

EQ
Compression
Gate
Busing/Routing

❏ Using a fiber-optic lightpipe cable, connect the
D8B Optical output to the ADAT Digital input connector.

Signal Routing

❏
❏
❏

❏ Using the appropriate cable, connect the multitrack outputs to the 25-pin D-sub TAPE INPUT
connector.

Connecting ADAT (Lightpipe)
Multitrack(s)

The Fat Channel

❏
❏
❏
❏

❏ Using the appropriate cable, connect 25-pin D-sub
TAPE OUT connector to the multitrack inputs.

❏ Make sure all connections are tightly secured.

Input source

❏
❏

❏ Install AIO•8 card(s) into one or more of the D8B
TAPE CARD slots. This provides up to 32 tracks of
I/O (including the ALT I/O card).

❏ Using a fiber-optic lightpipe cable, connect the
ADAT Digital output connector to the D8B optical
input.

To L/R
To Tape
To Bus

❏ If the D8B is to be the slave, the sync source
should be connected to the sync card BNC Word
Clock input.

Connecting the
Analog Multitrack

Connecting ADAT Lightpipe

Simply connect the AIO•8 outputs to an analog
console’s inputs for up to 32 channels (8 channels
per card) of flexible and assignable audio routing,
(including the ALT I/O).

Using two fiber-optic lightpipe cables, simply
connect the DIO•8 digital outputs the ADAT
lightpipe inputs, and the ADAT outputs to the
DIO•8 inputs, for up to 32 tracks (8 channels per
card) of flexible and assignable digital audio
(including the ALT I/O).

AIO•8 Card
ANALOG I/O

APOGEE
DIGITAL I/O

8-track ADAT

TDIF

OUTPUT

DIO•8 Card
INPUTS

OUT

Analog
Multitrack

ADAT OPTICAL

IN

OUTPUTS

ADAT OPTICAL

INPUT

rear panel

SYNC

IN
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Fiber-optic
Lightpipe

OUT

Connecting TASCAM (TDIF)
Multitrack(s)
❏ Install DIO•8 card into one or more of the D8B
TAPE card slots.
❏ Using a 25-pin D-sub digital cable (TDIF), connect
the D8B Digital I/O connector to the TASCAM
MDM (e.g., DA-88) Digital I/O connector.
❏ Install BNC clock cable and make sure all connections are tightly secured.
❏ If the D8B is to be the slave, the sync source
should be connected to the sync card BNC Word
Clock input and the D8B Apogee Clock should be
set to External in the Setup>Digital I/O window.

Connecting TDIF Digital
Use a 25-pin D-sub digital cable (TDIF) to connect
the D8B Digital I/O connector to the TASCAM
MDM (e.g., DA-88) Digital I/O connector, for up
to 32 tracks (8 channels per card) of flexible and
assignable digital audio, including the ALT I/O.
In addition, connect the Sync output from the
DIO•8 card to the Word Sync input of the DA-88.
This connection indicates use of a DIO•8 Card
with firmware version 127v2.
DIO•8 Card

Sync Cable

TDIF

APOGEE
DIGITAL I/O

Tascam
DA-98 rear panel
REMOTE INSYNC IN
(FROM RC848/DA-88)

SYNC OUT
(TO DA-88)

WORD SYNC

DIGITAL I/O
TDIF - 1

IN

OUT

OUT

SYNC

ADAT OPTICAL

IN
METER UNIT

TDIF Interconnect Cable
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Multitrack Recording
Multitrack recording involves a continuous
assessment of signal flow. If you follow a wellplanned thought process from the beginning of the
signal path to the end, you’ll succeed in each
audio task.
When multitrack recording using the D8B, it’s
helpful to visualize the basic signal flow between
fader banks. For any multitrack setup, it’s important to keep track of the signal path from the
console to the multitrack, then from the multitrack back into the console. The illustration below
is a review demonstrating an important signal
flow concept.

❏ Press Mic button on channels using microphone
inputs.
MIC

❏ Configure Auxes for desired Pre/Post status, select Surround Mode, set Mix Options.

❏ Test each instrument and mic to verify sufficient
level at console input meter.

MIC/LINE Bank

TAPE IN Bank

1
OL
2
4
7
10
15
20
25
30
40
50
60

Work your way though this checklist for
multitrack recording.

❏ Connect multitrack ins and outs to D8B.
❏ Follow basic power-up procedure.
❏ Select Mic/Line fader bank.

25

❏ Adjust input trim for a reading around –15 on the
meter.
TRIM

MASTERS

SHIFT

1-24

25-48

LINE
MIC

0

-20dB

MIC/LINE

TAPE IN

(TRACK)

(MONITOR)

60
+40dB

1

49-72

EFFECTS
BANK SELECT

❏ Press phantom power button on the rear of the
console for necessary mic inputs. .
12
+48V
PH

MIC

❏ Select L/R in the ASSIGNMENT section to confirm
Assign lights on for all desired channels, or look
on-screen to verify that all necessary channels
have L/R button highlighted in Bus Assign section.

11

ASSIGNMENT

+48V
PH

MIC

ASSIGN

BUS 2
ASSIGN
BUS 7

LINE IN

INSERT

LINE IN

INSERT

Note: Condenser mics and active DIs use phantom
power. Moving coil mics, ribbon mics, and most
electronic instruments don’t need phantom power.
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REC/RDY

REC/RDY

ASSIGN

ASSIGN

WRITE

WRITE

ASSIGN

BUS 8

ASSIGN

ASSIGN

L-R

ROUTE TO
TAPE

Multitrack Tracking Checklist
❏
❏
❏
❏
❏
❏
❏
❏
❏

❏
❏
❏
❏

Connect multitrack ins and outs to D8B.
Follow basic power-up procedure.
Select Mic/Line fader bank.
Press phantom power button on the rear of
the console for necessary mic inputs.
Press Mic button on channels using
microphone inputs.
Set pre-fader auxes in Setup Window for
monitor use.
Test each instrument and mic to verify
sufficient level at console input meter.
Adjust input trim for a reading around –15 on
the meter.
Press L/R in the ASSIGNMENT section to
confirm Assign lights on for all desired
channels. Or, look onscreen to verify all
necessary channels have L/R button
highlighted in Bus Assign section.
Set Master Fader to Unity position.
Turn channel faders up to hear instrument
or mic.
As each channel is verified and audible, press
channel mute.
Assign Fader Bank 1 channels to desired
tape track inputs.

❏ Set Master Fader to Unity position.

❏ Place tape inputs in
record/ready to verify
FAST
TRACK
signal at machine. It’s
typically best to monitor
signal from the multitrack rather than from
the channel input.
❏ If levels on the multitrack appear too hot or
cold, adjust level with the LEVEL TO TAPE
control. Select TRACKING LEVEL. This sets
the channel V-Pots to adjust the D8B output
level to tape.
❏ Remove Fader Bank 1 from the L/R mix.
❏ Adjust control room monitor mix from Tape
return in Fader Bank 2.
❏ Set levels in headphone system for
musicians.
❏ Adjust headphone monitor volume in the
PHONES/CUE MIX section.
❏ Adjust channel aux levels to onboard or
outboard effects from Fader Bank 2.
❏ Verify that Master Output is connected to
the mixdown machine.
❏ Record a pass on the multitrack.
❏ Play multitrack back.

❏ Once each channel is verified and audible, press
channel mute.

MASTER
L/R

dB

10

SELECT

SELECT

SELECT

SOLO

SOLO

SOLO

MUTE

MUTE

MUTE

BUS 5

BUS 6

BUS 7

RET 5

RET 6

RET 7

21
45

22
46

23
47

5

U

5

10

20

30

40
50
60
dB

❏ Turn channel faders up to hear instrument or mic.

dB

dB

10

10

10

5

5

5

U

U

U

5

5

5

10

10

10

20

20

20

30

30

30

40

40

40

50

50

50

60

60

60

GROUP 1
FX 1

1
25
dB

10

5

U

5

10

20

30

40
50
60
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❏ Assign MIC/LINE bank channels to desired tape
tracks.

❏ If you want to monitor from the multitrack,
remove the MIC/LINE Bank from the L/R mix.
This has no effect on the output to tape.

❏ Adjust control room monitor mix from TAPE IN
Bank. Verify channel assignment to the L/R bus.
❏ Place tape inputs in record/ready to verify signal
at machine.
It’s typically best to monitor signal from the
multitrack rather than from the channel input.
M o d u l a r D i g i t a l M u l t i t ra c k

Record Ready Buttons

TAPE IN Bank

❏ If levels on the multitrack appear too hot or cold,
adjust level with the LEVEL TO TAPE control.
Select TRACKING LEVEL. This sets the channel
V-Pots to adjust the D8B output level to tape.
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❏ Set levels in headphone system for musicians.
Aux 9/10 and 11/12 are perfect for stereo
headphone sends. It’s often convenient for the
musicians to, at first, monitor the L/R mix in the cue
section (PHONES/CUE MIX 1 and 2). Once the initial
L/R mix is established, copy it to the appropriate
cue, then customize for individual monitoring needs.

❏ Adjust headphone monitor volume in the
PHONES/CUE MIX section.
PHONES/CUE MIX 1

PHONES/CUE MIX 2

AUX 9-10

COPY MIX TO CUE

AUX 9-10

COPY MIX TO CUE

AUX 11-12

CONTROL ROOM

AUX 11-12

CONTROL ROOM

LEVEL

LEVEL

❏ Adjust channel aux levels to onboard or outboard
effects from Fader Bank 2 (TAPE IN).

❏ Verify that Master Output is connected to the
mixdown machine.
The mix should be arriving at the mixdown
recorder. It’s good to check this as part of your
tracking process. At the conclusion of a session the
artist will probably want to take a rough mix for
evaluation—you’ll look better if it’s already set to go.
BUS OUT 1-8
&
SURROUND OUT

MASTER OUT
L R

CR
MAIN
L R

L

CR
NEAR FIELD
L R

R

MASTER OUT

❏ Record a pass on the multitrack
Play multitrack back—playback should sound
identical to tracking and you’re ready to print a
rough mix.
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Sample Tracking Setup
This diagram shows a typical hookup for tracking.
Four microphones are connected to channels 1–4 for
vocals. Two of them are condenser mics, which
require phantom power, so the +48V PH switch is
pushed in on those channels. A vocal enhancer is
connected to the channel 1 INSERT jack to add a
special effect to the lead vocal.
Note: During tracking, dynamics control, like
compression and limiting, are often included (insert or
onboard) at the beginning of a signal path. Effects, like
reverb, delay, and chorus are best left for adjustment
during mixdown, or during tracking for monitor use
only.
Various instruments are connected to the line inputs
of channels 11–14, either directly from their line-level
outputs or through effects boxes or direct boxes.
Each input from channels 1–24 is assigned to a
tape output, which can be connected to an 8-, 16-, or
24-track recorder—simply use the appropriate I/O
card for your setup. You can assign any input (1–48),
any return (FX 1–16, RET 1–8), and Bus 1–8 to any
unused tape out using the ROUTE TO TAPE button
in the Bus Assignment Section (refer to Chapter 2
for review).

D8B Manual • Chapter 4 • page 100

Monitoring
Connect the outputs from the recorders to the
TAPE Inputs on the Digital 8•Bus. This allows you
to monitor the signal as it’s being recorded
(assuming your recorder has that capability).
To do this:
• Assign channels 25–48 (or whatever channels are
being used for tape returns) to the L-R bus.
• In the Control Room Section, assign MASTER
L-R as the Control Room Source.
The configuration shown has two external effects
devices connected for monitoring. Aux 8 send goes
to a digital reverb, which has stereo outputs that
feed into the line inputs of channels 19 and 20.
Aux 11–12 goes out to a multi-effects stereo
processor, which then comes back to the Digital
8•Bus through the line inputs of channels 23 and 24.
In addition, Aux 1 and 2 are routed to the internal
FX Card, which processes the signal with whatever
plug-in has been downloaded to it. The processed
signal is returned to the L-R bus via the FX 1–4
channel strips in Fader Bank 3.
The signal at the CR MAIN, CR NEAR FIELD,
and the STUDIO OUT is determined by the Control
Room Source selection in the Control Room Section.
You can connect a pair of headphones to the
PHONES 1 or 2 jack and monitor the signal there as
well. Select CONTROL ROOM as the source in the
PHONES/CUE MIX 1 or 2 Section.

ANALOG
I/O

ANALOG
I/O

ANALOG
I/O

MASTER OUT

21

2 TRACK C

CR
NEAR FIELD

Powered near-field
monitor speakers

2 TRACK B

2 TRACK A

22

CR
MAIN

MASTER
OUT

23

24

15

LINE IN

16

19

13

PNCH I/0 TLKBK

STUDIO OUT

PHNS 1 PHNS 2

20

14

LINE IN

INSERT

LINE IN

INSERT

LINE IN

INSERT

AUX 12

AUX 11

AUX 10

10

11

12

Stereo Effects
Procesor

R

L

BUS OUT 1-8
&
SURROUND OUT

17

18

Direct Box

AUX 9

INSERT

LINE IN

9

INSERT

LINE IN

8

AUX 8

Reverb

Digital 8•Bus Analog Recording/Tracking Hookup Example

Optional
AIO•8
Cards

TO TAPE

FROM TAPE

TO TAPE
FROM TAPE

TO TAPE
FROM TAPE

2-inch
24 track

Sync Interface

MIDI IN/OUT
(Rear of Remote CPU)

INSERT

INSERT

AUX 5

INSERT

LINE IN

5

Internal
Digital Audio
Signal Path

AUX 6

LINE IN

LINE IN

AUX 7

6

7

AUX 4

INSERT

LINE IN

4

LINE IN

INSERT

LINE IN

INSERT

AUX 3

AUX 1

INSERT

LINE IN

1

FX Card 1

AUX 2

2

3

Vocal Enhancer
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To FX Return
3 and 4
(Fader
Bank 3)

To FX Return
1 and 2
(Fader
Bank 3)

digital control signal

internal digital send

internal digital return

audio out

audio in

Mixdown Setup
This simple checklist will help get the mix started.
Notice that, each time, we follow the signal path
from its source to its destination.

❏ Be sure the multitrack recorder is connected
properly to the Tape In card(s).
❏ Roll tape to verify signal at TAPE IN Fader Bank.
❏ If any track reads excessively hot or cold on the
D8B meter bridge, adjust the Digital Trim for a
reading around -15 with no peaks (OL).
Pressing DIGITAL TRIM activates the channel
V-Pots as digital input trim adjustments.

❏ Select Master L/R in the Control Room section
and adjust the speaker level to a moderately conservative level (about 9:00).
CONTROL ROOM

2 TRACK A

DIGITAL IN 1

2 TRACK B

DIGITAL IN 2

2 TRACK C

MASTER
L-R

MONO

NEAR FIELD

MAIN

SPEAKERS

SPEAKER LEVEL

❏ It’s often recommended that you monitor from
the output of the mixdown recorder.
If the outputs from the mixdown recorder are
patched into the D8B 2-track or Digital inputs,
simply select the mixdown recorder in the Control
Room Section (Digital 1, Digital 2, 2 Tracks A–C).

❏ Adjust the channel faders, dynamics, pan, effects,
and EQ for an excellent mix.
Digital clipping could occur if a signal going
into the D8B is too hot. Noise could occur if the
signal is too low. Even though the D8B has plenty
of headroom and very little noise, it’s still a good
idea to verify optimum levels.

❏ With channel faders off, set the Master Fader at
Unity.
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❏ Record the mix and enjoy the mind-boggling
capabilities of the Mackie Digital 8•Bus.

Optional AIO•8 Cards
ANALOG
I/O

ANALOG
I/O

TO TAPE
FROM TAPE

ANALOG
I/O

TO TAPE
FROM TAPE

R

L

MASTER OUT

BUS OUT 1-8
&
SURROUND OUT

23

24
21

2 TRACK C

CR
NEAR FIELD

Control Room Monitors

Near-field Powered
Monitors

2 TRACK B

2 TRACK A

22

15

LINE IN

16

CR
MAIN

MASTER
OUT

2-Track Recorder

17

18

Digital 8•Bus Analog Recording/Mixdown Hookup Example

Digital I/O
AES/EBU

OUT

IN

2-inch
24 track

TO TAPE
FROM TAPE

2-Track DAT

MIDI I/O
(rear of D8B
Remote CPU)

Sync Interface

Out

In

19

13

PNCH I/0 TLKBK

STUDIO OUT

PHNS 1 PHNS 2

20

14

Stereo
Reverb

AUX 11

INSERT

INSERT

AUX 12

LINE IN

11

LINE IN

12

INSERT

LINE IN

9

AUX 10

AUX 9

8

AUX 8

INSERT

LINE IN

Digital Delay

INSERT

LINE IN

10

AUX 7

INSERT

LINE IN

7

AUX 6

INSERT

LINE IN

6

AUX 5

INSERT

LINE IN

5

INSERT

LINE IN

3

INSERT

LINE IN

2

AUX 4

AUX 3

AUX 2

1

INSERT

LINE IN

AUX 1

digital control signal

audio out

audio in

INSERT

LINE IN

4

Sample Mixdown Setup

This sample mixdown setup helps provide ideas for how your mixdown setup might look. Each setup is
unique in many ways, yet predictable in many ways.
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Effects/Plug-ins
MFX/UFX
Before we look at more setup
examples, lets cover some quick tips on
efficient use of the Digital 8•Bus plugins. Follow these easy steps to use the
Digital 8•Bus internal plug-ins.

Note: In the plug-in windows, clicking directly on the
Effects patch name displays a large pop-up menu of
Factory or User patch names, which points to available
patches in your working directory’s Presets folder.
Always save your custom presets to the User Presets
folder. Presets saved to the Factory Presets folder could
be written over by future plug-in updates. It is still
possible to use the up/down arrows to scroll through
the patch names.

1. Open the Plugin Configuration
window (click Plugins in the upper menu
bar and select Plugins, or Crtl+P) and
select the Mode (Stereo/Mono), Plugin,
and Input that suits your needs for each
available slot.
5. Click on the AUX button in the V-Pot
Select Section that corresponds to the plugin you
want to use.

2. Click the red 1/4" connector on
the lower menu bar to reveal the plug-in
selector buttons.
3. Select the plug-in you want to
adjust by clicking on its button.
4. Plug-ins are organized in the
order of the aux buses they correspond to.
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6. Use the channel V-Pots to set individual
channel send to the selected aux bus.

Note: Alternately, you can click and drag on the
horizontal bar in the auxes section at the top of the
channel strip to adjust the aux send level.

7. Click and drag on the Master V-Pot to adjust the
overall aux send level to the selected effect. You
can click on the SOLO button in the Master
V-Pot Section to monitor the aux send signal.

8. Click on the EFFECTS button to select Fader
Bank 3. Click and drag, or physically move, the
FX return fader(s) corresponding to the selected
effect, to control the amount of processed signal
returning to the left and right bus.

Note: Currently the D8B OS doesn’t store effects or
any DSP module names. If you create some effects
that you really like, we suggest that you name them
and store them to disk. For ease of retrieval and
organization, create a dedicated effects folder and keep
all your working effects patches there.
Don’t forget to use the EQ portion of the effects
module during patch creation. It certainly can
enhance the sound of any given patch.

Setting Up Plug-ins
• Press Ctrl+P on the keyboard (or click
Plugins in the upper menu bar and select
Plugins) to open the Plugins Configuration
window.
• Adjust aux send levels from any applicable
bank channels.

Note: The default setting for each Aux Master level is
0.0 dB. This typically provides sufficient send level and
doesn’t usually require adjustment.

• For MFX Plug-ins, each card utilizes two
separate mono sends, which are monitored as
two separate stereo returns from the MFX
plug-in.
• UFX Plug-ins reside in groups of four on each
card (2 stereo, 4 mono, or 1 stereo and 2
mono).
• Select the EFFECTS bank to adjust effects
return levels at the appropriate faders.
• Pan effects returns left and right in pairs.
• Listen to playback.
• When tracking, it’s best to monitor the tape
returns.

Note: See the Plug-ins Manuals for specifics on
individual plug-in functionality.
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Dynamics and EQ Applications
Dynamics and equalization are typically applied in
one of three ways:

1. Processing Dynamics and EQ Before Tape
• Select Fader Bank 1 (MIC/LINE).
• Double-click SELECT on the desired channel
to open the on-screen Fat Channel.
• Set compression, EQ, or gate.

Since Fader Bank 1 (MIC/LINE) feeds the
multitrack inputs, any changes made from that bank
are printed to tape.

2. Processing Dynamics and EQ After Tape
• Choose Fader Bank 2 (TAPE IN).
• Double-click SELECT button on the desired
channel to open the on-screen Fat Channel.
• Adjust compression, EQ, or gate.

Since TAPE IN Bank receives its feed from the
multitrack, Fat Channel changes made here don’t
affect what is printed to tape.

3. Analog inserts
• Using an insert cable, connect the channel
send to the input of an external EQ or
dynamics processor.
• Connect the insert cable return side to the
external device output.

All channel level adjustments past the insert are
dependent on the external device control settings,
since the entire channel signal passes through the
device.
Dynamic and EQ control should occur only once in
any given signal path. Avoid subjecting any signal
path to multiple stages of dynamics or EQ
processing. As a rule, fewer circuits almost always
result in more pristine and accurate audio—even
though the D8B signal path is incredibly accurate
and transparent.
Many engineers prefer to save all EQ for
mixdown, so as to include the least audio
manipulation for a more pure sound. Many recordists
rough the sound in when recording, using whatever
EQ and dynamics they feel the sound needs, then
they perfect the audio during mixdown. Many
excellent recordings have been the result of these
techniques and more. Experiment, and let your ears
determine what works best for you.

D8B Manual • Chapter 4 • page 106

MIDI and the D8B
MIDI Basics
Your Digital 8•Bus works very well when
incorporated in a MIDI network, utilizing a computer
referenced to time code.
Be sure to connect the D8B MIDI jacks to your
MIDI interface. Within your computer-based MIDI
sequencer, set the MIDI channel connected to the
D8B to transmit MIDI Time Code (MTC). This is
necessary to run automation from a Digital Audio
Workstation (DAW).

MIDI
OUT

BRC
MIDI

SYNC
SYNC

Digital 8•Bus

Modular Digital Multitrack

Modular Digital Multitrack

MIDI
IN

MIDI Interface

When you don’t include a computer in your setup,
you need a device like the Alesis BRC to transmit
MTC to the D8B for time reference when performing
dynamic and snapshot automation.

The Digital 8•Bus provides control over some key
MIDI parameters. These parameters affect your
system’s ease of use and efficiency, and should be
verified:
• MMC DEVICE ID: Some 8-track digital recorders
require that you define the device ID numbers
used for each recorder in the MIDI Machine
Controller. Typically, tracks 1–8 are device 0,
tracks 9–16 are device 1, and tracks 17–24 are
device 2, so these are the default settings.
• ONE BUTTON PUNCH: You can also select
whether to press the PLAY and RECORD buttons
to enter record mode, or just press the RECORD
button (One Button Punch).
Note: We recommend leaving One Button Punch off to
provide an extra measure of safety in case you
inadvertently press the RECORD button in the
Transport Section.
• MTC OFFSET: MIDI File Offset can be used to
indicate the starting time deviation of a Standard
MIDI File (SMF), referenced to absolute time code.
• TEMPO MAP: If you use a sequencer in your
recording process, you can create a standard
MIDI file from the song(s) you’ve recorded. Copy
the tempo map from the SMF to the Digital 8•Bus
and “synchronize” the D8B display to the
Bars:Beats:Ticks of the sequenced program.
SMFs are loaded from the floppy disk drive.
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MIDI Snapshots
Once you’ve developed several snapshots for a
mix, they can be recorded into a sequencer for
consistent playback.
This feature is set in the Mix Options window,
under Setup in the lower menu bar. When enabled:
1) Incoming MIDI program changes (received on
any MIDI channel) can recall Snapshots numbered
0–127 on the console.
2) The D8B sends MIDI Program changes on
MIDI channel 1 when snapshots are recalled on the
console, either via the dynamic automation snapshot
track or by manually recalling a snapshot from either
the snapshot window or via the front panel.

3) Place the sequencer in record on the D8B MIDI
channel and cable. While the mix plays, select
snapshots at the appropriate time. Each snapshot
change is stored as data in the sequence and
therefore can be shifted, cut, copied, pasted, etc.
See “The Snapshot Window” on page 69 for
information on how to set the program change
MIDI channel.
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Word Clock and the D8B —
The Kitchen Sync
In order for all digital components to function
together in unity, they must all move together,
sample-by-sample, through the digital data stream.
Word clock is an incredibly important part of
digital recording! The concept is simple: If multiple
devices are synchronized together via word clock,
they progress together through the digital data
stream, one sample at a time. This is called sampleaccurate sync.
Each system works in reference to one master
device. Forty-eight thousand times a second (or
whatever the common sample rate is) digital slaves
keep track of the word clock status of the master
device; they only output the next sample when the
master device outputs the next sample.
This type of system provides very accurate
synchronization. Incorporating a time reference, like
MTC, along with sample accurate sync enables time
stamping of data changes, like start-stop time,
snapshot placements, real-time automation data, etc.
Hence, ultimately flexible and way cool automation
capabilities of virtually every control on the Digital
8•Bus! Yahoo!
The optional Clock I/O card for your Digital 8•Bus
provides a means to send and receive digital word clock.
This card is necessary:
• When digitally combining the Digital 8•Bus with a
computer-based DAW, MDMs, video recorders, etc.
• When the D8B must send or receive word clock
other than through ADAT lightpipe or AES/EBU
connections.
Sync data can transmit directly through ADAT
Lightpipe and AES/EBU connections. However, a
complete sync system needs two main ingredients:
• Word clock, sample-accurate sync. This is
provided through the Digital 8•Bus optical or
AES/EBU connections, and through the optional
Clock I/O card.
• Time reference to stamp automation data for
accurate playback. This is typically provided
through MIDI Time Code (MTC).

Word Clock
INPUT

Word Clock
OUTPUT

Word Clock
OUTPUT

9-pin
OUT

9-pin
IN

PCI-324
9-pin IN

9-pin
OUT

Computer

MIDI MIDI
IN
OUT

Control
Track IN

MIDI MIDI
IN
OUT

Control
Track 1

DTP

Word Clock
INPUT

Word Clock
INPUT

Word Clock
OUTPUT

From PCI 324

Word Clock
INPUT

MIDI MIDI
IN
OUT

Digital 8•Bus
Master Word Clock
Out From D8B

Computer

Every digital system needs a master sync source.
The D8B prefers to be the master source but will
function as a master or slave. Follow these simple
steps to help assure a successful digital setup:
• Determine which piece of gear is the master. The
master must be able to generate proper word
clock that can be read by all other digital equipment.
• Set all digital equipment to the exact same word
clock rate—typically 44.1 or 48kHz.
• Connect the word clock output from the master
device to the word clock input of the slave
devices. Each digital device connected to the
digital audio chain must receive a common word
clock source, either directly or from a slave.
• It is common procedure to chain word clock
through digital devices. The D8B can provide
master word clock to a central word clock hub,
then the hub can send to multiple digital slaves
(DAWs, MDMs, digital effects, etc.).
• Set every slave device to respond to external
word clock.
• Draw a digital word clock flow chart for your
system. This will help you verify a logical
connection scheme. One piece of equipment
connected incorrectly can mess up your entire
system. Rats!
The following illustration shows a common sync
setup, using the Digital 8•Bus as the master word
clock source and a hub to distribute to other digitally
connected devices.

Here are two more sample setups that include the
D8B and other digital devices which depend on
accurate and solid word sync.

MIDI MIDI
IN
OUT

Proper Sync Connection

PCI 324
card output

Sync Hub
2408

Word Clock
OUTPUT

M o d u l a r D i g i t a l M u l t i t ra c k

Use expensive, properly impedance-matched
cabling! It’s worth it!
M o d u l a r D i g i t a l M u l t i t ra c k

Note: When using the D8B as the master sync source,
always power it up before other digitally connected
gear. You’ll have a much better day.
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Verifying Word Clock Sync Between Devices
and the Digital 8•Bus
• When the D8B is set to “Internal” in the Apogee
Clock pop-up window, it generates word clock as
a master device. All other devices must be
connected as slaves.
• If the D8B is slaved properly to a master word
clock source, “Locked.” is displayed in the
Setup>Digital I/O window next to the Apogee
Clock pop-up window and an asterisk (*) flashes in
the right-most portion of the control surface VFD.

You probably have a bad word clock sync
connection if:
• You hear audio but it cuts in and out at regular
intervals.
• There is no audio signal at the input of the D8B
even though everything seems to be connected
properly.
• All meters are full on and you hear a very ugly
grating, grinding, static sound.
• When the record/playback device transport is
engaged, you see a question mark flashing in the
right-most portion of the control surface VFD.

Troubleshooting Word Clock Problems

• If the D8B is improperly connected as a slave to
the digital network, “Lock Error.” is displayed in
the Setup>Digital I/O window next to the Apogee
Clock pop-up window and a question mark (?)
flashes in the right-most portion of the control
surface VFD.
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• Troubleshoot through the system from the master
through the slaves. Connect the first two devices
and verify their functionality. Once they’re up and
running, add the next device, and so on. This is
the most efficient manner to check out a system.
• Verify connection, integrity, and quality of all sync
cables.
• Verify a consistent sample rate setting on all
connected sync devices (all set to the same
sample rate—44.1, 48k, etc.)
• Verify that the master sync source word clock
output is connected to the word clock input of the
slave, and that additional slaves also receive word
clock. Slaves can either receive word clock
directly from the master device or daisy-chained
through connected slaves. Patch word clock out of
a connected slave into the word clock input of any
other slave.
• Verify that the master device word clock status is
set to INTERNAL.
• Verify that all slave devices are set to follow
EXTERNAL word clock.
• If the system doesn’t seem to work correctly, you
might have an intermittent or broken sync cable.
Always use high-quality 75Ω BNC word clock
cables.

Dither - To UV22 or Not to UV22:
That Is the Question
Digital audio’s weakness is its ability to accurately
reproduce extremely low-level signals. As the
amplitude decreases, there are fewer and fewer
bits available to accurately represent the audio wave.
In an analog system the audio simply sinks into
the noise floor. Even when covered by noise, the
waveform is still audibly intact. In a digital system,
low level audio simply becomes inaccurate and
sounds really bad. A few bits at the bottom of the
amplitude range aren’t capable of faithfully
converting the analog information to digital, let alone
reinterpreting the digital data into analog variations
in air pressure.
Dither is a low-level noise that combines with
your pristine audio at low levels to help keep enough
digital bits active to replicate an accurate waveform
throughout the conversion process from digital to
analog to digital—go figure that it takes noise to
make a system work that has no noise.
UV22 is a very good-sounding type of dither that
makes a way for more accurate reconstruction of
this low-level audio. The frequency of the UV22
dither noise is lower than the conventional process
and therefore provides a more transparent
reconstruction.
As a practical application, if your music is to be
mastered by someone else in a professional
mastering facility, you might not need to use the
UV22 process—too much dither can accumulate too
much noise. If you’re seeing the project through to
the end you have three primary options:
• Don’t dither. If your music is always loud—loud,
loud, loud—you might not need to worry about
dither because dither really only helps audio
quality at low levels. However, if there is a fade
out in your song, then of course everything isn’t
always loud and you’ll want to take advantage of
the UV22 process to feather the fade out with
excellent audio clarity.
• Dither once. The conventional approach has been
to avoid dithering until the final version is
mastered (prepared for duplication). In this case,
wait until the final mix is printed to the replication
master, then use a Normal UV22 setting on the
Stereo I/O in the Setup window. Dither only once
on Normal setting; dither noise is cumulative so
too much dither equates to senseless noise.

• Dither twice. If your music contains a wide
dynamic range, you might not be able to resist the
urge to use dither as you record to the multitrack.
In this case, plan to use the UV22 process twice:
use it once on the multitrack tracks—on the
“Low” setting; use it again on the final printing of
the master take—on the “Low” setting. If you use
the UV22 process twice, using it on Low setting
both times will closely equate to the dither noise
resulting from using it once in “Normal” position.

If your music contains only a few low-level
passages try using the “Low” setting on the
Stereo I/O. “Low” equates to a lower level of noise
and, though it might not provide as much
smoothing of low-level audio, it might be quite
sufficient—and less noise just seems like a better
choice wherever appropriate.
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2. Connect three snakes between the
HDR24/96 Outputs (top connector)
and the corresponding D8B Tape
Inputs (bottom connector).

D8B–HDR24/96 Setup
Hookups
This section shows how the D8B is connected
to the Mackie HDR24/96. These examples assume
that the rest of your studio equipment (monitors,
sound sources, outboard processing, etc.) is
already connected.
Before you begin, note how the three eightchannel I/O cards are arranged on the HDR24/96
rear panel: 1-8 is on the left, 9-16 is in the center,
and 17-24 is on the right. Labeling cables before
you begin will make connecting the HDR24/96 to
your D8B easier.
The specific hookups for each D8B and
HDR24/96 I/O card are shown below.

HDR24/96 Settings
1. Set the Sample Clock to Internal.
2. Set the Sample Rate and Bit Depth
according to your preference. It is not
necessary to set the D8B and
HDR24/96 to the same Sample Rate
since, with analog connections, the
sample clocks on the two units are not
synchronized.

Console Settings

Analog Hookup to HDR24/96 (AIO•8)
This example describes the analog hookup for
the D8B–HDR24/96 combination.
Cables & Hardware

1. Set the D8B Sample Rate to 44.1kHz
or 48kHz, and set the Apogee Clock
to Internal (in the Digital I/O Setup
window).

(3) AIO•8 cards for HDR24/96
(3) AIO•8 cards for D8B
(6) DB25 to DB25 analog snakes

Hookup
1. Connect three snakes between the
HDR24/96 Inputs (bottom connector)
and the corresponding D8B Tape
Outputs (top connector).

This example describes the hookup for the D8B console equipped for analog I/O.
HDR 24/96

Digital 8•Bus
AIO•8 Cards
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OUTPUT
INPUT

OUTPUT
INPUT

TAPE IN/OUTS

OUTPUT

OUTPUT
INPUT

ANALOG I/O ANALOG I/O ANALOG I/O

OUTPUT

(6) DB25 to
DB25 Analog
Snakes

INPUT

Note: Some older
AIO•8 cards have the
Input jack labeled as
“From Tape” and the
Output jack labeled
as “To Tape.” Otherwise, they operate
identically. Sigh ...
long story.

INPUT

OUTPUT

ANALOG I/O ANALOG I/O ANALOG I/O

INPUT

AIO•8 Cards

TAPE IN/OUTS

DIO•8 Sync out) to the HDR24/96
Word Clock In. To make the HDR24/96
the clock master, connect its Word
Clock Out to the D8B Word Clock In.

TDIF Hookup to HDR24/96 (DIO•8)
Cables & Hardware
(3) DIO•8 cards for HDR24/96
(3) DIO•8 cards for D8B
(1) Clock I/O card for D8B
(3) TDIF cables
(1) 75 Ω BNC word clock cable

HDR24/96 Settings
1. Set the Tape Input format for each
DIO•8 card to TDIF, and the Tape
Output format to TDIF.

Hookup

2. If the HDR24/96 is the clock master,
set the Sample Clock to Internal; if it
is a clock slave, set it to Word Clock
and depress the 75 Ω termination
switch on the Sync card.

1. Connect the three TDIF cables
between the corresponding TDIF jacks
on the HDR24/96 and D8B.
2. When TDIF is used, the D8B must
have a Clock I/O card installed. To
make the D8B the clock master,
connect its Word Clock Out (not

3. Set the Sample Rate to 44.1kHz or
48kHz according to your preference.

TDIF Hookup with DIO•8
Apogee
Clock I/O
Card
APOGEE
SYNC

DIO•8 Cards
APOGEE
DIGITAL I/O

APOGEE
DIGITAL I/O

APOGEE
DIGITAL I/O

TDIF

TDIF

TDIF

TDIF Connection
Word
Clock
Out

Word
Clock Out

OUT
SYNC

IN

OUT
IN

ADAT OPTICAL

SYNC
TDIF

APOGEE
DIGITAL I/O

TDIF

OUT
IN
SYNC
TDIF

S

IN

OUT

TDIF Connection
DIO•8 Cards

SYNC

OUT

OUT

ADAT OPTICAL

IN
SYNC

Word
Clock In
Word
Clock Out

TDIF Cables
(DB25)

HDR 24/96

IN

Depress the
Termination
button if the
HDR24/96 is
set to Slave

Use
one
only

APOGEE
DIGITAL I/O

ADAT OPTICAL

NOT

APOGEE
DIGITAL I/O

SYNC

WARNING

HDR
Sync
Card

ADAT OPTICAL

Word
Clock Out
(HDR24/96
as Master)

Word
Clock
Out
(D8B as
Master)

Word
Clock
In

Word
Clock In

ADAT OPTICAL

ADAT OPTICAL

APOGEE

Digital 8•Bus

C
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Console Settings
1. Set the Tape Input and Tape Output
format for each DIO•8 card to TDIF.
2. If the D8B is the clock master, set the
Sample Rate to either 44.1kHz or
48kHz, and set the Apogee Clock to
Internal (in the Digital I/O Setup
window). If it is a clock slave, set the
Apogee Clock to Word Clock. Set the
Sample Rate to match the Sample
Rate selected on the HDR24/96.

ADAT Optical Hookup to HDR24/96
(DIO•8 or OPT•8)
Cables & Hardware
(3) DIO•8 or OPT•8 cards for HDR24/96
(3) DIO•8 or OPT•8 cards for D8B
(1) Clock I/O card for D8B
(6) ADAT Optical cables
(1) 75Ω BNC word clock cable

Hookup
1. Connect three ADAT Optical cables
from the HDR24/96 Optical Outputs to
the Optical Inputs on the
corresponding D8B I/O cards.
2. Connect three ADAT Optical cables
from the HDR24/96 Optical Inputs to
the Optical Outputs on the
corresponding D8B I/O cards.
3. When ADAT Optical is used, the D8B
must have a Clock I/O card installed.
To make the D8B the clock master,
connect its Word Clock Out to the
HDR24/96 Word Clock In. To make
the HDR24/96 the clock master,
connect its Word Clock Out to the D8B
Word Clock In.

HDR24/96 Settings
1. If you have DIO•8 cards installed, set
the Tape Input and Tape Output
format for each card to ADAT. OPT•8
cards need no configuration.
2. If the HDR24/96 is the clock master,
set the Sample Clock to Internal. If
the HDR24/96 is a clock slave, set the
Sample Clock to Word Clock and
depress the 75Ω termination button
on the Sync card.
3. Set the Sample Rate to 44.1kHz or
48kHz according to your preference.
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Console Settings
1. If you have DIO•8 cards installed, set
the Tape Input and Tape Output
format for each card to ADAT. OPT•8
cards need no configuration.
2. If the D8B is the clock master, set the
Sample Rate to either 44.1kHz or
48kHz, and set the Apogee Clock to
Internal (in the Digital I/O Setup
window). If it is a clock slave, then set
the Apogee Clock to Word Clock. Set
the Sample Rate to match the Sample
Rate selected on the HDR24/96.

ADAT Optical Hookup with OPT•8

OPT•8 Cards

Apogee
Clock I/O
Card
APOGEE
SYNC

Word
Clock
Out

Word
Clock Out

ADAT Optical Out

APOGEE

Digital•8 Bus
ADAT Optical In

Word
Clock Out
(HDR24/96
as Master)
WARNING
NOT

Depress the
Termination
button if the
HDR24/96 is set
to Slave

Word
Clock Out
(D8B as
Master)

Word
Clock
In

Word
Clock In

HDR
Sync
Card
ADAT Optical Out

Use
one
only

HDR 24/96

ADAT Optical In

Word
Clock In

OPT•8 Cards
Word
Clock Out

S

C
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HDR24/96 Settings

AES/EBU Hookup to HDR24/96 (PDI•8)

1. If the HDR24/96 is the clock master,
set the Sample Clock to Internal; if it
is a clock slave, set the Sample Clock
to Word Clock and depress the 75Ω
termination switch on the Sync card.

Cables & Hardware
(3) PDI•8 cards for HDR24/96
(3) PDI•8 cards for D8B
(1) Clock I/O card for D8B
(3) DB25 to DB25 AES/EBU snakes
(1) 75Ω BNC word clock cable

2. Set the Sample Rate to 44.1kHz or
48kHz according to your preference.

Hookup

Console Settings

1. Connect the three AES/EBU cables
between the corresponding AES/EBU
connectors on the HDR24/96 and D8B.

1. If the D8B is the clock master, set the
Sample Rate to either 44.1kHz or
48kHz, and set the Apogee Clock to
Internal (in the Digital I/O Setup
window). If it is a clock slave, then set
the Apogee Clock to Word Clock. Set
the Sample Rate to match the Sample
Rate selected on the HDR24/96.

2. When AES/EBU is used, the D8B
must have a Clock I/O card installed.
To make the D8B the clock master,
connect its Word Clock Out to the
HDR24/96 Word Clock In. To make
the HDR24/96 the master, connect its
Word Clock Out to the D8B Word
Clock In.

AES/EBU Hookup with PDI•8
PDI•8 I/O Cards

Apogee
Clock I/O
Card
APOGEE
SYNC

PDI•8

PDI•8

PDI•8

Word
Clock
Out

Word
Clock
Out

AES/EBU I/O

Word
Clock
In

Word
Clock In

AES/EBU I/O

APOGEE

AES/EBU I/O

Digital 8•Bus

AES/EBU
Cables
(DB25)

PDI•8

PDI•8

PDI•8

HDR 24/96

Use
one
only

AES/EBU I/O

NOT

HDR
Sync
Card

AES/EBU I/O

WARNING

Depress the
Termination
button if the
HDR24/96 is
set to Slave

Word
Clock Out
(D8B as
Master)

AES/EBU I/O

Word
Clock Out
(HDR24/96
as Master)

Word
Clock In
Word
Clock
Out
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PDI•8
I/O Cards

OK, so we fibbed a little. You can
use PDI•8 cards in the D8B
without a Clock I/O card
installed, but doing so requires
that you enable sample rate
conversion on both the D8B and
the HDR24/96 in lieu of word clock synchronization.
Sample rate conversion results in a 4-bit loss in
sample resolution that may degrade the quality of
the sound slightly. On the positive side, you don’t
need a Clock I/O card!

4. Set “Samplerate” to match the sample rate of
the formatted ADAT tapes (typically 48kHz or
44.1kHz).
ADATs
1. Select DIGITAL IN on the ADAT front panel.

Modular Digital Multitrack

Using the Digital 8•Bus with ADATs
This is a simple setup. It works well and is easy
to configure. However, it has some limitations.
Without a MTC sync source there’s no way for the
Digital 8•Bus to time-reference snapshot or dynamic
automation. As long as automation isn’t a
consideration, this setup is clean and efficient.

CLOCK
EXT
48K

Cabling and Hookup
1. Connect a fiber optic cable between the ADAT’s
lightpipe output and the D8B’s lightpipe input.
Likewise, connect the D8B’s lightpipe output to
the ADAT’s lightpipe input. (A DIO•8 or OPT•8
lightpipe card must be installed in the D8B to gain
access to the ADAT digital tape inputs and outputs.)
2. When using multiple ADATs, connect SYNC OUT
from the master ADAT to SYNC IN of the first
slave, then from SYNC OUT of the first slave to
SYNC IN of the second slave, and so on.

INPUT MON

INPUT
DIGITAL

INPUT SELECT
DIGITAL
INPUT

INPUT MONITOR
TRACK
COPY

ALL
INPUT

AUTO
INPUT

Settings
D8B
1. Open the Setup window.
2. Click on “Digital I/O” to open the Digital I/O
dialog box.

Note: When powering up, turn the Digital 8•Bus on
first, then turn the ADATs on.

3. Click on each Tape Input and Output box and
select ADAT for each DIO•8 card installed.
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Connecting the Digital 8•Bus to a
BRC and ADATs
The inclusion of a BRC controller or, for that
matter, any other sync controller box with word
clock and MTC, vastly increases the capabilities of
the Digital 8•Bus. With centralized controls,
common sync reference, and MIDI Time Code
communication established, the digital system works
together as one unit. Automation is achieved,
referenced to MTC, and digital devices work
together, sample-by-sample to make the most of your
recordings. (See Figure on next page.)

Cabling and Hookup
1. Connect a fiber optic cable between the ADAT’s
lightpipe output and the D8B’s lightpipe input.
Likewise, connect the D8B’s lightpipe output to
the ADAT’s lightpipe input. (A DIO•8 or OPT•8
lightpipe card must be installed in the D8B to
gain access to the digital tape inputs and outputs.)
2. Connect a BNC cable from the Clock I/O card’s
WORD CLOCK OUT connector to the 48kHz IN
connector on the BRC.
Note: It is necessary to terminate this connection with
a 50 ohm termination at the BRC end of the cable. You
will need a BNC “T” connector (Radio Shack part
number 278-112; male-female-female configuration)
and a 50 ohm BNC terminator (Radio Shack part
number 278-270). Connect the “T” connector to the
48kHz IN jack on the BRC. Then connect the BNC cable
from the DIO•8 card to one side of the “T” and connect
the 50 ohm terminator to the other side of the “T.”
3. Connect the 9-pin D-sub sync cables between the
BRC (REMOTE OUT TO ADAT) and the first
ADAT’s SYNC IN connector. Then connect the
sync cables in a daisy-chain fashion between the
remaining ADATs.
4. Connect MIDI cables between the MIDI OUT
connector on the Digital 8•Bus’ Remote CPU
and the MIDI IN connector on the BRC, and
between the MIDI IN connector on the Digital
8•Bus’ Remote CPU and the MIDI OUT
connector on the BRC.
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Settings
Graphics in the previous section will help you
locate these controls.
D8B
1. Click the “Setup” button in the bottom menu bar
of the SVGA monitor to open the General Setup
window.
2. Click the “Digital I/O” icon on the left side of the
window to open the Digital I/O dialog box.
3. Click each Tape Input and Output box and select
ADAT for each DIO•8 card installed.
4. Set the “Samplerate” to 48kHz.
ADATs
1. On the front panel of the ADAT, select DIGITAL IN.
BRC
1. Set the External Sync parameters to the
following:
a) Press the EDIT button.
b) Set the Clock Source to “48KHz Input.”
c) Set the Locate Reference to “Internal.”
d) Press the EDIT button to exit the “Edit
External Sync” page.
e) Make sure the EXT SYNC button is still lit.
2. Press the EDIT button and the GEN SYNC
button twice to bring up the MIDI page.
Set the parameter to MTC. Press the EDIT
button to exit out of the “Edit Generate Sync”
page. Leave the GENERATE SYNC button lit.

Notes:
1. You must turn on the Digital 8•Bus first,
then turn on the ADATs.
2. Make sure the DIGITAL I/O button on the BRC
is not lit.
3. Under the MIDI/UTIL button on the BRC, make
sure #1 MIDI Echo is off and #8 Output Rew/FF
is off. This is so the faders don’t run at high
speed when shuttling around on your ADATs.
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MIDI OUT
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PUNCH
IN/OUT

4

5

6

7

DIGITAL
IN

8
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OUT
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OUT

INPUT
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OUTPUT

LOCATE/PLAY
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OUT
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Connecting the Digital 8•Bus to
ADATs Using an External Sync Box
Cabling and Hookup
1. Connect a fiber optic cable between the ADAT’s
lightpipe output and the D8B’s lightpipe input.
Likewise, connect the D8B’s lightpipe output to
the ADAT’s lightpipe input. (A DIO•8 or OPT•8
lightpipe card must be installed in the D8B to
gain access to the digital tape inputs and outputs.)
2. Connect the 9-pin D-sub sync cables between the
Sync Box (SYNC OUT) and the first ADAT’s
SYNC IN connector. Then connect the sync
cables in a daisy-chain fashion between the
remaining ADATs. Connect the SYNC OUT on
the last ADAT to the SYNC IN on the Sync Box
to complete the loop.
3. Connect MIDI cables between the MIDI OUT
connector on the Digital 8•Bus’ Remote CPU
and the MIDI IN connector on the Sync Box, and
between the MIDI IN connector on the Digital
8•Bus’ Remote CPU and the MIDI OUT
connector on the Sync Box.

4. Set “Samplerate” to match the sample rate of
the formatted ADAT tapes (typically 48kHz or
44.1kHz).
ADATs
1. Select DIGITAL IN on the ADAT front panel.

M o d u l a r D i g i t a l M u l t i t ra c k

Settings
D8B
1. Open the Setup window by pressing Ctrl+1 or
Setup in the bottom menu bar on-screen.

CLOCK
EXT
48K
INPUT MON

INPUT
DIGITAL

2. Click “Digital I/O” to open the Digital I/O
dialog box.
3. Click each Tape Input and Output box and select
ADAT for each DIO•8 card installed.

INPUT SELECT
DIGITAL
INPUT

INPUT MONITOR
TRACK
COPY

ALL
INPUT

AUTO
INPUT

Notes:
• When powering up, turn the Digital 8•Bus on first,
then turn the ADATs on.
• Make sure MMC and MTC are lit on the sync box.
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Connecting the D8B to TASCAM MDMs
Cabling and Hookup
1. Connect the digital cables between the TASCAM tape
decks and the DIO•8 cards in the Digital 8•Bus.
Note: You must use the special dubbing cables provided
by TASCAM, part number PW-88D (1 meter) or PW-88DL
(5 meters). These cables are reverse wired. Do not use
a standard DB25 computer cable, which is wired
straight through pin-to-pin.
2. Connect the sync cables (TASCAM part number
PW-88S) between the master deck and the slaves
in a daisy-chain fashion. Make sure the last deck
has a Termination Plug connected to its SYNC
OUT connector.
For the DA-38:
An MMC-38 MIDI Machine Control interface must be
used prior to the SYNC IN connector on the master
deck to implement MMC transport commands and
track arming for up to three DA-38 machines.
For the DA-88:
You must have an SY-88 card installed in each
DA-88 to implement MMC transport commands
and track arming for up to three DA-88 machines.
The SY-88 cards also provide SMPTE chase lock
operation. Alternately, an MMC-38 MIDI Machine
Control interface may be used prior to the SYNC
IN connector on the master deck to implement
MMC transport commands and track arming for
up to three DA-88 machines.
3. Connect a BNC cable from the first DIO•8 (Tape
1–8) card’s SYNC connector to the WORD SYNC
IN connector on the master deck.
4. Connect MIDI cables between the MIDI OUT
connector on the Digital 8•Bus Remote CPU and
the MIDI IN connector on the MMC-38 (or SY-88
on the master deck), and between the MIDI IN
connector on the Digital 8•Bus’ Remote CPU and
the MIDI OUT connector on the MMC-38 (or SY-88).

Settings
MMC-38
1. Set SW2 DIP switches 6 and 7 to the up
position. All other switches should be in the
down position.
SY-88
1. DIP switches on the SY-88 are set internally.
The DIP switches labeled S2 assign the device
ID numbers (see the TASCAM SY-88 Owner’s
Manual for ID setup information).
TASCAM DA-38/DA-88
1. On the front panel of the TASCAM, select
WORD CLOCK as the clock source.
2. Also on the front panel, turn on the DIGITAL IN.
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3. Set the Machine ID on each recorder, with the
first deck (master) having the lowest number and
the last deck having the highest number. DA-88s
start with ID #0 and DA-38s start with ID #1.
DA-88
DA-38
Deck 1
0
1
Deck 2
1
2
Deck 3
2
3
Note: If using a DA-88 as the master and a DA-38 as a
slave, assign the DA-88 ID #0, and the DA-38 ID #2.
D8B
1. Click the “Setup” button in the bottom menu bar of
the SVGA monitor to open the General Setup window.
2. Click the “Digital I/O” icon on the left side of the
window to open the Digital I/O dialog box.
3. Click each Tape Input and Output box and select
TDIF for each DIO•8 card installed.
4. Select the appropriate sample rate in the Digital
I/O Setup window.

For DA-38s with the MMC-38:
a. Click the “Locator-MC” icon on the left side
of the Setup window.
b. Set all Device IDs to 1 (all D8B Device IDs
must be set to 1 in order to arm tracks from
the console).
For DA-88s with the SY-88s:
a. Click the “Locator-MC” icon on the left side
of the Setup window.
b. Set all Device IDs to one digit less than the
DIP switch settings (S2) on the SY-88 cards
for their respective machines. For example:
SY-88
D8B
Deck 1
1
0
Deck 2
2
1
Deck 3
3
2

REMOTE IN/SYNC IN
(FROM RC-848/DA-88)

SYNC OUT
(TO DA-88)

WORD SYNC
IN

REMOTE IN

OUT

REMOTE
PUNCHIN/OUT

MACHINE ID
SYS

SYS

DSP

DSP

SYNC

SYNC

DA-88
MASTER DECK
(TRACKS 1-8)

(FROM RC-808)

METER UNIT

MODE

RS-422

DIGITAL I/0
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TIME CODE
IN
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VIDEO
IN

THRU

MIDI
IN

OUT

THRU

1 2 3 4 5 6 7 8

MIDI IN
MIDI OUT

REMOTE IN/SYNC IN
(FROM RC-848/DA-88)

SYNC OUT
(TO DA-88)

WORD SYNC
IN

REMOTE IN

OUT

REMOTE
PUNCHIN/OUT

MACHINE ID
SYS

SYS

DSP

DSP

SYNC

SYNC

(FROM RC-808)

METER UNIT

MODE

RS-422

DIGITAL I/0
TDIF-1

TIME CODE
IN
OUT

VIDEO
IN

THRU

MIDI
IN

OUT

THRU

DA-88
SLAVE DECK
(TRACKS 9-16)

1 2 3 4 5 6 7 8

TERMINATION PLUG
REMOTE IN/SYNC IN
(FROM RC-848/DA-88)

SYNC OUT
(TO DA-88)

WORD SYNC
IN

OUT

REMOTE IN

REMOTE
PUNCHIN/OUT

MACHINE ID
SYS

SYS

DSP

DSP

SYNC

SYNC

(FROM RC-808)

METER UNIT

MODE

RS-422

DIGITAL I/0
TDIF-1

TIME CODE
IN
OUT

VIDEO
IN

THRU

MIDI
IN

OUT

THRU

DA-88
SLAVE DECK
(TRACKS 17-24)

1 2 3 4 5 6 7 8

B

C

D

DIGITAL I/O
AES/EBU

Other Notes

1

TAPE 1- 8

TAPE 9- 16

TAPE 17- 24

APOGEE
DIGITAL I/O

APOGEE
DIGITAL I/O

APOGEE
DIGITAL I/O

LINE INPUTS

BUS OUT 1-8

&
SURROUND OUT

(BAL/UNBAL)

18

17

16

15

14

13

DIGITAL 8•BUS

TDIF

TDIF

TDIF

1. You must turn on
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Digital Audio Workstation Setup
Connecting the Digital 8•Bus to a Digital Audio
Workstation (Digital Performer, Studio Vision Pro,
Cakewalk Pro, etc.) shares considerations with the
ADAT and TASCAM hookups. Word clock synchronization must be addressed; the master and slaves
must be established; the clock rate must be consistent throughout; and the audio path into the
console must be intelligently configured.

computer’s sample rate (typically 48kHz or
44.1kHz). Selecting “Internal” in the Apogee
Clock pull-down establishes the D8B as the
master. Everything else in the digital chain must
be capable of slaving to the Digital 8•Bus.
DAW
1. Set the digital audio interface to follow ADAT
optical at the interface input (from the D8B
lightpipe output).
2. Connect the DAWs MIDI/digital audio interface
to the Digital 8•Bus inputs and outputs.

Note: A Pro Tools system works best when referenced
to Superclock sync source, or when connected to a
PDI•8 card through AES/EBU with SRC engaged.
Let’s consider a common computer-based
setup utilizing:
• A combination digital audio/MIDI software
package
• A MIDI interface
• A digital audio interface with lightpipe audio
connections

Cabling and Hookup
1. Connect the Digital 8•Bus lightpipe output, from
the DIO•8 or OPT•8 card, to the digital audio
interface lightpipe input. Likewise, connect the
lightpipe output from the digital audio interface
to the D8Bs lightpipe input.
2. Connect the digital audio interface to the
computer per the manufacturer’s specifications.

Settings
D8B
1. Open the Setup window.
2. Click “Digital I/O” to open the Digital I/O
dialog box.
3. Click each Tape Input and Output box and select
the appropriate setting for each card installed.

4. Set the Digital 8•Bus “Samplerate” to match the
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Note: Be sure to turn on the D8B before any of the
other digital components. In addition, if your setup uses
TDIF connections, refer to the previous setup scenario
for TASCAM-specific settings.
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Digital Audio
Workstation

ADAT OPTICAL

ADAT OPTICAL

ADAT OPTICAL

IN

IN

IN

DAW Digital
Interface

8

C

TAPE 1- 8

TAPE 9- 16

TAPE 17- 24

APOGEE
DIGITAL I/O

APOGEE
DIGITAL I/O

APOGEE
DIGITAL I/O

D

DIGITAL I/O
AES/EBU

1

OUT

IN

OUT

DIGITAL 8•BUS
LINE INPUTS

BUS OUT 1-8

&
SURROUND OUT

TDIF

B

OUT

TDIF

OUTPUT

(BAL /UNBAL)

18

17

16

15

14

13

24

23

22

21

20

19

PHONES 1

PHONES 2

MASTER OUT
L R

2 TRACK IN A
L R

CR
MAIN
L R

2 TRACK IN B
L R

CR
NEAR FIELD
L R

2 TRACK IN C
L R

OUT
IN

OUT
IN

OUT

ADAT OPTICAL

2

IN

DIGITAL I/O
S/PDIF

ADAT OPTICAL

OUT

L

OUT

SYNC

SYNC

IN
SYNC

A

TDIF

TDIF

7

BANK C

TDIF

ADAT OPTICAL

6

BANK B

TDIF

MASTER OUT
DIGITAL EFFECTS CARDS

STUDIO OUT
L R

PUNCH I/O

R

DIGITAL I/O

SYNC

ALT I/O

TAPE IN/OUTS

MACKIE DESIGNS
THIS DEVICE COMPLIES WITH PART 15 OF THE FCC RULES. OPERATION IS SUBJECT TO THE FOLLOWING TWO CONDITIONS:
1) THIS DEVICE MAY NOT CAUSE HARMFUL INTERFERENCE AND
2) THIS DEVICE MUST ACCEPT ANY INTERFERENCE RECEIVED THAT MAY CAUSE UNDESIRED OPERATION

DATA CABLE
(to Console)
PARALLEL

MIDI OUT

CONSOLE DATA

5

BANK A

COMPUTER

MOUSE

KEYBOARD

DATA AND SYNCHRONIZATION I/O
CONCEIVED, DESIGNED, AND MANUFACTURED BY MACKIE DESIGNS INC • WOODINVILLE • WA • USA • MADE IN USA • FABRIQUE AU USA • COPYRIGHT ©1997 •
THE FOLLOWING ARE TRADEMARKS OR REGISTERED TRADEMARKS OF MACKIE DESIGN INC.: "MACKIE", "DIGITAL SYSTEMS", D8B AND THE "RUNNING MAN" FIGURE •

REMOTE CPU

MIDI IN

TALKBACK

Connecting the Digital 8•Bus to A Digital Audio Workstation
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Live Sound/Live Recording Setup
In a live sound/recording application the
console fader banks are chained together to form
one large console. With the addition of up to 24
more mic preamplifiers, the tape inputs can be
used to receive signal from any mic-level or linelevel source.
The setups for live concert recording and live
sound are similar. Each involves mixing everything
as you go—moving faders, or setting and selecting
snapshots. Whereas the live concert mix sends the
final audio to the monitors and house sound system,
the live recording mix sends the final audio to the 2track recorder and the headphones.
Follow this simple procedure to set up for a live
session.
❏ Power amps off
❏ Console power on
❏ Select a starting snapshot
❏ Turn Master Fader down
❏ Connect all mics and instruments
❏ Setup sample clock
❏ Power amps on
❏ Select Mic/Line fader bank
❏ Press Mic button on channels using microphone

inputs
❏ Set Pre-Fader auxes in Setup Window for monitor

use
❏ Test each instrument and mic to verify level at

console input meter
❏ Adjust input trim for a reading around 15 on the

meter
❏ Press L/R in the ASSIGNMENT section to confirm

Assign lights on for all desired channels. Or, look
on-screen to verify all channels have L/R button
highlighted in Bus Assign section
Live Application Tip #1: Buses 1–8 don’t sum to L/R
Mix internally. Therefore, to utilize buses as masters,
route the bus (sub) out the Alt I/O then back into any
channel or Alt I/O input. Or, simply use the virtual
groups as level and mute masters.
❏ Set Master Fader to Unity position
❏ Turn channel faders up to hear instrument or mic.
❏ Once the appropriate level is achieved, press the

channel mute button.
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❏ Set up a quick mix using level, pan, EQ, dynamics,

effects
❏ Adjust mix to the cue (headphone) buses.
❏ Store and label snapshot(s)
Live Application Tip #2: Don’t forget the Snapshot
filters. If you find a parameter setting that you want to
keep throughout the performance (EQ, plugin,
compressor, etc.), simply filter that parameter out of
your saved set of snapshots. All your changes will still
happen on cue as you scroll through snapshots, but
your updated parameters will remain constant.

ANALOG
I/O

FOH Speakers

MASTER OUT

2 TRACK B

2 TRACK C

CR
MAIN
CR
NEAR FIELD

2 TRACK A

19

13

AUX 12

Separate Mix for
Live Broadcast Feed

PNCH I/0 TLKBK

STUDIO OUT

PHNS 1 PHNS 2

20

Processor

Connecting the Digital 8•Bus for Live Sound/Live Recording

Optional AIO•8 Cards

R

L

MASTER
OUT

Cassette Deck

21

14

AUX 10

AUX 9

INSERT

LINE IN

11

AUX 8

AUX 7

INSERT

LINE IN

9

INSERT

LINE IN

10

Stereo Monitors for
Finicky Keyboard Player

AUX 11

INSERT

LINE IN

12

Stereo Reverb

Digital I/O
AES/EBU

ANALOG
I/O

BUS OUT 1-8
&
SURROUND OUT

8 Track Analog
Recorder

22

23

24

15

LINE IN

16

17

18

CR1604-VLZ

Digital Delay

OUT

IN

ANALOG
I/O

TO TAPE

FROM TAPE

2-Track DAT

Drum Mics

Horn Section Mics

TO TAPE
FROM TAPE

Percussion Mics

Mic Preamps
TO TAPE

Stereo Processor

FROM TAPE

INSERT

INSERT

AUX 5

LINE IN

LINE IN

AUX 6

7

8

AUX 4

INSERT

LINE IN

6

Backup Vocals

INSERT

LINE IN

4

INSERT

LINE IN

3

AUX 3

AUX 1

Power Amp
mono mode

AUX 2

FX Card 1

2

INSERT

LINE IN

INSERT

LINE IN

1

internal digital send

internal digital return

audio out

audio in

audio insert

Stage Monitors

To FX Return
1 and 2
(Fader
Bank 3)

To FX Return
3 and 4
(Fader
Bank 3)

internal digital audio
signal path

INSERT

LINE IN

5

Lead Vocals

Vocal Enhancer

D8B Manual • Chapter 4 • page 127

Post-Production Setup
The Digital 8•Bus is an amazing tool, no
matter what the setup. However, the more complex the setup, the more amazing the D8B becomes. Post-production provides potential for any
tracks, effects, snapshots, automation moves, and
general madness mayhem.
Most post-production facilities use house sync
to lock all video equipment together. The same
piece of gear that generates house sync can
provide the D8B and all connected audio gear with
the necessary word clock to get everything
functioning properly together.
In order for the D8B to follow external word
clock, an Apogee Clock I/O card is required. With
the Clock I/O card installed, the available sample
clock options increase. The D8B will slave to most
any clock source from 32kHz to 48kHz.
This is also the type of setup that might be
found in a home studio that incorporates a central
sync generator.

3. Click and hold on the “1” button at the top of
channel 1. Sweep across to channel 6 to assign
channels 1–6 to Bus 1.
4. Click and hold on the “2” button at the top of
channel 6. Sweep across to channel 1 to assign
channels 1–6 to Bus 2.

5. Click the MASTERS button next to the Master
Fader to select Fader Bank 4.
6. Click and hold on the OUT box at the top of BUS
1 (channel 89). Drag down to “Tape Out 7” to
assign Bus 1 to the multitrack record device
track number 7.

Bouncing/Summing Using Bus Outs
You may find that you need to free up some more
tracks to get everything to fit. You can do a submix
and combine several tracks into one (or two) using
the BUS 1–8 Submasters.
Maybe you have six separate tracks for the kick
drum, snare drum, cymbals left, cymbals right, tom
1, and tom 2. You can free up five extra tracks by
bouncing these down to one track, or free up four
extra tracks if you want to bounce them down to a
stereo pair of tracks.
The following steps show an example of how to
bounce tracks 1–6 down to tracks 7 and 8 by using
Bus 1 and 2. By using Buses 1 and 2, whatever pan
positioning you’ve set up is retained.
1. Select Fader Bank 2 by clicking the TAPE
button next to the Master Fader.
7. Click and hold on the OUT box at the top of BUS
2 (channel 90). Drag down to “Tape Out 8” to
assign Bus 2 to the multitrack record device
track number 8.
8. On the recording device, select record ready on
the tracks 7 and 8.
9. Play the song while recording tracks onto the
multitrack.

2. Turn off the L-R assignments for channels 25–
30 (tracks 1–6 returns). Turn off the L-R
assignments for any other channels you don’t
want to monitor while bouncing down.
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10. With the original 6 channels muted, monitor the
bounced track on the D8B TAPE IN bank
(channels 31 and 32).

Using Basic Automation
What Type of Data Can Be Automated
Virtually all of the D8B channel parameters
are available for automation. However, there are a
few exceptions—some obvious and some not so
obvious. All D8B channel parameters can be
automated except:
• Analog Trims on channels 1–12
• Tape Output selection
• Pre and Post insert selections
• Plug-in Configuration selections—even
though plug-in parameters can be automated
• Channel reconfigurations

Two Types of Automation
Automation moves are divided into two basic
types: snapshot and dynamic. Snapshot automation makes it possible to instantly reset all
automated console settings to a predetermined
fixed (static) position with a single command
(snapshot recall). Dynamic automation allows you
to record and play back any parameter changes,
like fader positions or mute toggles, in real time
while locked into time code.
The Digital 8•Bus is powered by Mackie’s Real
Time OS™ automation software. Upon initial powerup, the console Automation Section is bypassed.

Snapshot Automation
As described in Chapters 2 and 3 of this
manual, snapshots are simple and painless to
store on the D8B.
Snapshot automation refers to simply scrolling through various snapshots at the appropriate
time and place. (Recalling snapshots in the proper
order and position can be accomplished through
connection to a MIDI sequencer, or by placing
snapshot events in the Event Automation Track.)
Your MIDI sequencer sees a snapshot selection as a simple patch change, which can be
recorded as part of the same sequence that might
contain all or a portion of your music.
• Set the sequencer to receive and record MIDI
patch change data from the D8B MIDI channel
and cable.
• Select “MIDI Snapshots” in the Setup>Mix
Options window.
• Run the sequence with the D8B receiving MTC
from the sequencer.
• Place the sequencer in record mode on the D8B
channel as you scroll through snapshots. Each of
these snapshot changes record into the sequence.
• Play the sequence back with the D8B receiving
MIDI playback at its MIDI input.
• Snapshots will playback in the same time and
order that you selected them.

•

To fine-tune snapshot placement, open the
sequence track and adjust the time position in
the MIDI sequence.

Dynamic Automation
Dynamic automation is a function of the D8B
automation system. The power and flexibility
offered by the D8B is awesome. This one tool can
revolutionize the way you do music.
Each new automation pass helps mold and
shape the music into a brilliant work of art.
Dynamic automation involves real-time crafting of
the mix with the assistance of a computer processor.

Where Do I Start?
Automation is somewhat intimidating at first.
Fortunately, it doesn’t need to be. The power,
flexibility, and ease of use provided by the Mackie
designers makes the D8B painless and intuitive.
If you’ve used other automation systems, you
have a definite advantage. The concepts involved,
as they apply to the D8B, are similar to most
automation systems. The advantage the D8B
offers over most other automation systems is its
mind-boggling ability to automate virtually every
parameter on the console.
The following is a step-by-step, streamlined
procedure to help get you automating. To clarify
terminology and basic layout, refer to Chapter 2
of this manual.

Automation In Bypass
•

Begin by setting up a basic mix with automation
off. Select BYPASS in the Automation section of
the control surface in the Options/Automation
window, or in the on-screen Locator window.

Clear Automation
•
•
•
•
•
•

To avoid errant data, select all channels and
clear all types of automation data.
Select Mic/Line bank, then Select All
(Control+A).
Select Fader bank, then Select All (Control+A).
Select Effects bank, then Select All (Control+A).
Select Masters bank, then Select All
(Control+A).
Choose Clear Automation… from the Edit Menu.
Check all types of data, then OK.

Save Session As…
•
•

Name your Mixes in a manner that is easy to
reference consecutive revisions: For example,
“BigBadBob Mix 1,” or “BigBadBob rev 1.0.”
Using “rev 1.x,” “rev 2.x,” etc. provides an
easy way to indicate major conceptual
changes (1.0, 2.0, 3.0, etc.) from minor
refinements (1.0, 1.1, 1.2, etc.)

Setup Rough Mix
•
•

Build the basic sound of the mix. Include
fundamental EQ, Pan, Surround, Dynamics,
Groups, etc.
Save frequently, or set the D8B for SMART
SAVES at regular intervals.
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Save Snapshot For Safety
As you build the mix, save snapshots as soon
as the music begins to reveal itself. Label the
snapshots for your own reference. Sometimes these
basic mixes, which are derived from your initial
“gut” reaction to the music, are the most powerful.
Basic dynamic automation does not require
these snapshot saves, but they’re often useful as
the mix comes together, even if only as a crossreference. If you develop a string of snapshots that
are very powerful, they can be strung together
during automation. However, the procedure we’re
outlining here highlights dynamic automation.

Time Code From Playback Device
Route MTC
The D8B requires MIDI Time Code (MTC) at
the MIDI input to operate automation along with
the record/playback device.
• Connect the MIDI output of your computer,
sequencers, MIDI interface, or transport control
to the MIDI input of the D8B.
• Most sequencers or other record/playback
devices that transmit MTC need to be configured
to route to a specific MIDI channel, cable, or
device. Consult your MTC source operator’s
manual to confirm accurate and verifiable
routing to the D8B.

•
•
•
•

Exit Bypass Mode
Once the default levels have been set, it’s time
to exit BYPASS mode. From this point on, any
parameter change can be written into automation.

Select Parameters
Choose the parameters you’d like to record as
automation data on the first pass. This is typically
a great time to ride basic fader, mute, and pan
settings. However, there is no problem with
selecting Faders, Mutes, Pan, and ALL so no
matter what moves you make, they can be recorded and recalled by the automation processor.

Any Combination of Faders, Mutes, and Pans on
First Pass
•

•

Verify MTC at D8B Transport SMPTE Window
•

•
•

When your sequencer or other record/playback
device is running and MTC is transmitted, the
D8B control surface position readout window will
scroll MTC. You will see a continuous increase of
Hours, Minutes, Seconds, and Frames. If you see
this scrolling time code in the D8B POSITION
display, it’s almost automation time!
MTC also displays in the on-screen Locator
window.
If SMPTE VIEW is not selected, the readout will
display Bars/Beats/Ticks (BBT). Press the SMPTE
VIEW button at the left of the control surface
readout to toggle between SMPTE and BBT.

Set Default Levels…
Once your ducks are in a row, you’re ready to
begin the automation process! The Set Default
Levels…” command determines the starting point
for the entire mix. Fader levels can be written
from the beginning of time code (00:00:00:00) to
the end (23:59:59:30).
If you don’t set default levels to your preference, levels will jump to any previously selected
automation settings as soon as MTC begins. This
can be very frustrating, but if you’ve religiously
saved snapshots of your mix status, you won’t be
far from repair.
• Determine that your mix is solid enough that
you’d like to have all parameters written as
defaults. Don’t get too freaked out about this—
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you’ll be tweaking the mix to perfection anyway.
Verify that all channels are selected by choosing
each of the four fader banks and confirming that
all SELECT buttons are highlighted.
Select Set Default Levels… from the Edit Menu.
Respond “Yes” to complete the task.
If you need to recall your static mix at any point,
you can save or update snapshots at any time.

Choose automation parameters by selecting
them in the control surface AUTOMATION
section, in the on-screen locator window, or the
Options/Automation menu.
The D8B shows no favoritism to any or all
parameter writing during automation. You’ll
discover the process that works best for you.

Note: Faders, Mutes, and Pan all apply individually to the
one parameter they name. ALL applies to all automation
parameters other than Faders, Mutes, and Pan.
Safety Net: You can undo any automation record pass
or series of record passes using the History List. You
can also redo your undo. Or undo your redo. Or undo
your hairdo.

Auto Touch Mode
Auto Touch mode offers great flexibility and
ease of use. When AUTO TOUCH is selected,
automation data is recorded instantaneously for
any parameter as soon as you change its setting.
Select AUTO TOUCH by highlighting the control
surface AUTO TOUCH button, clicking AUTO
TOUCH in the on-screen Locator window, or selecting Auto Touch in the Options/Automation menu.
You’ll know you’ve succeeded in writing
automation data when you see the yellow light
illuminate the control surface WRITE button or
the on-screen channel WRITE icon.

Start playback device
•
•

Verify MTC in the Locator position readout.
Verify selection of desired automation
parameters—for now select FADERS, MUTES,
PAN, and ALL.

Move a channel fader

Press the D8B Record Button

•

•

As soon as the fader moves, the WRITE button
illuminates, indicating automation data is being
recorded.

Exit Record and Rewind to Beginning of Track
•

Stop playback or press the WRITE button on the
active channels to exit automation record mode.
Rewind playback/Record device to the beginning
of the automation pass.

•
•

Start Playback from Beginning of Track
•
•

If you’ve followed these directions thoroughly
you’ll see the fader move that you recorded
playback automatically.
Welcome to the wonderful world of D8B
automation!

Repeat this Action for More Parameters
•
•

Be sure you’ve selected the desired parameter
before attempting the automation pass.
Each time you perform a new automation pass,
new data combines with the old in a seamless
manner. Continue building the mix until
everything is just right.

Note: Auto Touch mode does not require any channel
selection for automation to record! Simply move
virtually any parameter on any channel to activate the
record status for that channel on that automation
parameter.

Write Ready Mode
It’s possible to build an entire mix using Auto
Touch mode. It is easy to use, easy to build on,
and it offers incredible creative flexibility. However, there are instances where Write Ready mode
provides the perfect mode for a particular task.
Write Ready Mode is very useful when several
channels must be placed into automation record
mode at the same time.

•

Note: Operation characteristics of the Transport
RECORD button are determined by the settings in the
Setup>Mix Options window. Select “One Button Punch”
to enable record status by simply pressing the RECORD
button alone. If “One Button Punch” is not selected
the user must hold PLAY while pressing RECORD to
enter record mode. Press Play or Stop to punch out of
record.

Exit Record and Rewind to Beginning of Track
Start Playback from Beginning of Track
Repeat this Action for More Parameters
Write Punch-in Mode
This mode functions in a very similar fashion
to Write Ready mode. However, in this mode the
Transport RECORD button is not needed.

Exit AUTO TOUCH Mode
Deselect Write Ready Mode
•

•

•

•

Select Write Ready Mode
•

•

This option is located in the Setup>Mix Options
window as “Use Write Ready” and in the
Options/Automation Menu as “Write Ready
Mode.”
In this mode, the Transport RECORD button is
necessary for completing an automation pass.

Press WRITE on All Desired Automation Channels
•

The yellow light or icon blinks, indicating
record-ready status.

Start the Playback Device
•

Even when the playback device starts, the
automation system remains in ready status
(yellow lights blinking) until the RECORD button
is pressed in the control surface Transport section
or the on-screen Locator window.

This option is available in the Setup>Mix
Options Menu and in the Setup>Mix Options
window

Start Playback Device, then Press the Write
Button(s) on the Desired Channels

Toggle the AUTO TOUCH button off
Activate the Desired Automation Parameters
Engage FADERS, MUTES, PAN, and/or ALL
in the same manner as previously described.

Press the RECORD button on the control
surface in the transport control section or in the
on-screen Locator window.
Once record status has been achieved, the
blinking yellow lights remain solid until the
transport stops or the WRITE button is pressed.
For the write-ready channels, fader, mute, and
pan automation data is written as soon as record
is pressed.
For all other parameters (other than fader, mute,
and pan), even though RECORD is pressed,
automation data isn’t actually recorded until a
parameter change is made.

In this mode, pressing the channel WRITE
buttons immediately places the channels into
automation record mode.
Pressing an active WRITE button (yellow light
solidly on) immediately punches out of
automation record mode for that channel.

Adjust Automation Parameters on the WRITEEnabled Channels
•

It’s always important to verify the correct
selection of intended automation parameters.

Exit Record and Rewind to Beginning of Track
Start Playback from Beginning of Track
Repeat this Action for More Parameters

Trim Levels
This mode is perfect for updating sections of a
mix. If you’ve worked and toiled over a track
throughout a mix, adjusting the levels frequently, try
TRIM mode. This valuable mode simply adds or
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subtracts the same amount from a previously
adjusted automation track. For example, when used
for faders, all moves are maintained but the overall
volume changes.

Press TRIM LEVELS
•

Press TRIM LEVELS in the control surface
Automation section, on-screen Locator window,
or in the Options>Automation menu. Notice that
the faders all snap to unity position.

Choose Automation Mode
Even though TRIM LEVELS is selected and
the faders all move to unity position, the automation modes still retain their operational character.

Use Channel Faders to Boost or Cut Previously
Automated Channel Data
•
•
•

The faders automatically set at unity so they can
be easily used to boost or cut the previously
adjusted track content.
This is an excellent mode to globally adjust
channel levels.
Simply raise or lower the fader level to boost or
cut the sum of your previous adjustments for the
selected channel.

Auto Touch, Write Punch-in, and Write Ready
Modes Function in TRIM mode, also

Automate EQ, Dynamics, and Effects
Automation of EQ, dynamics, and effects is simple.
Select automation mode (ALL).
Start the playback/record device.
Activate automation record command.
Make changes.
In order for these parameters to record, ALL
must be selected in the control surface AUTOMATION section, on-screen Locator window, or in the
Options/Automation window.
•
•
•
•

Automation Procedural Checklists
These checklists are designed as skeletal
reminders of the processes previously described. If
you follow them and have a basic understanding of
the D8B automation system, they’ll help instill an
efficient automation procedure.

Automation Start-up Procedure
❏
❏
❏
❏
❏
❏
❏
❏
❏
❏
❏

Automation In Bypass
Clear Automation
Save Session As…
Set Up Rough Mix
Save Snapshot For Safety
Route Time Code (MTC) From Playback Device to
D8B MIDI Input
Verify MTC at D8B Transport SMPTE Window
Set Default Levels…
Exit Bypass Mode
Select Parameters
Any Combination of Faders, Mutes, Pans, and All

Auto Touch Summary Checklist
❏
❏
❏
❏
❏
❏

Enter Auto Touch Mode
Start Playback Device
Move a Channel Fader
Exit Record and Rewind to Beginning of Track
Start Playback from Beginning of Track
Repeat this Action for More Parameters

Write Ready Summary Checklist
❏
❏
❏
❏
❏
❏
❏
❏
❏
❏

Exit the AUTO TOUCH and/or TRIM LEVELS Mode
Activate the Desired Automation Parameters
Select Write Ready mode in Options>Automation
Press WRITE on All Desired Automation Channels
Start the Playback Device
Press the D8B Record Button
Adjust faders, mutes, or any selected parameters
on the WRITE enabled channels
Exit Record and Rewind to Beginning of Track
Start Playback from Beginning of Track
Repeat this Action for more channels and
Parameters

Write Punch-in Summary Checklist
❏
❏
❏
❏
❏
❏
❏
❏

Exit AUTO TOUCH and/or TRIM LEVELS Mode
Exit Write Ready mode in the Options>Automation
Menu
Start Playback/Record Device and Verify MTC
Press the Write Button(s) on the Desired Channels
Adjust Automation Parameters on the WRITEEnabled Channels
Exit Record and Rewind to Beginning of Track
Start Playback from Beginning of Track
Repeat this Action for More Parameters

Trim Levels Summary Checklist
❏
❏
❏
❏
❏
❏
❏
❏
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Press TRIM LEVELS
Choose Automation Mode (All Modes Function as
Expected)
Start Playback/Record Device and Verify MTC
Use Channel Faders to Boost or Cut Previously
Automated Channel Data
Exit Record and Rewind to Beginning of Track
Start Playback from Beginning of Track
Repeat this Action for More Parameters
Exit Trim Levels to Return Faders to Normal Mode

Appendices
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Appendix A
Service
Warranty Service
Details concerning Warranty Service are spelled
out on the Warranty Card included with your console
(if the card is missing, let us know and we’ll rush
one to you).
If you think your console has a problem, please do
everything you can to confirm it before calling for
service, including reading through the
Troubleshooting section of this owner’s manual.
Doing so might save you from deprivation of your
console and the associated suffering.
Of all Mackie products returned for service (which
is hardly any at all), roughly 50% are coded “CND”
— Could Not Duplicate, which usually means the
problem lay somewhere else in the system.

Repair
Service for the U.S. versions of our digital
consoles is available only from our factory, located in
sunny Woodinville, Washington. (Service for
products living outside the United States can be
obtained through local dealers or distributors.) If
your console needs service, follow these instructions:
1. Review the troubleshooting suggestions in your
owner’s manual (see next section). Please.
2. Call Tech Support at 1-800-258-6883, 7am to 5pm
PST, to explain the problem and request an RA
(Return Authorization) number. Have your Digital
8•Bus (or Remote CPU) serial number(s) ready.
You must have an RA number before you can
obtain service at the factory.
3. Set aside the power cord, owner’s manual, or
anything else that you’ll ever want to see again.
We are responsible only for the return of the
product being repaired.
4. Pack the product in its original package, including
the foam end caps and the upper tray. This is
VERY IMPORTANT. When you call for the RA
number, please let Tech Support know if you need
new packaging. Mackie is not responsible for any
damage that occurs due to non-factory packaging.
5. Include a legible note stating your name, shipping
address (no P.O. boxes), daytime phone number,
RA number, and a detailed description of the
problem, including how we can duplicate it.
6. Write the RA number in BIG PRINT on top of the
box. It must appear on the outside of the box.
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7. Ship the product to us. We recommend United
Parcel Service (UPS). We suggest insurance for
all forms of cartage. Ship to this address (unless
told differently by your friendly Tech Support
person):
Mackie Designs
SERVICE DEPT.
16140 Wood-Red Rd. NE, Ste. 5
Woodinville, WA 98072
8. We’ll try to fix the product in three to five
business days. Ask Tech Support for current
turnaround times when you call for your RA
number. We normally send everything back
prepaid using UPS Orange (three-day air).
However, if you rush your product to us by air
shipment, we’ll treat it in kind by placing on the
‘priority’ shelf. Once it is repaired, we’ll ship it
back the same way in which it was received. This
paragraph does not necessarily apply to nonwarranty service.

Troubleshooting Guide
Three Things to Keep in Mind
As you become familiar with the Digital 8•Bus,
you’ll find it helpful to keep these three questions in
mind at all times:
1. What Fader Bank is selected?
2. What channel is selected?
3. What is the V-Pot assignment?
In 90% of the cases, if something isn’t working as
you expect it should, it’s because one of these three
settings isn’t where you intend it to be.
No power!
• Our favorite question: Is it plugged in? Make sure
the power cord is securely seated in the IEC
socket and plugged all the way into the AC outlet.
• Our next favorite question: Is the POWER switch
on? If not, try turning it on.
• Is the Fat Channel Display working? If not, make
sure the AC outlet is live (check with a tester or
lamp). If so, refer to “No Sound” below.
• Make sure the DC power cable is securely
connected at the rear panel of the console.

No Sound!
• Is the signal source working correctly, and
properly connected to an input on the console?
• Is the TRIM control (channels 1–12) or the
Digital Trim control (channels 1–48) turned all the
way down?
• Is the MIC/LINE switch set to the correct
position?
• Is the channel fader control turned up?
• Has the channel been assigned to an output bus in
the Bus Assignment Section?
• Is the master level control for the selected output
bus turned all the way down?
• Try soloing a channel and listen to the Control
Room Outputs, or use headphones connected to
the Phones Out (with Control Room selected in
the Phones/Cue Mix Section). Make sure the Solo
Level is turned up in the Studio/Solo Section, and
the Control Room Level is turned up in the
Control Room Section.
Bad Sound
• Is the input connector plugged completely into
the jack?
• Is it loud and distorted? Turn down the output
level on the console.
• Are any of the meters hitting the “OL” mark? Try
turning down the TRIM control (channels 1–12)
or the Digital Trim control (channels 1–48). Or try
turning down the signal source volume control.
• Solo the signal source and listen to it in the
Control Room Output, or with headphones in the
Phones output. Select PFL SOLO in the Studio/
Solo Section. Make sure the SOLO LEVEL control
is turned up in the Studio/Solo Section, and the
Control Room LEVEL control is turned up in the
Control Room Section. If the signal sounds bad
with PFL SOLO selected, the problem lies
somewhere before the channel fader, with the
source itself or the input settings on the console.
If the signal sounds okay, the problem lies
somewhere after the channel fader, with the
output settings or the amplifier/speaker
combination after the console.
Noise/Hum
• Check the signal cable between the console and
the power amplifier. Make sure all connections
are secure.
• Make sure signal cables are not routed near AC
cables, power transformers (wall warts), or other
EMI sources.
• Is there a light dimmer or other triac-based (SCR)
device on the same AC circuit as the console? Use
an AC line filter or plug the console (along with all
other audio equipment) into a different AC circuit.
• If you’re connecting an unbalanced source to the
balanced input using an XLR or TRS connector,
try disconnecting the unbalanced ground from pin
1 (XLR) or sleeve (TRS).
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Appendix B
IVL Vocal Studio

The Interface

About the IVL Vocal Studio
The IVL Vocal Studio is a truly unique tool that
offers natural sounding harmonies, wild vocal
effects, and vocal utilities. You will hear that Vocal
Studio can help you to quickly create killer vocal
tracks. In order to get you excited—and for your
general information—here is what’s packed into IVL
Vocal Studio:
• Formant-Preserving Pitch Shifting
• Intelligent Vocal Harmony (with four
operating modes)
• Pitch Corrector
• Vocal Special Effects
• Integral Reverb Effect

Technologies Used
Formant-Preserving Pitch Shifting: No
chipmunks or Darth Vader here! With IVL’s patented
formant-preserving pitch shifting algorithm, the
Vocal Studio uses precise analyzation techniques on
the input voice to naturally shift it higher or lower.
Pitch recognition: IVL does more than just take
a note and shift its pitch. The pitch shifting
algorithm detects the exact pitch of the note in order
to provide the most natural shifted sound.
Intelligent Harmony: The Vocal Studio has
musical knowledge. It took lessons from some
amazing musicians. By using different control modes,
you can choose how much of this intelligence the
Vocal Studio will use when creating your harmonies.
By selecting the key and scale that the vocal passage
is in, and with IVL Vocal Studio’s pitch recognition, an
intelligent harmony can be created with 1 to 4 voices.
Voice Muting: These buttons allow you to mute
individual voices. When Voice Muting is ON, the
audio signal passes through Vocal Studio’s
processing. When MUTE is selected, the audio signal
is muted for that voice. The small number to the left
of each button corresponds to the Harmony
Ensemble voice that it affects.
Note: The Digital 8•Bus ships with one MFX (Mackie
Effects) card installed. You can load it with either the
Mackie Effects plug-in or the IVL Vocal Studio plug-in.
The IVL Vocal Studio software will run in demonstration
mode, where it times out after about 10 minutes of use.
You must then download the plug-in to the card once
again to activate it for another 10 minute session.
To authorize the IVL software plug-in, simply purchase
and install a second MFX card into your Digital 8•Bus.
Then you can download the Mackie Effects plug-in to
one card, and the IVL Vocal Studio plug-in to the other
card and use them both for as long as you like.
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Menu
Click this button to save and load your own
presets, save changes made to an existing preset,
rename a preset, copy current settings to the
clipboard, and paste settings from the clipboard to
any other Vocal Studio preset.

On/Off
This button turns the IVL Vocal Studio on or off.

Processing Mode
Use this button to select either Harmony or Pitch
Correct mode.
Harmony: This button puts the IVL Vocal Studio
into harmony mode, allowing 4 voices of harmony or
doubled voices to be added to a mix.
Pitch Correct: This button puts the IVL Vocal
Studio into pitch correct mode, allowing a vocal line
to be nudged to the note your ear wants to hear.

Output Mode

Stereo: This button selects two independent
mono in/stereo out effects blocks. One effects block
is used for pitch shifting, harmony, and doubling. The
second effects block, assigned to a second aux send,
is used for reverb. The input to the reverb effects
block comes from a mix of its assigned aux send and

the output of the harmony effects block. Each effects
block then returns its processed signal to an
individual stereo return.

Quad: Selects mono in/quad out. Input from one
auxiliary send is routed to the harmony processor.
Four harmony voices are given discrete outputs to
two stereo returns.

Control Mode

Manual: Any notes played on a MIDI keyboard
become the harmony parts. These parts will stay on
the note assigned by the keyboard even when your
voice shifts to a new pitch. Using pitch bend and/or a
modulation wheel, realistic expression is introduced.
SmartChord: Chords played from a MIDI
keyboard are interpreted by the Vocal Studio to
create natural harmony parts that move in tandem
with your voice.
SmartKey: Enter the key and scale once, at the
beginning of a song, and the Vocal Studio
automatically creates natural harmonies in real time.
This mode produces the most common type of
harmony in popular music.
Pitch Shift: Use this button to set a chromatic
interval between the lead vocal and pitch-shifted
voices to create true parallel melody lines. This is
useful more for special effects than harmonies
because our ear is tuned to the “moving third”
interval that parallel (chromatic) harmonies don’t
provide.

Edit–Harmony Ensemble

Interval: In SmartChord, SmartKey and Pitch
Shift control modes, “Interval” determines how much
higher or lower the harmony note is than the lead
note. In SmartChord and Smart Key modes, the
intervals are intelligent; that is, they will sharpen or
flatten automatically to make the harmonies sound
musically correct.
For Pitch Shift, the interval chosen is always in
parallel with the lead, regardless of the key and
scale.
Gender: The gender of each harmony voice can be
changed to create mixed vocal ensembles without
needing to see that special doctor in Sweden.
Detune: Who sings a perfect third? No one, really.
“Detune” adjusts a harmony note’s pitch to be
slightly above or below the exact note it is creating.
Volume: Controls the level for each harmony
voice.
Pan: Controls the stereo placement of each
harmony voice.
Styles: Styles are preset modifiers you can use to
add realism to the harmony voices.
Timing: This allows you to control the entries of
the harmony parts, from 10 millisecond to random
delays.
Scoop: This controls how a harmony part slides
into each note. Do they bend up to it? How much do
they bend?
Vibrato: This controls the amount of vibrato in
your harmony parts.
Envelope: This control is used with the “Manual”
control mode. When in “Manual” control mode, a
MIDI keyboard is used to trigger harmony notes.
The “Envelope” control adjusts the attack and
release timing of the harmony MIDI notes. This can
add bite or smooth out the manual harmony sound.
Key/Scale: When the SmartKey control mode is
used, the key and type of scale of the song must be
selected for the intelligent harmony to choose
musically correct harmonies.
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Pitch Correct Mode

Interval

Pitch Bender: Use the bender to manually raise
or lower the pitch of the shifted voices. This works
just like a spring-loaded keyboard pitch bender.
Pitch Bend Range: The range parameter lets you
set the maximum amount of pitch bend that can be
applied to the vocal.
Pitch Controller: Use the keyboard to force the
vocal to an exact pitch.
Keyboard Octave Select: Selects the octave that
the keyboard represents.
Slope: Use this lovely window to set the
transition rate between the original vocal sound and
the pitch-corrected sound.

Operation–Harmony

Using the interval sliders, you can adjust the
interval of each of the four harmony voices.
Basically, “Interval” controls the voicing of the
harmonies relative to your lead note. When in the
SmartChord and SmartKey control modes, the
interval settings are divided into seven coarse steps.
Each step directs the voice in a different way. The
following table describes the individual intervals in
musical and nonmusical terms. Note that, although
the descriptions for the SmartChord and SmartKey
intervals are similar, SmartChord intervals follow the
lead voice “loosely” and SmartKey intervals follow
the lead voice’s every pitch movement.

Step

SmartChord
non-musical
description

SmartChord
musical
description

SmartKey
non-musical
description

SmartKey
musical
description

Bass

lowest

root of chord,
octave down

lowest

octave below lead

3rd of chord, in
the octave down

low

3rd of chord, in
the octave below

Baritone low

Harmony mode is used to create everything from
harmonies to doubled voices. To make sure you are
in Harmony mode, make sure it is selected.

The Editing Parameters

Tenor

just underneath 5th of chord, in
lead
the octave below

just underneath
the lead

5th of chord, in
the octave below

Unison

same as lead

unison

the same note
as the lead

unison

Alto

just above
lead

3rd of chord

just above
the lead

intelligent 3rd

Mezzo

high

5th of chord

high

5th above lead

an octave above
the root

highest

octave above lead

Soprano highest

The editing parameters are the tools that allow
you to put some spice into your harmonies or
doubled voices. Some of the editing parameters are
used in all control modes, and others are specific to
one control mode.
Parameter
Interval
Gender
Detune
Volume
Pan
Styles
Envelope
Key/Scale

Manual
yes
yes
yes
yes
yes
yes

SmartChord
yes
yes
yes
yes
yes
yes

SmartKey
yes
yes
yes
yes
yes
yes
yes
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PitchShift
yes
yes
yes
yes
yes
yes

When using the Pitch Shift control mode, Interval
works in a different, but simple way. Pitch Shift
interval is set from –24 to +24 for each voice. Each
digit corresponds to one semitone above or below the
lead pitch. For example, –24 would be two octaves
below the lead, +12 would be an octave above the
lead. The intervals for Pitch Shift are represented
with numbers as they are not “intelligent” intervals.
Pitch Shift intervals are always a parallel distance
away from the lead note no matter what the key and
scale of the music.

Gender

1. Harmonies: Detuning each harmony voice can
create natural-sounding harmonies. In real life
nobody sings perfectly in tune, so why should
the IVL Vocal Studio have to?
2. Doubling: Detuning unison harmony voices can
create the fattest of phat vocal sounds without
singing a vocal line four times.

Volume

Using these sliders, you can adjust the gender of
each of the four harmony voices. So, what is this
gender thing?
gender (jen’der) m. 1. The condition or quality of
being of the male or female sex.
In IVL Vocal Studio, “Gender” will give your
harmony voices distinct character. When the gender
amount is set at 0 (in the middle) there is no gender
effect applied to the harmony voice. As you lower the
gender amount, more male qualities are introduced
into the voice. As you raise the gender amount, more
female qualities are introduced into the voice. This is
the control that gets you that deep bottom end you
have been undoubtedly waiting for.

Detune

These sliders provide individual level control over
your voices. If you are in QUAD output mode,
VOLUME edit will not be available; volume will be
controlled via the four assigned aux return faders. If
you are using the Vocal Studio in Stereo output mode
you will want to mix your voices using the Vocal
Studio volume controls.

Pan

The detune sliders can be adjusted independently
for each harmony voice. Detune is like a fine-tune
adjustment on a keyboard. The detune amount
ranges from –50 cents to +50 cents (50 cents is
equal to 1 semitone). There is also a “normal” or
“random” button located in the top-right corner of
the detune window. When “normal” is selected, the
detune amounts are fixed at their settings. With
“random” selected, the detune amounts are randomly
generated from 0 detune to the setting for each
harmony voice. Detune is very useful for two
different applications:

Now the sliders are going the other way! The pan
controls are used to place your harmony voices in a
stereo field. Just as with the volume controls, you
will want to set your pan controls differently
depending on which output mode you are using.
When in QUAD output mode, PAN is not available to
edit. Instead, you control the pan on their dedicated
aux returns.
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Vibrato adds another level of human quality to
the harmony voices. The majority of singers use
some amount of vibrato. Basically, Vibrato is like the
modulation wheel on a keyboard, which modulates a
harmony voice’s pitch by a small amount. The
Vibrato presets are based on the amount of
modulation, the rate of the modulation, and when the
modulation starts.

Styles

In “Styles,” you can create that extra amount
of personality and realism for your harmony
voices. Each style is controlled by a spin dial. Spin
the dial up or down to change the parameter; all of
the Style parameters are adjusted globally for
each harmony voice.
Timing adjusts the entrances of the harmony
voices. With “Timing” turned off, the harmony voices
enter at the same time as the lead voice. Each timing
parameter delays the harmony voices from the lead
vocal. Just like tuning, no group of singers sings the
notes at exactly the same time. The timing presets
have been created using individual delays for each
voice. Additionally, some time delay presets use
randomization. Randomization randomly creates
delay time for each voice from 0 delay to the delay
time specified. The timing presets are listed below.
Number
0
1
2
3
4
5
6
7
8
9
10

Name
Off
Tight Mix
Medium Mix
Loose Mix
5ms + Rand.
10ms +Rand.
20ms +Rand.
30ms +Rand.
40ms +Rand.
50ms +Rand.
80ms +Rand.

Delay
none
between 5 and 12ms
between 10 and 32ms
between 20 and 36ms
Max. Delay of 5ms
Max. Delay of 10ms
Max. Delay of 20ms
Max. Delay of 30ms
Max. Delay of 40ms
Max. Delay of 50ms
Max. Delay of 80ms

Randomization
none
none
none
per voice
per voice
per voice
per voice
per voice
per voice
per voice

Scoop adjusts how a voice attacks a note. Even
professional singers never hit a note right on pitch.
They hit their note slightly lower than the pitch they
are aiming for and then “scoop” up to the correct
note. The scoop presets are created using the
amount of scoop (how far below the note) and how
long it takes for the harmony voice to scoop to the
actual note.
Number
0
1
2
3
4
5

Name
Off
The Pros#1
The Pros#2
Semi Pro#1
Semi Pro#2
Swoopy

Description
no scooping
low amount, fast rate scooping
high amount, medium-fast rate scooping
low amount, medium-slow rate scooping
high amount, slow rate scooping
low amount, very slow rate scooping
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Number
0
1
2
3
4
5
6
7
8
9
10

Name
off
Light
Medium
Heavy
Light & Fast
Med & Fast
Heavy & Fast
Light & Slow
Med & Slow
Heavy & Slow
Chorale

Description
no vibrato
low depth, medium rate with onset delay
medium depth, medium rate with onset delay
high depth, medium rate with onset delay
low depth, fast rate with onset delay
medium depth, fast rate with onset delay
heavy depth, fast rate with onset delay
low depth, slow rate with onset delay
medium depth, slow rate with onset delay
high depth, slow rate with onset delay
low depth, very slow rate with no onset delay

Portamento is used to limit the hard stepping
between moving harmony notes. Portamento can add
realism to the movement of harmonies. With
Portamento, each harmony note slides into the next
at a selected rate. The rates are selected with the
Portamento spin dial from 0 (fastest) to 10 (slowest).
PitchBend Range sets the pitch bend range that
can be applied to the harmony voices using a MIDI
device. The pitch bend range can be set from 0 to 12
semitones.
Key/Scale is an edit mode used only in
“SmartKey” mode. The use of Key/Scale is described
farther on under the “SmartKey” section.
Envelope is used only in the “Manual” control
mode. The use of “Envelope” is described in the
“Manual” section on page E-6.

The Harmony Control Modes
Harmony Control Modes determine the way in
which harmonies are created. IVL Vocal Studio has
four control modes. Each of these modes is tailored
toward a different application. They can be
categorized by two items:
1. Requires MIDI input: Using the D8B’s MIDI
input, a keyboard or sequencer sends note
information to the IVL Vocal Studio to create
harmonies.
2. Intelligent Harmonies: IVL Vocal Studio uses
intelligence to help create natural harmonies.
Action
Requires MIDI Input
Use intelligent harmonies

Smart
Manual Chord
yes
yes
no
yes

Smart Pitch
Key
Shift
no
no
yes
no

Manual
Because you can choose exactly which harmony
notes you want, Manual mode is excellent for
creating unusual harmony treatments. Where the
SmartKey and SmartChord control modes follow the
ascending and descending direction of your voice,
Manual mode allows you to play a descending
harmony line over an ascending melody line, for
example. You can combine this aspect with the
ability to play dense chord voicings with lots of
sixths, sevenths, and ninth color notes to create
harmony parts that are truly unique.
When using Manual or SmartChord modes (the
keyboard control modes), you can save time by using
a MIDI sequencer to play any or all of the
instrumental parts in your composition. As there are
often pad chords on a synth or piano track, these can
also be used to trigger harmonies.
When you choose Manual mode in this situation,
the harmony parts won’t follow the melody lines you
sing; they’ll stay on the notes played on the
instrument track. Because you’ll probably want to
add notes here and there to your control track, it’s
often a good idea to copy the instrument track to
another open track in your sequencer and use the
copy as your starting point.
In manual mode there is an editing parameter
called “Envelope.” You can use “Envelope” to shape
the entrances and exits of harmony notes triggered
through MIDI.

The graph in the Envelope window represents
volume against time. Adjusting the Attack time with
the spin dial will vary the slope on the leading edge
of the graph. A shallow slope will fade-in the
harmony notes after Vocal Studio is triggered
through MIDI. Adjusting the release time will vary
the slope on the trailing edge of the graph. A shallow
slope will fade the harmony notes out after the MIDI
trigger is released. Steep slopes will make
instantaneous attacks and releases.

SmartChord
SmartChord uses the intelligent harmonies of the
Vocal Studio in conjunction with a MIDI keyboard
hooked up to the D8B. On the keyboard, you would
play the chords of a song in real time with the lead
vocal. IVL Vocal Studio recognizes the chords and
creates correct harmonies. SmartChord mode will
follow the melody of your voice while staying
musically related to the chords on the MIDI control
track.
To get harmonies in SmartChord mode you first
need to select intervals for one to four of the
harmony voices. You can select the intervals from
the “Interval” edit window. See the previous section
on Intervals.
SmartChord mode, on the other hand, will follow
the melody of your voice while staying musically
related to the chords on the MIDI control track.

SmartKey
With the right combination of input vocal melody
and underlying chord structure, the SmartKey mode
can produce harmonies that sound unbelievably real.
When you have a song that has a simple chord
structure like those found in country and blues, you
can dial up SmartKey mode and be on your way to a
killer harmony line in mere moments.
The “key” to making SmartKey work properly is
to set the key and scale correctly. While it sounds
like you’d need some music theory background to do
this, don’t despair—if you can lean over and tell a
fellow musician what key you’re going to play the
next song in, you can set up SmartKey mode
effectively.
Let’s break it down into the two components of
key and scale. Determining the key is easy; it’s often
the first chord in a song. However, some songs are in
a different key than the first chord (such as “Sweet
Home Alabama,” which is in G but starts with a D
chord). Scale can be either major or minor, and
depends on the notes that make up the scale.

.
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To select Key and Scale, you want to be in the
Key/Scale Edit mode, shown above. Once in this
editing window, Key is selected by clicking on a note
on the piano. Select the scale using the spin dial
above the piano keys.

The Difference
SmartKey harmony usually requires you to enter
the one key that works for a whole song. SmartKey
harmonies will sound correct in many songs but not
all, and this is why you have a choice between it and
SmartChord. SmartKey harmonies are also more
active in harmony motion.
SmartChord harmony requires you to input a
different chord change for every chord in a song.
They can be applied to almost any song you can play.
This is the only practical difference between the two
harmony types.

Pitch Shift
This mode doesn’t have the “smarts” that the
other control modes do, so you’re best to stay away
from harmonies and use this for special effects and
doubling (unless you actually want your harmonies
to sound like Gregorian chants). You can produce
some interesting spoken-word effects by muting your
input voice and pitch-shifting a single effect voice
down a few tones or even an octave. Combine this
with a little male gender and you can get pretty close
to a newscast voiceover. Subtle pitch shifts are
better, though, for changing male to female and vice
versa.
Pitch Shift mode is also handy for unison or
octave-doubling effects. Turn on all four voices and
place the interval settings in the middle. If you add
detuning and a bit of scoop style, this will thicken up
your vocal as if you had quadruple-tracked your
voice. You can also take one or two of the effect
voices and put them in octave positions for
interesting effects, too.

Reverb
When any of the harmony modes are being used,
you can also add a reverb harmony effect. However,
to engage the reverb harmony effect you must be in
Stereo Output mode. This sends your harmonies to
one set of stereo returns on your D8B, and your
reverb to another set of stereo returns. Reverb can
be very useful in placing your harmonies deeper in
your mix.
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Operation–Pitch Correction Mode
To make sure you are in Pitch Correction mode
select “Pitch Correct” from the Vocal Studio screen.

What is Pitch Corrector Mode?
Everyone mixing vocals has experienced out-oftune vocal tracks. Typically, there hasn’t been much
at your finger tips to fix those nasty notes. Some
lucky folks have been able to invest thousands of
dollars in computer editing suites to do pitch
correction. IVL Vocal Studio gives a simple yet
effective pitch corrector to doctor your vocal tracks
with your D8B. Vocal Studio’s pitch corrector is
operated manually. Therefore, you have control over
pitch fixing at all times. Generally, the less you
correct the note, the more natural the result.
However, the pitch corrector can force a vocal note
anywhere.

What are the Controls?
The Pitch Corrector screen is separated into four
control areas:

Pitch Bender is used to bend out-of-tune vocal
notes to the desired pitch. The pitch bender works
just as a spring-loaded pitch bender would work on a
keyboard. Use the mouse to drag the pitch bender up
to raise the pitch. Drag the pitch bender down to
lower the pitch. When you release your mouse
button, the pitch bender will spring back to the
center position, where the pitch will be unaffected.
You can also use an external pitch bender from a
MIDI keyboard with the same results.

Pitch Bend Range sets a maximum amount the
pitch can be corrected using the Pitch Bender. The
pitch bend range is set by grabbing the red circle
(located in the Pitch Bend Range window) with your
mouse. When the range is set to maximum, the pitch
can be corrected by ±12 semitones (1 octave) with
the Pitch Bender. When the pitch bend range is set
to its minimum the pitch can be corrected by ±50
cents (1 semitone). Set the range for the maximum
amount of pitch correction needed. If the vocal track
travels a full semitone out of tune, set the range to 1
or 2 semitones.

Slope controls the switching rate between the
pitch corrected sound and the original sound when
using the Vocal Studio’s keyboard control graphic.
Use the red circle in the Slope window to adjust the
slope. When the Slope is pulled all the way to the
left, the switch between original and pitch-corrected
sound is instantaneous. The more you pull the slope
to the right, the more gradual the fade between
original and pitch-corrected sound becomes. This
parameter can be set to make pitch correction more
natural.

Pitch Controller is used to force the vocal line to
an exact pitch. Use the Octave buttons to set the
octave you want the vocal line to be forced. Once you
have set the octave, trigger the note you want using
the Pitch Controller keyboard. As long as you are
holding/triggering the note with the mouse or MIDI
keyboard, the vocal line will sing the corrected pitch
indefinitely. Only when you release the note will the
vocal line return to the original pitch. An external
MIDI keyboard can also be used to give immediate
access to multiple octaves.
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Appendix C
Plug-in Configuration and Routing
Configuring the Plug-in
After installing your UFX or MFX card, all you
need to do is assign a plug-in to the card.

Assigning the Plug-in to a UFX or MFX card
1. Click the Plugins menu and select Plugins,
(or use the keyboard shortcut Ctrl+P).

2. In the Plugin Configuration window, locate the
card slot that contains the UFX or MFX card
to which you wish to assign a plug-in.
3. In the MODE column, click the
MONO/STEREO toggle button and set it to
mono or stereo (depending on the plug-in and
the card).

• When a plug-in is fed from an aux bus, its output
appears on the FX Return channels (faders in the
EFFECTS bank). The return channel is
determined by the slot number and whether the
effect output is mono or stereo. For example, a
reverb with a mono input and stereo output that is
installed in Slot 5 has its outputs on FX 5 and FX 6.
Note: The default state for all FX channels is
MUTE. You won’t hear the effect until you unmute
its FX return channel(s).
• A plug-in can also receive its input from a channel
pre- or post-DSP insert or the main stereo left and
right bus. When a plug-in is inserted in this manner,
its output is routed directly back into the channel.

Deactivating the Plug-in
4. In the Plugin column, select a plug-in from
the pull-down menu. It should look
something like this:

1. Select none from the associated plug-in dropdown assignment menu.

2. Click OK in the Alert dialog box.

Note: A plug-in can also be loaded from the Setup
section on the console.

Assigning an Input Source to the Plug-in
• Click the plug-in’s INPUT button to select an
input source. In the following example, we have
chosen the Aux 5 Bus as the input to the plug-in
installed in slot 5.
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Warning: Deactivating a plug-in erases all
automation data for the plug-in.

Saving, Loading, and Resetting a Preset

Plug-in settings can be saved and recalled
from the hard drive. You can save and load files to
either Memory A or Memory B.

To Save a Preset:
1. Click and hold the Menu button.

To Load a Preset:
1. Click Mem A or Mem B to choose the
memory location from which to load the file.

2. Click and hold the Menu button.

2. Select Save User Preset to overwrite the file
currently opened.
3. Select Save User Preset As to save to a new
file name. The Save Preset File As dialog box
appears.

3. Select Load (Plug-in) to open a file. The Load
Preset File dialog box appears.

4. A default name for the preset is automatically
displayed, such as Preset#1. If you want to
rename it, simply type in the name you want,
using up to 20 characters.

A new sub folder can
be easily created to
help organize custom
patches.

5. Select INTERNAL (default hard drive) or
FLOPPY.
6. Click Save to complete the operation.

4. Click INTERNAL if the file is on the internal
drive, or click FLOPPY if the file is on a
floppy disk.
5. Select the preset you want to load.
6. Click Open to load the selected preset.

Click in the Preset Display to
load from the pull-down
menu or scroll through
presets using the Up/Down
buttons.
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To Reset the Plug-in:

Reset will reload the previous patch.
1. Click and hold the Menu button.
2. Select Reset (Plug-in).

Automation and Snapshot Control
Dynamic Real Time
To write automation on a loaded plug-in:
1. Engage AUTO TOUCH.

2. Engage ALL, disengage BYPASS, and send
timecode to the console –the POSITION
readout will change to show time code is being
received.
3. Move a parameter or recall a patch (user or
factory preset).

To Cut Preset Settings:
1. Click and hold the Menu button.
2. Select Cut (Plug-in).

Subsequent edits to any recorded automation
moves may be performed in the Mix Editor. Enable
the channel view by clicking on the Channel View
button, then choose the plug-in you wish to view
from the page drop-down menu. This displays a
list of available channel and plug-in parameters.

The current settings are temporarily stored in
the clipboard memory in case you want to paste
them to a new preset. The plug-in also reverts to
its default state (it is reset).
To Copy Preset Settings:
1. Click and hold the Menu button.
2. Select Copy.

The current settings are temporarily stored in
the clipboard memory in case you want to paste
them to a new patch.

Note: Parameters can be controlled from either
the GUI plug-in graphic parameters (using a
mouse to modify the parameters) or via the VFD
V-Pots and SELECT buttons (with the plug-in
parameters called up on the VFD readout).

To Paste Preset Settings:
1. Click and hold the Menu button.

Dynamic Off-line

2. Select Paste (Plug-in).

To write a snapshot on a loaded plug-in:

The current settings are replaced with the
setting in the clipboard memory.

• Use the Event Automation Track, available under
the Windows Menu as ‘Event Track’, to load plugin user (previously stored) or factory preset
patches, at a specific time during automation
playback.
General Note: Plug-in settings are recalled as
part of a console Snapshot, but may also be
recalled as Presets (patches). If you are recalling
snapshots and presets, be aware that one may override
the other.
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FX Routing
The Plug-in Configuration Window

Card Slot Column

Input Source
Assignment Column

Plug-in
display toggle

Plug-in
Assignment Column
Close Window

Input Channel
Assignment Pulldown Menu Button
Card A

Stereo/Mono
Mode Column
Stereo/Mono
Toggle Button

Card B
Card C

Card D (no
card installed)

Inserting a Plug-in into a Channel
A pre- or post-DSP channel insert can also be
used as the input source for a plug-in. When a
channel insert point is selected, the plug-in output
returns to the channel. The FX return path is
disconnected, although the plug-in output is still
displayed on the FX return channel meter.
A plug-in channel insert assignment can be
made from the Plugin Configuration window, or
from a pull-down menu from the mixer screen.

Post-DSP Pull-down
Plug-in Configuration Window

Pre-DSP Pull-down

This assignment can also be made from the
control surface and VFD by holding the desired
channel’s SELECT button for two seconds, then
paging over to Plug Pre or Plug Post, selecting
the input source, then selecting the desired plugin slot from the follow-on menu.
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Using an Aux Send with a Plug-in
• Click the associated INPUT menu button and
select an Aux input source. In the example below,
we have chosen the Aux 5 Bus.

Pre-Fader and Post-Fader Auxiliary Sends
Normally, effect sends are post-fader, so the
signal sent to the effect follows the program level
in the mix. Occasionally you may wish to feed an
effect from a pre-fader source so that the signal
level from the aux control is independent of the
channel fader position. Aux sends are selectable
pre- or post-fader globally (all Aux 1’s for instance)
from the Mix Options screen in the Setup window,
or individually on a channel-by-channel basis either
from the channel strip or the Fat Channel.
In the channel strip, Alt-click the Aux Send
level indicator to toggle between pre-and postfader operation. Post-fader is indicated by a red
bar, pre-fader is indicated by a yellow bar.

Send the Input Signal to the Aux Bus
1. Send a signal to a D8B mixer input channel
(MIC/LINE or TAPE IN).
2. Assign the input channel V-Pot/GUI Control
Pot to an aux send. We have chosen AUX 5
according to the example above.

3. Use the AUX 5 control to adjust the input level
to the plug-in.

GUI Control
Pot Assigned
to AUX 5

Remember to select an aux send before using
the V-pot or GUI Control Pot on the mixer input
channel (MIC/LINE or TAPE IN).
You will see the plug-in’s input meter
become active as you raise the mixer input
channel’s aux send.
Set the plug-in input/output signal levels as
you would with any effect, so the meter reaches
its upper-most range every so often (always trust
your ears first). This can be accomplished from
the console or GUI.
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In the Fat Channel, clicking on the small
indicators below the Aux knobs toggles between
pre- and post-fader operation. Yellow indicates
pre-fader, otherwise the aux is post-fader.

The FX Return Channel
• Switch the D8B Bank Select to EFFECTS (49-72)
and bring up faders one and two (channels 49 and
50). You will also see meter activity associated
with these channels.

FX Channels 1&2
(channels 49&50)

Stereo Plug-in

The Plug button
toggles between
Windows menu
buttons and FX
buttons (lower
left on the D8B
mixer screen).

Plugins button opens the Patch
Configuration window (or
Ctrl+P on the keyboard).
Here the Delay Factor plug-in is
selected for display.
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Appendix D
Shortcuts
Feature

Surface

Keyboard

Mouse (click or pull down)

New Session

[New]

Ctrl+N

File > New Session

Open Session

[Load]

Ctrl+O

File > File Manager

Save Session

[Save Session]

Ctrl+S

File > Save Session

Save Session As

[Save Session As]

File > Save Session As

Save As Template

File > Save As Template

Toggle Desktop

Ctrl+D

Shutdown

Ctrl+Q

File > Shutdown

Ctrl+1

Setup

Ctrl+Z

Edit > Undo (channels or moves)

Ctrl+Shift+Z

Edit > Redo (channels or move)

Preferences

[General]

Undo

[Undo]

Redo

File > Desktop (or Click Desktop in bottom menu bar)

Cut Channels

[Cut]

Ctrl+X

Edit > Cut Channels

Copy Channels

[Copy]

Ctrl+C

Edit > Copy Channel(s)

Paste Channels

[Paste]

Ctrl+V

Edit > Paste Channels

DEL

Edit > Delete Events

Alt+M

Edit > Modify Levels

Delete Events
Set Default Levels

Edit > Set Default Levels

Modify Levels
Insert Time

Edit > Insert Time

Delete Time

Edit > Delete Time

Insert Global Time

Edit > Insert Global Time

Delete Global Time

Edit > Delete Global Time

Clear Automation

Edit > Clear Automation

Clear Edit History

Edit > Clear Edit History

Select All

Ctrl+A

Edit > Select All

Select Fader Bank

Alt+A

Channel > Select Fader Bank

Select All Faders

Alt+Shift+A

Channel > Select All Faders

[tab], #’s, [enter]

click on counter, #’s , [enter]

Time Code Counter

[set time, #’s, enter]

Sort by column title in …window

[tab] highlight column, [enter]

click on title in window

(New, Open, Save, Snap, Locate – any listing window)

Window views: [Ctrl] + [number or letter] both opens and closes these windows:
Feature

Surface

View Setup

Keyboard

Mouse (click or pull down)

Ctrl+1

Windows > Setup

View Snapshots

Ctrl+2

Ctrl+2

Windows > Snapshot

View Surround

Ctrl+3

Ctrl+3

Windows > Surround

View Locator

Ctrl+4

Ctrl+4

Windows > Locator

View Mix Editor

Ctrl+5

Ctrl+5

Windows > Mix Editor

View Fat Channel

Ctrl+6

Ctrl+6

Windows > Fat Channel

View Panning

Ctrl+7

Ctrl+7

Windows > Panning

View Faders

Ctrl+8

Ctrl+8

Windows > Faders

View Event Track

Ctrl+9

Ctrl+9

Windows > Event Track

View History List

Ctrl+H

Windows > History List

View MIDI Map

Ctrl+–

Windows > MIDI Map
[Mic/Line]

View Ch 1–24

[Mic/Line]

F1

View Ch 25–48

[Tape]

F2

[Tape]

View Ch 49–64

[Effects]

F3

[Effects]

View Masters

[Masters]

F4

[Master]

Close Window

Ctrl+W (or ESC)

File> Close Window

Close All

Ctrl+\

Window> Close All

View Plugin Configuration

Ctrl+P

[Plugins] in bottom menu bar (or Plugins > Plugins)

View Plug-in Windows (slots 1–9)

Alt+1 through Alt+9

View Plug-in Windows (slots 10–16)

Alt+Shift+0 through Alt+Shift+6
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Functions on SELECT(ed) Channel
Example: Select channels 1–5 and type the letter [M] and these channels will mute. To unmute these same selected channels, type either a
comma [ , ] or hold down the shift key and type the letter [M].
Feature

Surface

Channel List

Keyboard

Mouse (click or pull down)

Ctrl+B

Channel > Channel List

Open Channel

Channel > Open Channel

Save Channel As

Channel > Save Channel As

Track Selection

[Select]

L/R arrow

Click on Channel [Select]

Multiple Track Selection

[Shift]+[Select]

[Shift]+L/R arrow

[Shift] Swipe across channel [Select]s
or

Move Channel Selection

Right mouse button/swipe across channel [Select]s

L/R arrows

Single Event Selection

Left-click

Multiple Event Selection

[Shift]

[Shift-click]
Double-click on any [Select]

Unselect All Faders

Double-press any [Select]

Left or right arrow

Group

[Group][Select]

Ctrl+G

Ungroup

[Group][Select]

Channel > Group
Channel > Ungroup

Faders to Unity

Ctrl+]

Channel > Faders to Unity

Faders to Off

Ctrl+[

Channel > Faders to Off

Nudge Selected Faders

Alt+up/down arrows

Channel Link

Hold adjacent [Select]s

Ctrl+L

Unlink

Hold adjacent [Select]s

Ctrl+U

Adjust Channel Delay

Channel > Channel Link
Channel > Unlink
Channel > Adjust Channel Delay

Reset Channel Delay

Channel > Reset Channel Delay

Reset Channel Layout

Channel > Reset Channel Layout

Write toggle

[Write]

[W] (enable)

[Write]

[E] or [Shift] [W] (disable)
Solo toggle

[Solo]

[S] (enable)

[Solo]

[D] or [Shift] [S] (disable)
Solo Isolate toggle

Alt+[Solo]

Mute toggle

[Mute]

Channel > Channel List (or Alt+click on Solo)
[M] (enable)

[Mute]

[ , ] or [Shift] [M] (disable)

Transport Functions
Feature

Surface

Keyboard

Mouse (click or pull down)

Play/Stop

[Play][Stop]

[Space]

[PLAY][STOP] in Locator window

Play

[Play]

[Space]

[PLAY][STOP] in Locator window

Play from Selection

Ctrl+Space

Edit > Play From Selection

Set Selection Start

[

Set Selection End

]

Stop

[Stop]

Record Mode

[Record]

[Space]

[PLAY][STOP]

Location 00-99

in locate mode: 00-99 numeric entry, followed by [Enter] Locator window, double-click line

[RECORD]

Store Locate

in locate mode: 00-99 numeric entry, followed by [Store] Locator window, click [New]

Next/Previous Cue

Ctrl+Enter/Alt+Enter

New Cue
Return to Zero (RTZ)

+/–

Double-click Cue

Ctrl+M

[New]

empty locate, [enter]

Rewind

[<<]

Shift+<

[REW]

Fast Forward

[>>]

Shift+>

[FFWD]
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ODDS ’N’ ENDS
Feature

Surface

Channel strip name

Keyboard

Mouse (click or pull down)

Click on name field, enter [text], [tab] (right) or [shift] [tab] (left)

Equal aux/trim levels

(see clipboard ops)

Bus assigns

[Bus #], swipe [Assign]s

(See clipboard ops)

Click bar, right mouse button, swipe either direction
Click bus, any mouse button, swipe either direction

DSP function On/off toggles (Phase, EQ, Gate, Compressor)

Click button, any mouse button, swipe either direction

Bypass Automation

Bypass Automation

Bypass Automation in Locator window

Motor Faders off

Motor Faders off button

Toggle checkbox / edit field

Mouse Click

Mix Editor Shortcuts
Highlight from Selection

Click and drag over area

Scroll Mix Editor

Alt+arrow(s)

Zoom Mix Editor

Ctrl+arrow(s)

Dive Zoom Mix Editor

Z

Drag Mix Editor Screen

D
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Use Highlighter (I-Beam) tool

Appendix E
MIDI Implementation Guide
Product: Mackie Digital 8•Bus
MIDI Implementation Chart
Function
Transmitted
Basic Channel
Default
00, MIDI Off (note 1)
Changed
00-0F
Mode
Default
Poly
Messages
Altered
Note
True voice
00-0F
Number
Velocity
Note ON
Mute on = 40
Note OFF
Mute off = 01
Aftertouch
Keys
00-7F
Channel
Pitch Bend
X
Control Change
00-7F

Date: 3/01
Version: 3.0
Recognized
Remarks
00, MIDI off (note 1) See 1) under notes
00-0F
2) per channel strip
Poly
Exception: program
changes are Omni
00-0F
Mute on = 40
Mute off = 01
00-7F
X
00-7F

Reassignable – applies
to mute & pan messaging
Mute only
Pan control: range
127L to 127R
Fader level Tx & Rx,
assignable per D8B channel
strip via the Channel List
Rcv: Omni
See note 3)

Program Change True number
00-7F
00-7F
System Exclusive
note 3)
X
System Common Song Pos
X
X
Song Sel
X
X
Tune Req
X
X
System Real-time Clock
X
MTC
Commands
X
X
Local On/Off
X
X
Aux
All Notes Off
X
X
Messages
Active Sensing
X
X
System Reset
X
X
Notes
1) System real time always active, MIDI On/Off defaults to OFF
and MIDI channel 00.
2) Either Tx or Rx.
3) MMC open loop commands: STOP, PLAY, FF, REW, TRACK REC/RDY,
SHUTTLE, STEP.
4) All values listed in hexadecimal.

O: Yes
X: No
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Appendix F
Compatible Cables
Analog and Digital Multitrack Cables
The following companies supply analog and digital multitrack cables for use with the HDR24/96 I/O cards:

Horizon Music, Inc.
P.O. Box 1988, Cape Girardeau MO 63702-1988
Tel: (800) 255-9822; Fax: (800) 455-3460
http://www.horizonmusic.com
AIO•8 Analog Interface Cables
HDA8 Series
DB25 to [specify connector]
Connector options:
8 male XLR, 8 female XLR, or 8 1/4" TRS
Standard lengths:
5, 10, 15, 20, 25 feet
DIO•8 TDIF Interface Cables
TDIF Series
DB25 to DB25
Standard lengths:
5, 10, 15 feet
PDI•8 AES/EBU Interface Cables
HD44 Series
DB25 to [specify connector]
Connector options:
4 male + 4 female XLR, or DB25
Standard lengths:
5, 10, 15, 20, 25 feet

Hosa Technology, Inc.
6920 Hermosa Circle, Buena Park CA 90620
Tel: (714) 736-9270; Fax (714) 522-4540
http://www.hosatech.com
AIO•8 Analog Interface Cables
DTP Series
DB25 to 8 1/4" TRS
DTF Series
DB25 to 8 female XLR’s
DTM Series
DB25 to 8 male XLR’s
Standard lengths:
3, 4, 5, 7 meters
DIO•8 TDIF Interface Cables
DBK Series
DB25 to DB25
Standard lengths:
3, 15 feet
OPT•8 / DIO•8 ADAT Optical Interface Cables
OPT Series
Standard ADAT Optical cables
OPM Series
Jacketed ADAT Optical cables w/ metal headshell
OPT lengths:
2, 3, 6, 10, 13, 17, 30, 50 feet
OPM lengths:
3, 5, 10, 15, 20, 30, 50 feet
PDI•8 AES/EBU Interface Cables
DBK Series
DB25 to 4 male, 4 female XLR’s
Standard length:
8 meters only
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Marshall Electronics
PO Box 2027, Culver City, CA 90231
Tel: (800) 800-6608; Fax: (310) 391-8926
http://www.mars-cam.com/cable.html
AIO•8 Analog Interface Cables
DC-DAXM Series
DB25 to 8 male XLR’s
DC-DAXF Series
DB25 to 8 female XLR’s
DC-DAS Series
DB25 to 8 1/4" TRS
Standard lengths:
3, 5, 10, 15, 20,
and 25 feet
DIO•8 TDIF Interface Cables
DCD-88D Series
DB25 to DB25.
Standard lengths:
1, 3, 6, 12, 15, 20, 25,
and 33 feet.
PDI•8 AES/EBU Interface Cables
DC-SYX Series
DB25 to 4 male,
4 female XLR’s
DC-DUB Series
DB25 to DB25
Standard lengths:
3, 5, 10, 15, 20, 25 feet

Pro Co Sound, Inc.
135 E. Kalamazoo Ave., Kalamazoo, MI 49007
Tel: (800) 253-7360; Fax: (616) 388-9681
http://ww.procosound.com
AIO•8 Analog Interface Cables
DA-88 XM Series
DB25 to 8 male XLR’s
DA-88 XF Series
DB25 to 8 female XLR’s
DA-88 BQ Series
DB25 to 8 1/4" TRS connectors
Standard lengths:
5, 10, 15, 20 feet

Other Cables
In addition to the companies listed above, the following companies
supply individual 110Ω AES/EBU and/or 75Ω word clock and video cables:

Apogee Electronics Corporation
3145 Donald Douglas Loop South
Santa Monica, CA 90405-3210
Tel: (310) 915-1000; Fax: (310) 391-6262
http://www.apogeedigital.com

Canare
531 5th Street, Unit A, San Fernando, CA 91340
Tel: (818) 365-2446; Fax: (818) 365-0479
http://www.canare.com

Whirlwind
99 Ling Rd., Rochester, NY 14612
Tel: (888) 733-4396; Fax: (716) 865-8930
http://www.whirlwindusa.com
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25-pin .................................................................................................................. 22, 23
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A
A-D Converter .................................................................................................... 12, 17
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ADAT ....................................................................... 68, 91, 94, 108, 117, 118, 120
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ADAT Optical Hookup to HDR-24/96 ................................................................. 114
Adjust Channel Delay… .......................................................................................... 59
AES/EBU ........................................................................................................ 108, 154
AES/EBU (PDI•8) ....................................................................................................... 23
AES/EBU Digital I/O ................................................................................ 23, 35, 66
AES/EBU Hookup (PDI•8) ..................................................................................... 116
AFL ............................................................................................................................. 27
AFL Solo Button ........................................................................................................ 33
After-Fader Listen ................................................................................................... 27
AIO•8 ................................................................................. 22, 23, 65, 91, 112, 154
All ................................................................................................................ 37, 60, 74
Alt Button ................................................................................................................. 36
Alt I/O ................................................................................................ 23, 38, 64, 66
Analog and Digital Multitrack Cables ...................................................... 144, 154
Analog Hookup to HDR-24 (AIO•8) ...................................................................... 112
Analog I/O ....................................................................................................... 22, 112
Analog Inserts ........................................................................................................ 106
Analog Trim ............................................................................................................... 12
Antares ........................................................................................................................ 4
Apogee ............................................................................................................... 4, 155
Apogee Digital I/O ................................................................................................. 22
Assign ......................................................................................................... 26, 36, 81
Assignment Section ................................................................................................. 10
Authorize .................................................................................................................. 66
Auto Arm .................................................................................................................. 66
Auto Follow ............................................................................................................... 75
Auto Touch ............................................................................................... 37, 60, 130
Auto-follow Checkbox ........................................................................................... 76
Auto-scroll Checkbox ............................................................................................. 76
Automate EQ, Dynamics, and Effects ................................................................. 132
Automation In Bypass ........................................................................................... 129
Automation Parameters ......................................................................................... 74
Automation Procedural Checklists ..................................................................... 132
Automation Section ................................................................................................ 36
ALL ........................................................................................................................ 37
AUTO TOUCH ...................................................................................................... 37
BYPASS ................................................................................................................ 36
FADER MOTORS OFF .......................................................................................... 37
FADERS ................................................................................................................. 37
MUTES .................................................................................................................. 37
PAN ....................................................................................................................... 37
TRIM LEVELS ....................................................................................................... 37
Automation Sub-menu ........................................................................................... 60
All ........................................................................................................................ 60
Auto Touch ......................................................................................................... 60
Bypass ................................................................................................................. 60
Faders .................................................................................................................. 60
Mutes .................................................................................................................. 60
Pan ....................................................................................................................... 60
Trim Levels ......................................................................................................... 60
Write Flyback .................................................................................................... 60
Write Ready Mode ............................................................................................. 61
Aux 1–8 Buttons ....................................................................................................... 30
Aux 9–10 and 11–12 ........................................................................... 30, 34, 48, 98
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Aux Buttons 1–8 ....................................................................................................... 48
Aux Out Section ...................................................................................................... 24
Aux Pans 9-10 and 11-12 ........................................................................................... 45
Aux Send Levels ....................................................................................................... 44
Aux Sends ........................................................................................................... 23, 81
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